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Computer
Fundamentals

Computer:

Computer is an electronic device that is designed to work with Information. The term
computer is derived from the Latin term ‘computare’, this means to calculate. Computer
cannot do anything without a Program. It represents the decimal numbers through a
string of binary digits. The Word 'Computer' usually refers to the Center Processor Unit
plus Internal memory.

CHARLESBABBAGE

Charles Babbage, was an English polymath. He was a mathematician, philosopher,
inventor and mechanical engineer, who is best remembered now for originating the
concept of a programmable computer.

Considered a "father of the computer", Babbage is credited with inventing the first
mechanical computer that eventually led to more complex designs. His varied work in
other fields has led him to be described as "pre-eminent" among the many polymaths of
his century.

FUNCTIONALITESOF COMPUTER:

Anydigitalcomputercarriesoutfivefunctionsingrossterms:

 Takesdataasinput.

 Storesthedata/instructionsinitsmemoryandcanusethemwhenrequired.

 Processthedataandconvertitintousefulinformation.

 Outputtheinformation.

 Controlalltheabovefoursteps.

http://en.wikipedia.org/wiki/Polymath
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Definition

Computer Systemis anelectronicdataprocessingdevicewhichdoesthefollowing:

 Acceptandstoreaninputdata.

 Processthedatainput.

 Andoutputtheprocesseddatainrequiredformat.

ADVANTAGESOFCOMPUTER:

FollowinglistdemonstratestheadvantagesofComputers:
High Speed

 Computerisaveryfastdevice.

 Itiscapableofperformingadditionofverybigdata.

 The computerhasunits of speed inmicrosecond,nanosecond andeven the
picoseconds.

 Itcanperformmillionsofcalculationsinafewsecondsascomparedtomanwho can
spend many months for doing the same task.

Accuracy

 Inadditiontobeingveryfast,computerisveryaccurate.

 Thecomputercanperformcalculations100%errorfree.

 Computersperformalljobswith100%accuracy.

Storage Capability

 Memoryisaveryimportantcharacteristicofacomputer.

 Thecomputerhasmuchmorestoragecapacitythanhumanbeings.

 Itcanstorelargeamountofdata.

 Itcanstoreanytypeofdatasuchasimages,videos,text,audioandanyothertype.

Diligence

 Unlikehumanbeings,acomputerisfreefrommonotony,tirednessandlackof
concentration.

 Itcanworkcontinuouslywithoutcreatinganyerrorandboredom.

 Itcandorepeatedworkwithsamespeedandaccuracy.



Versatility

 Acomputerisaveryversatilemachine.

 Acomputerisveryflexibleinperformingthejobstobedone.

 Thismachinecanbeusedtosolvetheproblemsrelatingtovariousdifferentfields.

 Atoneinstant,itmaybesolvingacomplexscientificproblemandtheverynext moment
it may be playing a card game.
Reliability

 Acomputerisareliablemachine.

 Modernelectroniccomponentshavefailurefreelonglives.

 Computersare designedto makemaintenanceeasy.

Automation

 Computerisanautomaticmachine.

 Automationmeansabilitytoperformthetaskautomatically.

 Onceaprogramisgiventocomputeri.estoredincomputermemory,theprogram and
instruction can control the program execution withouthuman interaction.

ReductionInPaperWork

 Theuseofcomputersfordataprocessinginanorganizationleadstoreductionin paper
work and speeds up the process.

 Asdatainelectronicfilescanberetrievedasandwhenrequired,theproblemof
maintenance of large number of files gets reduced.

Reduction In Cost

 Thoughtheinitialinvestmentforinstallingacomputerishighbutitsubstantially
reduces the cost of each of its transaction.

DISADVANTAGESOFCOMPUTER:

FollowinglistdemonstratesthedisadvantagesofComputersintoday'sarena.

 Acomputerisamachineandhasnointelligenceofitsowntoperformanytask.

 Eachandeveryinstructionhastobegiventothecomputer.

 Acomputercannottakeanydecisiononitsown.



Dependency

 Itcanperformfunctionasinstructedbytheuser,soitisfullydependentonhuman being.

Environment

 Theoperatingenvironmentofcomputershouldbedustfreeandsuitabletoit.
NoFeeling

 Computerhasnofeelingoremotions.

 ItcannotmakeJudgmentbasedonfeelings,tastes,experiencesandknowledge unlike
a human being.

APPLICATIONSOFCOMPUTER

Banking

TodayBankingisalmosttotallydependentoncomputer. Banks

provide following facilities:

 Bankson-lineaccountingfacility, whichincludecurrentbalances,deposits,
overdrafts, interest charges, shares and trustee records.

 ATMmachinesaremakingiteveneasierforcustomerstodealwithbanks.

Insurance

Insurance companies are keeping all records up to date with the help of computer. The
Insurance Companies, Finance houses and Stock broking firms are widely usingcomputers
for their concerns.

InsuranceCompaniesaremaintainingadatabaseofallclientswithinformationshowing

 howtocontinuewithpolicies

 startingdateofthepolicies

 nextdueinstallmentofapolicy

 maturity date

 interestsdue

 survivalbenefits

 bonus

Education



ThecomputerhasprovidedalotoffacilitiesintheEducationSystem.

 The uses of computer provide a tool in the Education system is known as CBE
(Computer Based Education).

 CBEinvolvesControl,DeliveryandEvaluationoflearning.

 The computer education is very familiar and rapidly increasing the graph of
computer students.

 Therearenumberofmethodsinwhicheducationalinstitutionscanusecomputerto
educate the students.

 It is used for prepare a database about student performance and analysis are
carried out.

Marketing

InMarketingusesofcomputerarefollowing:
 Advertising: With computers, advertising professionals create art and graphics,

writeandrevisecopyandprintanddisseminateadswiththegoalofsellingmoreproducts.
 At Home Shopping: At home shopping has been made possible through use of

computerized catalogues that provide access to product information and permit direct
entry of orders to be filled by the customers.

HealthCare

ComputershavebecomeimportantpartinallMedicalSystems.

Thecomputersarebeingusedinhospitalstokeeptherecordofpatientsandmedicines.It
isalsousedinscanninganddiagnosingdifferentdiseases.ECG,EEG,Ultrasoundsand CT Scans
etc. are also done by computerized machines.

Someofmajorfieldsofhealthcareinwhichcomputerareused:
 Diagnostic System: Computersareusedtocollectdataandidentifycauseof

illness.
 Lab-diagnostic System: Alltestscanbedoneandreportsarepreparedby

computer.
 Patient Monitoring System: Theseareusedtocheckpatient'ssignsfor

abnormality such as in Cardiac Arrest, ECG etc.
 Pharma Information System: Computer checks Drug-Labels, Expiry dates,

harmful drug side effects etc.

 Nowadays,computersarealsousedinperformingsurgery.

Engineering Design

Computersare widelyused in Engineeringpurposes.

One of major areas is CAD (Computer Aided Design). CAD provides creation, edition and
modification of image. Some fields are:



 Structural Engineering: Requiresstressandstrain analysisrequiredfordesign of
Ships, Buildings, Budgets, and Airplanes etc.

 IndustrialEngineering: Computersdealswithdesign,implementationand
improvement of integrated systems of people, materials and equipments.

 Architectural Engineering: Computers help in planning towns, designing
buildings, determining a range of buildings on a site using both 2D and 3Ddrawings.

Military
Computers are largely used in defense. Modern tanks, missiles, weapons etc. employ
computerized controlsystems. Somemilitaryareaswherea computerhasbeen usedare:

 MissileControl

 MilitaryCommunication

 Militaryoperationandplanning

 SmartWeapons

Communication

Communication means to convey a message, an idea, a picture or speech that is received
andunderstoodclearlyandcorrectlybythepersonforwhomitismeant.Somemainareas in this
category are:

 E-mail

 Chatting

 Usenet

 FTP

 Telnet

 Video-conferencing

Governmentapplications

Computers play an important role in government applications. Some major fields in this
category are:

 Budgets

 Salestaxdepartment

 Incometaxdepartment

 Male/Femaleratio

 Computerizationofvoterslists

 ComputerizationofDrivingLicensingsystem



 ComputerizationofPANcard

 WeatherForecasting.

TYPESOFCOMPUTER:

Computercanbebroadlyclassifiedbytheirspeedandcomputingpower.
Sr.
No. Type Specifications

1 PC(PersonalComputer) Single user computer system. Moderately
powerful microprocessor.

2 WorkStation
Single user computer system. Similar to
Personal Computer but have more powerful
microprocessor.

3 MiniComputer
Multi-user computer system. Capable of
supporting hundreds of userssimultaneously.

4 MainFrame

Multi-user computer system. Capable of
supporting hundreds of userssimultaneously.
Software technology is different from
minicomputer.

5 Supercomputer
An extremely fast computer which can
perform hundreds of millions of instructions
per second.

INPUTDEVICES

FollowingarefewoftheimportantinputdeviceswhichareusedinComputerSystems

 Keyboard

 Mouse

 JoyStick

 Lightpen

 TrackBall

 Scanner

 GraphicTablet

 Microphone

 MagneticInkCardReader(MICR)



 OpticalCharacterReader(OCR)

 BarCodeReader

 OpticalMarkReader

OUTPUT DEVICES

FollowingarefewoftheimportantoutputdeviceswhichareusedinComputerSystems

 Monitors

 GraphicPlotter

 Printer

CPU(CENTRALPROCESSING UNIT)

 CPUisconsideredasthebrainofthecomputer.

 CPUperformsalltypesofdataprocessingoperations.

 Itstoresdata,intermediateresultsandinstructions(program).

 Itcontrolstheoperationofallpartsofcomputer.

CPU itself hasfollowing threecomponents.

 MemoryOrStorage Unit:

 ControlUnit

 ALU(ArithmeticLogicUnit)

Memoryor Storage Unit:
Thisunitcanstoreinstruction,dataandintermediateresults.Thisunitsuppliesinformation
totheotherunitsofthecomputerwhenneeded.Itisalsoknownasinternalstorageunitor main
memory or primary storage or Random access memory (RAM).

Its size affects speed, power and capability. There are primary memory and secondary
memory two types of memories in the computer.

FunctionofMemoryUnitis:

Itstoresallthedatatobeprocessedandtheinstructionsrequiredforprocessing. It stores

intermediate results of processing.



Itstoresfinalresultsofprocessingbeforetheseresultsarereleasedtoanoutputdevice. All inputs

and outputs are transmitted through main memory.

Control Unit:
Thisunitcontrolstheoperationsofallpartsofcomputer.Itdoesnotcarryoutanyactual data
processing operations.

Functionsofthisunitare

Itisresponsibleforcontrollingthetransferofdataandinstructionsamongotherunitsofa computer.

Itmanagesandcoordinatesalltheunitsofthecomputer.

Itobtainstheinstructionsfromthememory,interpretsthemanddirectstheoperationof the
computer.

ItcommunicateswithInput/outputdevicesfortransferofdataorresultsfromstorage. It does

not process or store data.

ALU(ArithmeticLogicUnit):

Thisunitconsistsoftwosub-sectionsnamely

 Arithmetic section

 LogicSection

ARITHMETICSECTION
FunctionofArithmeticsectionistoperformarithmeticoperationslikeaddition,subtraction,
multiplication and division. All complex operations are done by making repetitive use of
above operations.

LOGIC SECTION
Function of logic section is to perform logic operations such as comparing, selecting,
matching and merging of data.

Units of Computer MemoryMeasurements

1Bit=BinaryDigit(BitsofComputerare0and1) 8 Bits
= 1 Byte
1024Bytes=1KB(KiloByte)
1024 KB = 1 MB (Mega Byte)
1024 MB = 1 GB(Giga Byte)

Computer Memory



In computing, memory refers to the physical devices used to store programs (sequences
ofinstructions)ordata(e.g.programstateinformation)onatemporaryorpermanentbasis for use
in a computer or other digitalelectronic device. The term primary memory is used for the
information in physical systems which function at high-speed (i.e. RAM), as a distinction
from secondary memory, which are physical devices for program and datastorage which
are slow to access but offer higher memory capacity. Primary memory stored on
secondary memory is called "virtual memory". An archaic synonym for memory is store.
The term "memory", meaning primary memory is often (but not always) associated with
addressable semiconductor memory, i.e. integrated circuits consisting of silicon-based
transistors, used for example as primary memory but also other purposes in computers
and other digitalelectronic devices. There are two main types of semiconductor memory:
volatile and non-volatile. Examples of non-volatile memory are flash memory (sometimes
used as secondary, sometimes primary computer memory) and
ROM/PROM/EPROM/EEPROM memory (used for firmware such as boot programs).
Examples of volatile memory are primary memory (typically dynamic RAM, DRAM), and
fast CPU cache memory (typically static RAM, SRAM, which is fast but energy-consuming
and offer lower memory capacity per area unit than DRAM).

Volatile memory

Volatile memory is computer memory that requires power to maintain the stored
information. Most modern semiconductor volatile memory is either Static RAM or dynamic
RAM.SRAMretainsitscontentsaslongasthepowerisconnectedandiseasyto interface to but
uses sixtransistors per bit. Dynamic RAM is more complicated to interface to and control
and needs regular refresh cycles to prevent its contents being lost. However, DRAM
usesonlyone transistoranda capacitorperbit, allowing it to reachmuch higher densities and,
with more bits on a memory chip, be much cheaper per bit. SRAM is not worthwhile for
desktop system memory, where DRAM dominates, but is used for their cache memories.
SRAM is commonplace in small embedded systems, which might only need tens of
kilobytes or less. Forthcoming volatile memory technologies that hope to
replaceorcompetewithSRAMandDRAMincludeZ-RAM,TTRAM,A-RAMandETARAM.

Non-volatilememory

Non-volatile memory is computer memory that can retain the stored information even
when not powered. Examples of non-volatile memory include read-only memory(ROM),
flash memory, most types of magnetic computer storage devices (e.g. hard disks,
floppydiscs and magnetic tape), optical discs, and early computer storage methods such
aspaper tape and punched cards.

OperatingSystem
An operating system is a program that acts as an interface between the software and the
computer hardware.

 Itisanintegrationsetofspecializedprogramsthatareusedtomanageoverall
resources and operations of the computer.
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 It is specialized software that controls and monitors the execution of all other
programs that reside in the computer, including application programs and other system
software.

ObjectivesofOperating System

 Makingacomputersystemconvenienttouseinanefficientmanner

 Tohidethedetailsofthehardwareresourcesfromtheusers

 Toprovideusersaconvenientinterfacetousethecomputersystem.

 To act as an intermediary between the hardware and its users and making it easier
for the users to access and use other resources.

 Managetheresourcesof acomputersystem.

 Keep track of who is using which resource, granting resource requests, according
for resource using and mediating conflicting requests from different programs andusers.

 Theefficientandfairsharingofresourcesamongusersandprograms

CharacteristicsofOperatingSystem
 MemoryManagement--Itkeepstracksofprimarymemoryi.ewhatpartofitarein use by

whom, what part are not in use etc. Allocates the memory when the process or program
request it.

 Processor Management -- Allocate the processor(CPU)toaprocess. De- allocate
processor when processor is no longer required.

 Device Management --Keeptracksof alldevices. Thisisalsocalled I/O controller.
Decides which process gets the device when and for how much time.

 File Management -- Allocates the resources. De-allocates the resources. Decides
who gets the resources.

 Security -- By means of passwords & similar other techniques, preventing
unauthorized access to programs & data.

 Job accounting -- Keeping track of time & resources used by various jobs and/or
users.

 Control over system performance -- Recording delays between request for a
service & from the system.

 Interaction with the operators --Theinteractionmaytakeplaceviatheconsoleof the
computer in the form of instructions. Operating System acknowledges the same, do the
corresponding action and inform the operation by a displayscreen.

 Error-detecting aids -- Production of dumps, traces, error messages and other
debugging and error-detecting methods.



 Coordination between other software and users --Coordinationandassignment of
compilers, interpreters, assemblers and other software to the various users of the
computer systems.

WINDOWS7

Windows 7 isanoperatingsystem producedbyMicrosoftforuseonpersonalcomputers,
including home and business desktops, laptops, net books, tablet PCs, and media center
PCs. It was released to manufacturing on July 22, 2009, and became generally available
retail worldwide on October 22, 2009, less than three years after the release of its
predecessor, Windows Vista. Windows 7's server counterpart, Windows Server 2008 R2,
was released at the same time. Windows 7 is succeeded by Windows 8.

Unlike Windows Vista's many new features, Windows 7 was an incremental upgrade
designedtoworkwithVista-compatibleapplicationsandhardware.Presentationsgivenby
Microsoft in 2008 focused on multi-touch support, an updated Windows shell with a new
taskbar, referred to internally as the Superbar, a home networking system called Home
Group, and performance improvements. Some standard applications that have been
included with prior releases of MicrosoftWindows, including Windows Calendar,
WindowsMail, Windows Movie Maker, and Windows Photo Gallery, are not included in
Windows 7; most are instead offered separately at no charge as part of the Windows
Essentials suite.

InstallWindows7

ManypeoplehavecomputersthatcomewithWindows7sotheymayneverhavetoinstall it.
However, you may need to install Windows 7 if:

 Youreplacedyourharddiskdrivewithanewharddiskdrivethatdoesnothave Windows
7 installed.

 YouarereinstallingWindows7onacomputerbecauseyouwanttocleanoffyour hard
drive and remove any unwanted programs, such as spyware.

 Youpurchasedacomputerwithoutanoperatingsystem.

Pre-installation checklist

Beforeyoubegintheinstallationprocess,usethischecklisttomakesurethatyouare prepared:

 YouhavetheWindows7CD.
 Youhavetheproductkeyavailable.Theproductkeyislocatedonyour Windows7 CD case

and is required to install and activate Windows 7.
 Your computer hardware is set up. At a minimum, you should connect your

keyboard,mouse,monitor,andCDdrive.Ifavailable,youshouldconnectyour
computer to a wired network.

 You haveWindows7 driversavailable. DriversaresoftwarethatWindows7 usesto
communicate with your computer’s hardware. If you do not have drivers available,
Windows 7 may already include drivers for your hardware. If not, you shouldbe

http://en.wikipedia.org/wiki/Operating_system
http://en.wikipedia.org/wiki/Microsoft
http://en.wikipedia.org/wiki/Desktop_computer
http://en.wikipedia.org/wiki/Netbook
http://en.wikipedia.org/wiki/Microsoft_tablet_PC
http://en.wikipedia.org/wiki/Home_theater_PC
http://en.wikipedia.org/wiki/Windows_Vista
http://en.wikipedia.org/wiki/Windows_Server_2008_R2
http://en.wikipedia.org/wiki/Windows_8
http://en.wikipedia.org/wiki/Multi-touch
http://en.wikipedia.org/wiki/Windows_shell
http://en.wikipedia.org/wiki/Taskbar
http://en.wikipedia.org/wiki/Windows_Calendar
http://en.wikipedia.org/wiki/Windows_Mail
http://en.wikipedia.org/wiki/Windows_Mail
http://en.wikipedia.org/wiki/Windows_Movie_Maker
http://en.wikipedia.org/wiki/Windows_Photo_Gallery
http://en.wikipedia.org/wiki/Freeware
http://en.wikipedia.org/wiki/Windows_Essentials
http://en.wikipedia.org/wiki/Windows_Essentials


abletodownloadthemfromyourhardwaremanufacturer’swebsiteafteryousetup Windows 7.
 IfyouarereinstallingWindows7onanexistingcomputer,youneedabackupcopy of your

files and settings. The installation process will delete all of your files. You can use
the File and Settings Transfer Wizard to store your files and settings on removable
media and then restore them after installation iscomplete.

Installation process

InstallingWindows7cantakeuptotwohours.Tomaketheprocessmore manageable,it has
been broken up into several sections.

ToBeginInstallation:

1. InserttheWindows7CDintoyourcomputerandrestartyourcomputer.
2. IfpromptedtostartfromtheCD,pressSpacebar.Ifyoumisstheprompt(itonly appears

for a few seconds), restart your computer to tryagain.
3. Windows7Setupbegins.Duringthisportionofsetup,yourmousewillnotwork,so you

must use the keyboard. On the Welcome to Setup page, pressEnter.
4. On theWindows 7 Licensing Agreement page, read the licensing agreement. Press

the Page Down key to scroll to the bottom of the agreement. Then pressF8.
5. This page enables you to select the hard disk drive on which Windows 7 will be

installed. Once you complete this step, all data on your hard disk drive will be
removedandcannotberecovered.Itisextremelyimportantthatyouhavearecent backup
copyof your files before continuing. When you have a backup copy, press D, and
then press L when prompted. This deletes your existing data.

6. PressEnter toselectunpartitionedspace, whichappearsbydefault.
7. Press Enteragain to select Formatthepartition usingthe NTFSfilesystem, which

appears by default.
8. Windows 7 erases your hard disk drive using a process called formatting and then

copiesthesetupfiles.Youcanleaveyourcomputerandreturnin20to30minutes.

ToContinuethe Installation

1. Windows7restartsandthencontinueswiththeinstallationprocess.Fromthispoint
forward, you can use your mouse. Eventually, the Regional and Language Options
page appears. Click Next to accept the default settings. If you are multilingual or
preferalanguageotherthanEnglish,youcanchangelanguagesettingsaftersetup is
complete.

2. On the Personalize Your Software page, type your name and your organization
name.Someprogramsusethisinformationtoautomaticallyfillinyournamewhen
required. Then, click next.

3. On the Your Product Key page, type your product key as it appears on your
Windows7 CDcase.The productkeyisuniqueforeveryWindows7 installation. Then,
click Next.

4. On the Computer Name and Administrator Password page, in the Computer name
box, type a name that uniquely identifies your computer in your house, such as
FAMILYROOM or TOMS. You cannot use spaces or punctuation. If you connect
your computer to anetwork, you will use thiscomputernametofindsharedfiles



and printers. Type a strong password that you can remember in the Administrator
passwordbox,andthenretypeitintheConfirmpasswordbox.Writethepassword down
and store it in a secure place. Click Next.

5. OntheDateandTimeSettingspage,setyourcomputer’sclock.Then,clickthe Time
Zone down arrow, and select your time zone. Click Next.

6. Windows7willspendaboutaminuteconfiguringyourcomputer.Onthe
Networking Settings page, click next.

7. OntheWorkgrouporComputerDomainpage,clickNext.

To complete the installation

1. Windows 7 will spend 20 or 30 minutes configuring your computer and will
automaticallyrestartwhenfinished.When theDisplaySettingsdialogappears,click OK.

2. WhentheMonitorSettingsdialogboxappears,clickOK.
3. Thefinalstageof setup begins.On theWelcometo MicrosoftWindowspage, click Next.
4. On the Helpprotect yourPCpage,clickHelpprotectmyPCbyturningon

Automatic Updates now. Then, click Next.
5. Windows7willthencheckifyouareconnectedtotheInternet:

o If you are connected to the Internet, select the choice that describesyour
networkconnectionontheWillthiscomputerconnecttotheInternetdirectly,
orthrougha networkpage. If you’re not sure,acceptthe defaultselection, and
click Next.

o If you use dial-up Internet access, or if Windows 7 cannot connect to the
Internet,youcanconnecttotheInternetaftersetupiscomplete.OntheHow will
this computer connect to the Internet? page, click Skip.

6. Windows 7 Setup displays the Ready to activate Windows page. If you are
connectedtotheInternet, clickYes, and thenclickNext. If youarenot yet
connectedtotheInternet,clickNo,clickNext,andthenskiptostep24.Aftersetup
iscomplete,Windows7willautomaticallyremindyoutoactivateandregisteryour copy of
Windows 7.

7. OntheReadytoregisterwithMicrosoftpage,clickYes,andthenclickNext.
8. OntheCollectingRegistrationInformationpage,completetheform.Then,click Next.
9. OntheWho willusethiscomputerpage,typethenameofeachpersonwhowill

usethecomputer.Youcanusefirstnamesonly,nicknames,orfullnames.Then click
Next.

10. OntheThankyou!Page,clickFinish.

Windows 7 setup is complete. You can log on by clicking your name on the logon
screen. If you’ve installedWindows 7 on a new computer or new hard disk drive,
youcannowusetheFileandSettingsTransferWizardtocopyyourimportantdata to your
computer or hard disk drive.

MS-DOS



Short for Microsoft Disk operating system, MS-DOS is a non-graphical command line
operating system derived from 86-DOS that was created for IBM compatible computers.
MS-DOSoriginallywrittenby TimPetersonandintroducedby MicrosoftinAugust 1981 and was
last updated in 1994 when MS-DOS 6.22 was released. Today, MS-DOS is no longer used;
however, the command shell, more commonly known as the Windows command line is
still used by many users.

Today, most computer users are only familiar with how to navigate Microsoft Windows
using the mouse Unlike Windows, MS-DOS is a command-line and is navigated by using
MS-DOS commands. For example, if you wanted to see all the files in a folder in Windows
you would double-click the folder to open the folder in Windows Explorer. In MS-DOS, to
view that same folder you would navigate to the folder using the CD command and then
list the files in that folder using the dircommand.

DOS Commands

MS-DOS has a relatively small number of commands, and an even smaller number of
commonly used ones. Moreover, these commands are generally inflexible because, in
contrast to Linux and other Unix-like operating systems, they are designed to
accommodate few options or arguments (i.e., values that can be passed to the
commands).

Some of the most common commands are as follows (corresponding commands on Unix-
like operating systems are shown in parenthesis):

CD-changesthecurrentdirectory(cd)
COPY - copies a file (cp)
DEL-deletesa file(rm)
DIR-listsdirectorycontents(ls)
EDIT-startsaneditortocreateoreditplaintextfiles(vi,vim,ed,Joe) FORMAT -
formats a disk to accept DOS files (mformat)
HELP-displaysinformationaboutacommand(man,info) MKDIR -
creates a new directory (mkdir)
RD-removesadirectory(rmdir) REN -
renames a file (mv)
TYPE-displayscontentsofafileonthescreen(more,cat)

OtherDOSCommand commonlyused are:

Append
Theappendcommandcanbeusedbyprogramstoopenfilesinanotherdirectoryasif they were
located in the current directory.
Attrib
Theattribcommandisusedtochangetheattributesofasinglefileoradirectory.
Break
ThebreakcommandsetsorclearsextendedCTRL+Cchecking.
Call
Thecallcommandisusedtorunascriptorbatchprogramfromwithinanotherscriptor batch
program.
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Thecallcommandhasnoeffectoutsideofascriptorbatchfile.Inotherwords,running the call
command at the DOS prompt will do nothing.
Chcp
Thechcp command displaysorconfigures the active codepage number.
Chdir
Thechdircommandisusedtodisplaythedriveletterandfolderthatyouare currentlyin.
Chdircanalso be usedto change thedrive and/ordirectorythat youwant to workin.
Chkdsk
Thechkdskcommand,oftenreferredtoascheckdisk,isusedtoidentifyandcorrect certain hard
drive errors.
Choice
Thechoicecommandisusedwithinascriptorbatchprogramtoprovidealistofchoices and return
the value of that choice to the program.
Cls
Theclscommandclearsthescreenof allpreviouslyenteredcommandsandothertext.
Dir
Thedircommandisusedtodisplayalistoffilesandfolderscontainedinsidethefolder that you are
currently working in.
The dir command also displays other important information like the hard drive's serial
number,thetotalnumberoffileslisted,theircombinedsize,thetotalamountoffreespace left on
the drive, and more.
DIR[drive:][path][filename][/P][/W][/A[[:]attributes]][/O[[:]sortorder]][/S][/B][/L][/V]

[drive:][path][filename]Specifiesdrive,directory,orfilestolist.(Couldbeenhancedfile
specification or multiple file specs)

/P Pauses aftereachscreenfulofinformation.
/W Useswidelistformat.

attributes:
DDirectories
RRead-onlyfiles

/A HHidden files
AFilesreadyforarchiving S
System files
-Prefixmeaningnot
Listbyfilesinsortedorder,sortorder: N
By name (alphabetic)
SBysize(smallestfirst)

/O EByextension(alphabetic)
DBydateandtime(earliestfirst)
GGroupdirectoriesfirst
-Prefixtoreverseorder
AByLastAccessDate(earliestfirst)

/S Displaysfilesinspecifieddirectoryandallsubdirectories.
/B Usesbareformat(noheadinginformationorsummary).
/L Useslowercase.
/V Verbosemode.

http://www.computerhope.com/jargon/m/multfile.htm


MS-OFFICE

(MsWord, Msexcel,MsPowerPoint)
MicrosoftOfficeis an office suite of desktop applications, servers andservicesfor the
MicrosoftWindows and OS X operating systems, introduced by Microsoft on August 1, 1989.
Initiallya marketingterm fora bundledset of applications, thefirst versionof Office contained
Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. Over the years, Office
applications have grown substantially closer with shared features such as
acommonspellchecker,OLEdataintegrationandMicrosoftVisualBasicfor Applications scripting
language. Microsoft also positions Office as a development platform for line-of-business
software under the Office Business Applications brand. Office is reported to now be used
by over a billion people worldwide.

ThecurrentversionsareOffice2013forWindows,releasedonOctober11,2012
andOffice2011forOSX,releasedOctober26,2010.On24October2012,theRTMfinal code of
Office 2013 Professional Plus has been released to TechNet and MSDN
subscribersfordownload.On15November2012,the60-daytrialversionofOffice2013
ProfessionalPluswasreleasedfordownload.

MS-WORD
Microsoft →ord is an example of a program called a “word processor.” The key benefit to
using a word processor is that you can make changes easily, including correcting spelling;
adding, deleting, formatting, and relocating text; and inserting images. Once you create a
document, you can effortlessly print it (as many copies as you want!), save it for later
modifications, or send it to a friend via e-mail. Microsoft Word is a very powerful word
processor—this handout was created using just a small number of its features!

Microsoft WordisavailableonbothPCsandMacs,sowhatyoulearninclasstoday should be
applicable to any computer you use. The program may look slightly different
dependingontheversionandcomputerthatyou’reusing,butMicrosoft→ordwillfunction in the
same basic ways. There are other word processors out there, including OpenOffice.org
Writer, WordPerfect, Apple Pages, and WordPad. They have manyfeatures in common
with MicrosoftWord, and you should feel free to choose any program you prefer.

OpeningMicrosoft Word
To get started with Microsoft →ord (sometimes called “MS →ord”), you will need to locate
and open the program on your computer. To open the program, point to →ord’s icon on
thedesktopwithyourmouseanddouble-clickonitwiththeleftmousebutton.Ifyoudon’t see the
MS →ord icon on your desktop, you’ll have to access the program from the Start Menu.
Click on the button in the bottom left corner to pull up the Start Menu. You should
seetheMS→ordiconhere,soclickonitoncewithyourleftbutton.Ifyoustilldon’tseeit, click on “All
Programs” and scroll through the list of programs until you find it. Click once with your
leftbutton to open the program. Occasionally, MicrosoftWord will be in a folder



called “Microsoft Office” or something similar—this will make one more step between “All
Programs” and “Microsoft →ord.”

MS→ordwillthenopenablankpagecalled“Document1.”
This is an image of the upper-left corner of MS Word. This box features two important
pieces of information: the name of the file that you are currently working on (in this case,
“Document 1” since we have not yet renamed it) and which program you are using
(“Microsoft →ord”).There should nowbe a blinkingline in the top left cornerof the partof
the screen that looks like a sheet of paper. This means you will be able to type in this
space!

MicrosoftWordFeatures

TheTitleBar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Itshowsthename
ofthefile(here,“Microsoft→ord”)andthenameoftheprogram(“Microsoft→ord”).Notice the
threebuttonsonthe right side, controllingthe size and closingoftheprogram.
Minimize: Left click this button to shrink the window down to a small button that will
appear in the task bar
Maximize: Left click this button to make the window as large as it can be—it should take
up your entire screen.
Close:Left-clickthisbuttontoclosethewindow.Theprogramwillcloseandstoprunning. Make
sure you save your work first!
RestoreDown:
Left-clickthisbuttontomakethewindowsmallerwithoutminimizingit.ThetabbedRibbon menu
system is how you navigate through Word and access various Word commands. If



you have used previous versions of Word, the Ribbon system replaces the traditional
menus.

The FileMenu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the
top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in the
Ribbon called “File.”
When you left-click on this tab, a drop-down menu appears. From this menu, you can
perform the same functions as were found under the Microsoft Office Button menu, such
as: Create a new document, open files, save files in a variety of ways, and print.
QuickAccessToolbar
On the top left-hand side of the Title Bar, you will see several little icons above the File
menu. These let you perform common tasks, such as saving and undoing, without having
tofindtheminamenu.→e’llgooverthemeaningsof theiconsalittlelater.

TheHomeTab

The most commonly used commands in MS Word are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers optionsthat
can change the font, size, color, alignment, organization and style of the text in the
document.Forexample,the“TimesNewRoman”IndicatestheFONTofyour text,the“12”
indicates the SIZE of your text; etc. We will go over how to use all of these options to
formatyourtextinalittlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-click
onthetinydown-arrowinthebottomrightcornerof thewindow.Therulerisfoundbelow the
Ribbon. The ruler tells you where you are on the page, along with the dimensions of the
overall document. Just like a real piece of paper, the default setting is 8.5 x11 inches, and
the margins have been incorporated for you. Similar to most options in MSWord, this is
entirely customizable and the user can create a document of anydimensions.

Keyboard Review

In order to use MSWord effectively, you must input commands usingboth the mouseand
the keyboard.The above image of a keyboard should look similar to the keyboard infront
ofyou;learningjustafewcertainkeyswillhelptoimproveyourefficiencyintyping,aswell as
present you with more options within the program. The following is a list of commonly
used keys that have special functions in MS Word (key functions can change dependingon
which program you are using) :

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondary

Function.

4. Spacebar:Thiskeyentersaspacebetween wordsorletters.

5. Tab:Thiskeywillindentwhatyoutype,ormovethetexttotheright.Thedefault



Indentdistanceisusually½inch.

6. CapsLock:Pressingthiskeywillmakeeveryletteryoutypecapitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter:Thiskeyeithergivesyouanewline,orexecutesacommand(pressedin MS

Word, it begins a new line).

9. NumberKeypad:Theseareexactlythesameasthenumbersatthetopofthe

Keyboard; some people just find them easier to use in this position.

10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocument.

MICROSOFT WORDBASICS

TypingText

To enter text, type just as you would if you were using a typewriter. To capitalize a letter,
hold down the SHIFT key while typingthe letter. Or, press the CAPS LOCK keyon the left-
hand side of your keyboard. You will have to press the CAPS LOCK key again—once you
are done capitalizing—to remove the lock. You do not need to press ENTER to start a new
line—MicrosoftWordwillautomaticallywrap yoursentence attheendof the line.Tomove
thecursorfromitspositionattheendof yoursentencetoanywhere elseonthepage,use the
mouse or the arrow keys to move the cursor where you want the letters or spaces to
be(left-clickthemousetoplacethecursor)andthentypewhatyouwanttoadd—thetext will
automatically adjust to include it. Press ENTER to start a new paragraph (this is
sometimes called a “carriage return”).

Deleting Text

While typing a document, sometimes you will make a mistake. Unlike a typewriter, MS
Word can delete text on the screen and leave no trace—it is as if you never typed on the
page in thefirstplace.Thereare two different buttons on the keyboard that will allow you to
erase text. They are the “Delete” key and the “Backspace” key (#s 1 and 2 on the
keyboard map on page. The “Backspace” key deletes words to the LEFTofthecursor, and
the “Delete” key deletes words to the RIGHT of the cursor.

BACKSPACE↔ DELETE

Let’sassumethattheverticallinedissectingtheword“creative”intheexampleaboveis

Ourcursor.Pressingthe “Backspace”keywillerase “a,”“e,”“r,”“c,”and so on,moving

LEFT.The “Delete”keywillerase “t,”“i,”“v,”“e,”and soon,moving RIGHT.

Todeleteawholechunkoftextatonce,left-clickwithyourmouseanddragtohighlight



asectionoftext.Thensimplypress“Backspace”or“Delete”andallofthehighlighted Text will

disappear.

Undoingand Redoing

The UNDO and REDO features of Microsoft Windows applications are great tools to rely on.
The program will keep a list of the last 25 commands that you have performed, and it
allowsfortaking“onestep”backwardsinordertoerasewhatyouhavejustdone.Clickon the UNDO
button in the Quick Access Toolbar to go back one step. Click on the REDO button in the
Quick Access Toolbar to go forward one step.

FormattingText

Changing the look of what you’ve written is called “formatting.” This can include changing
the text style, size, color, and more. This is a sentence that features many different fonts.
This is a sentence that features many different sizes. From the Home Tab, the “B” will
makeyourtextBOLD,the“I”willputitinitalics,andthe“←”willaddanunderlinetoyour text. These
features do not have to be used independently of each other—in other words, you can
bold, underline, and italicize a single piece of text. The alignment of the text can be
altered using the buttons with the horizontal lines on them. You can align text To the LEFT,
To the CENTER and to the RIGHT.

In order to apply certain stylistic or formatting changes to text, you must first
HIGHLIGHT the text. This is a common procedure in Microsoft Windows applications, And
because it is so useful, it is a skill worth practicing. You can also change the font color by
clicking on the appropriate buttons in the

Formatting Toolbar. Experiment and remember—you can always start over with a fresh,
newdocument,sodon’tworryaboutmakingmistakes!Ifyoudo,however,thereisalways
theincredible“←NDO” tool.Cutting,Copying,andPastingTextinMS→ord,youcanC←T or COPY
text from one area of the document and save that text to be PASTED elsewhere (these
commands are found on the Home Tab).When you CUT text, you actually delete it from
where you took it, as opposed to COPYING it, which makes a copy of yourselection.

WhenyouCUTorCOPYtext,itisstoredontheCLIPBOARD.TheClipboardisatoolin MS Word that
stores cuts and copies of your work, to be pasted in other places in the
document.OnceyourselectionisontheCLIPBOARD,youcanPASTEitasmanytimes as you want!
CUTTING a selection will place it on the clipboard, just in case you want to PASTE it
elsewhere. To CUT a selection, firsthighlight it. Then, click on the CUT icon from
theHomeTab.Thehighlightedtextwilldisappear,asyouhavejustcutitout,butacopyis now on
your clipboard, and MS Word is waiting for you to paste it somewhereelse.

To PASTE this cut selection, place your cursor where you want the selection to go. Clickon
the PASTE icon from the Home Tab toolbar, and it will pop the text into place, right
whereyouhaveyourcursor.ToCOPY,simplyfollowthosesamesteps,replacingthe
CUTcommandwithCOPY.TheCOPYcommandwillnotalteryouroriginalselectionat all, as it
simplymakesa copyof theselectionwithout changingor deletingit in anyway.



DOINGMORE WITHMICROSOFT WORD

InsertingImagesandClipArt

With Microsoft Word, you can insert pictures in your document using the Insert Tab
toolbar.↔oucaninsertpicturesfromthe“ClipArt”albumthatcomeswiththeprogram,or you can
insert pictures from a file that you have previously saved on a disk or elsewhere on the
computer (e.g., the My Pictures folder).Clip Art is a collection of cartoon and computer-
generated images that cover a broad array of commonly needed icons and pictures. These
include business, holiday, nature, entertainment, academic and other themes, along with
standard bullets and symbols.

To insert a clip art picture into a Microsoft Word document, you will first need to place
your cursor (left-click) where you wish to insert you picture in your document. Then, from
the Insert tab on the Ribbon, click on “Clip Art.” A Clip Art search box will appear on the
right side of your screen. From here, you can enter a search word for the picture you
wouldliketo find.Thenclick“Go.”Thiswillshowalltheoptionsofpicturesyoucaninsert.
Whenyouseeapieceofclipartthatyoulike,clickonit,anditwillautomaticallyinsertinto your
document, in the exact place where you left the cursor. To resize your image, grab one of
the corners of the image by left-clicking and holding—drag it to your desired size and fine-
tune the placement. The cursor will change from a typing icon to a double arrow when it
can be used to resize an image.

Dragthecornertowardtheupper-leftcornerofthescreen,andtheimagewillgrow.Drag
towardthebottom-right,anditwillshrink.Youcanmovetheimagetoanotherplaceinthe document
by left-clicking and holding on the center of it; drag it to its desired location. More options,
such as aligning the image with text (or special effects like wrapping text around or
through an image) can be found by clicking on the picture, and then choosing the Picture
Tools Tab. You can also insert a photograph or other images from your files using this
same process. On the Insert Tab, click on Picture and locate the files that you want to
include.

ModifyingLine Spacing

Line spacing in Word refers to the amount of space between lines of text. The default in
Word 2010 is 1.15 spacing, which leaves a little bit more space than single-spacing, or
whatyou wouldfindinanormalbook.Singlespacing is generallyeasyfortheeyetoread. There
may be times, however, when you want to change this spacing. One common option is to
double-space text: This text is double-spaced. Double-spacing is especially useful if
someone else is proof reading your document. It allows for more room to write comments
on the page.

Tochange theline spacing:

1. Selecttextyouwanttoformatbyhighlightingit.

2. OntheHomeTab,clickontheLineSpacingbuttonintheParagraphgroup.



3. Choose the spacing you want from the menu that appears. For more options, select
Line Spacing Options. In the dialog box that appears, you can choose other spacing
options, including spacing between paragraphs. This can be done by changing the values
in the Before and After boxes.

CreatingBulletedand NumberedLists

Wordallows you to createlists within yourdocumentthat can be organized with bullets or
numbers. Lists are useful for presenting text that wouldn’t make the most sense in
paragraph form (for example, step-by-step instructions) or for emphasizing key points
Bulletsareusuallysmallcirclesatthebeginningof iteminalist,andnumbersareusedfor lists that
are arranged in sequential order. Here’s an example of a bulleted list:

 Bananas
 Milk
 Eggs
 IceCream

Tocreatealist:

1. On the Home tab, select either the Bullets or Numbering buttons from the Paragraph
group. If you want to choose a particular style for your bullets or numbers, click on the
triangle next to thebutton and choose astyle from themenuthatappears.

2. You will see the first bullet or number appear on your document. Type your first line of
text and then hit Enter.

3. Another bullet or number will appear automatically. Type your next line of text and hit
Enter.

4. Whenyouhavefinishedyourlist,hitEntertwicetoendthebulletsornumbering.

ChangingViewsandOverall Look

There will be times when you need to create documents that don’t fit on a standard piece
of paper (8.5” by 11”).

ClickonthePageLayoutTab.

From this menu, you can alter the margins, width, height, and orientation (portrait =
11”14long; landscape = 11” wide) of the document, as well as choose from a variety of
templates, different types of paper, and document styles that come with the program. To
change the orientation of your page, clickon the Orientation button.

Click on Landscape from the drop-down box that appears. Your document should now be
in landscape position. If you wish to return to portrait orientation, go through the same
steps, clickingon theLandscape option instead of Portrait. If you would like to change the
displayof yourdocumentorzoominandoutwithoutaffectingthewayyourdocumentwill



print, you can dothatfrom the ViewTab.Anything you changefrom the ViewTab willnot
changethewayyourdocumentprintsout.Soifyouwantyourtext tobebiggerwhenyou
printoutthedocument,makesuretochangethesizeof the fontinsteadof thezoom.

SpellingandGrammar Check

Onebenefitof usingacomputerizedwordprocessorisitsabilitytorecognize,change,and give
advice about your writing. MS Word has utilities that can check your spelling and grammar
against a master database, and can offer advice on a variety of different grammatical
styles. MS Word automatically underlines any words that it does not recognize in red,
assuming that they are not spelled correctly, and underlines in green if it does not
recognize the grammatical pattern, assuming that the sentence does not make sense.

Forexample:Inthiscase,“jumping”shouldread“jump”and“laziy”shouldbe“lazy.”Ifyou right
click on the word, a menu with pop up with options, including “Ignore” if you do not want
help on this specific phrase or agree with the suggestion. You can also choose toadd
words to the MS Word spellingdatabase, if you aregoingto use them often and don’t want
them to be flagged as misspelled every time—this is especially useful for names, as MS
Word often interprets these as misspellings. The spelling and grammar tools can be found
in the Review Tab

USINGMICROSOFTWORD

Microsoft →ord is an example of a program called a “word processor.” →ord processors
are used to create and print text documents in much the same way that you would use a
typewriter.Thekeybenefittousingawordprocessoristhatyoucanmakechangeseasily,
includingcorrectingspelling;adding,deleting,formatting,andrelocatingtext;andinserting
images. Once you create a document, you can effortlessly print it (as many copies as you
want!), save it for later modifications, or send it to a friend via e-mail. Microsoft Word is a
very powerful word processor—This handout was created using just a small number of its
features! Microsoft Word is available on both PCs and Macs, so what you learn in class
today should be applicable to any computer you use. The program may look slightly
differentdependingontheversionandcomputerthatyou’reusing,butMicrosoft→ordwill function
in the same basic ways. There are other word processors out there, including
OpenOffice.org Writer, WordPerfect, Apple Pages, and WordPad. They have manyfeatures
in common with MicrosoftWord, and you should feel free to choose any program you
prefer.

OpeningMicrosoft Word

To get started with Microsoft →ord(sometimescalled “MS →ord”), you will need to locate
and open the program on your computer. To open the program, point to →ord’s icon on
thedesktopwithyourmouseanddouble-clickonitwiththeleftmousebutton.Ifyoudon’t see the
MS →ord icon on your desktop, you’ll have to access the program from the Start Menu.
Click on the button in the bottom left corner to pull up the Start Menu. You should
seetheMS→ordiconhere,soclickonitoncewithyourleftbutton.Ifyoustilldon’tseeit, click on “All
Programs” and scroll through the list of programs until you find it. Click once with yourleft
button toopen the program.



Occasionally, Microsoft →ord will be in a folder called “Microsoft Office” or something
similar—this will make one more step between “All Programs” and “Microsoft →ord.”MS
Word will then open a blank page called “Document 1.”This is an image of the upper-left
cornerofMSWord.Thisboxfeaturestwoimportantpiecesofinformation:thenameofthe file that
you are currently working on (in this case, “Document 1” since we have not yet renamed it)
and which program you are using (“Microsoft →ord”).There should now be a
blinkinglineinthetop leftcornerof thepartof thescreenthatlookslikeasheetof paper. This
means you will be able to type in this space!

MICROSOFT WORDBASICS

TypingText

To enter text, type just as you would if you were using a typewriter. To capitalize a letter,
hold down the SHIFT key while typingthe letter. Or, press the CAPS LOCK keyon the left-
hand side of your keyboard. You will have to press the CAPS LOCK key again—once you
are done capitalizing—to remove the lock. You do not need to press ENTER to start a new
line—MicrosoftWordwillautomaticallywrap yoursentence attheendof the line.Tomove
thecursorfrom itspositionattheendof yoursentencetoanywhereelseonthepage,use the
mouse or the arrow keys to move the cursor where you want the letters or spaces to
be(left-clickthemousetoplacethecursor)andthentypewhatyouwanttoadd—thetext will
automatically adjust to include it. Press ENTER to start a new paragraph (this is sometimes
called a “carriage return”).

Deleting Text

While typing a document, sometimes you will make a mistake. Unlike a typewriter, MS
Word can delete text on the screen and leave no trace—it is as if you never typed on the
page in thefirst place.Thereare two different buttons on the keyboard thatwill allow you to
erase text. They are the “Delete” key and the “Backspace” key (#s 1 and 2 on the
keyboard map on page.

The “Backspace” key deletes words to the LEFT of the cursor, and the “Delete” keydeletes
words to the RIGHT of the cursor.

MicrosoftWordFeatures

The Title Bar

Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Itshowsthename
ofthefile(here,“Microsoft→ord”)andthenameoftheprogram(“Microsoft→ord”).Notice the
threebuttonsonthe right side, controllingthe size and closingoftheprogram.

Minimize: Left click this button to shrink the window down to a small button that will
appear in the task bar

Maximize: Left click this button to make the window as large as it can be—it should take
up your entire screen.



Close:Left-clickthisbuttontoclosethewindow.Theprogramwillcloseandstoprunning. Make
sure you save your work first!

RestoreDown:Left-clickthisbuttontomakethewindowsmallerwithoutminimizingit.

The FileMenu

In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the
top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in the
Ribboncalled“File.”→henyouleft-clickonthistab,adrop-downmenuappears.Fromthis menu,
you can perform the same functions as were found under the Microsoft Office Button
menu, such as: Create a new document, open existing files, save files in a variety of ways,
and print.

TheHomeTab

The most commonly used commands in MS Word are also the most accessible. Some of
these commands available in the Home Tab are: The Home Tab Toolbar offers optionsthat
can change the font, size, color, alignment, organization and style of the text in the
document.Forexample,the“TimesNewRoman”indicatestheFONTofyourtext,the“12” indicates
the SIZE of your text; etc. We will go over how to use all of these options to
formatyourtextinalittlewhile.Eachoftheseoptionsexpandsintoamenuifyouleft-click
onthetinydown-arrowinthebottomrightcornerofthewindow.

The Ruler

The ruler isfound belowthe Ribbon. The ruler tells you where you are on the page, along
with the dimensions of the overall document. Just like a real piece of paper, the default
settingis8.5x11inches,andthemarginshavebeenincorporatedforyou.Similartomost options in
MS Word, this is entirely customizable and the user can create a document of any
dimensions.

Keyboard Review

In order touse MSWord effectively, you must input commands usingboth themouse and
the keyboard. The above image of a keyboard should look similar to the keyboard in front
ofyou;learningjustafewcertainkeyswillhelptoimproveyourefficiencyintyping,aswell as
present you with more options within the program. The following is a list of commonly
used keys that have special functions in MS Word (key functions can change dependingon
which program you are using)

1. Backspace:Thiskeydeleteslettersbackward.

2. Delete:Thiskeydeleteslettersforward.

3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.

4. Spacebar:Thiskeyentersaspacebetween wordsorletters.



5. Tab:Thiskeywillindentwhatyoutype,ormovethetexttotheright.Thedefaultindent distance
is usually ½ inch. 6. Caps Lock: Pressing this key will make every letter you type
capitalized.

7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.

8. Enter:Thiskeyeithergivesyou a newline, orexecutesa command(pressed inMS Word,
it begins a new line).

9. NumberKeypad:Theseareexactlythesameasthenumbersatthetopofthe keyboard; some
people just find them easier to use in this position.

10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocumentor page.

MICROSOFTEXCEL
Microsoft Excel is an example of a program called a “spreadsheet.” Spreadsheets areused
to organize real world data, such as a check register or a rolodex. Data can be numerical
or alphanumeric (involving letters or numbers). The key benefit to using a spreadsheet
programisthatyou canmake changeseasily, includingcorrectingspellingor values, adding,
deleting, formatting, and relocating data. You can also program the
spreadsheettoperformcertainfunctionsautomatically(suchasadditionandsubtraction), and a
spreadsheet can hold almost limitless amounts of data—a whole filing cabinet’s worth of
information can be included in a single spreadsheet. Once you create a spreadsheet, you
can effortlesslyprint it (asmany copies as you want!), save it for later modifications, or
send it to a colleague via e-mail. Microsoft Excel is a verypowerful.

OpeningMicrosoftExcel
To get started with MicrosoftExcel (often called “Excel”), you will need to locate andopen
the program on your computer.To open theprogram, point to Excel’s icon on the desktop
with your mouse and double-click on it with the left mouse button. If you don’t see the
Excel icon on your desktop, you’ll have to access the program from the Start Menu. Click
on the button in the bottom left corner to pull up the Start Menu. You may see the Excel
icon here, so click on it once with your left button. If you still don’t see it, click on “All
Programs”andscrollthroughthelistofprogramsuntilyoufindit.Itmayalsobelocatedin a folder
called “Microsoft Office” or something similar—it will depend on your specific
machine.Clickoncewithyourleftbuttontoopentheprogram.Excelwillthenopenablank page
called “Book1.”

MicrosoftExcelFeatures



The Title Bar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Itshowsthename
ofthefile(here,“Book1,”thedefaulttitle)andthenameoftheprogram(“MicrosoftExcel”). You
willbe abletoname yourfile somethingnewthefirst timethatyou save it.Noticethe three
buttons on the right side of the Title Bar, controlling the size and closing of the program.

TheRibbon Menu System
The tabbed Ribbon menu system is how you navigate through Excel and access various
Excelcommands.IfyouhaveusedpreviousversionsofExcel,theRibbonsystem replaces the
traditional menus. At the bottom, left area of the spreadsheet, you will find worksheet
tabs. By default, three worksheet tabs appear each time you create a new workbook. On
the bottom, right area of the spreadsheet you will find page view commands, the zoom
tool, and the horizontal scrolling bar.

The FileMenu
In Microsoft Office 2007, there was something called the Microsoft Office Button ( ) in the
top left-hand corner. In Microsoft Office 2010, this has been replaced with a tab in the
Ribbon called “File.”→hen you left-click on this tab,a drop-down menuappears. From this
menu, you can perform the same functions as were found under the Microsoft Office
Button menu, such as: Create a new worksheet, open existing files, save files in a variety
of ways, and print.6
Quick Access Toolbar On the top left-hand side of the Title Bar, you will see several little
icons above the File menu. These let you perform common tasks, such as saving and
undoing,withouthavingtofindtheminamenu.→e’llgooverthemeaningsoftheiconsa little later.



TheHomeTab
ThemostcommonlyusedcommandsinExcelarealsothemostaccessible.Someof these
commands available in the Home Tab are: The Home Tab Toolbar offers optionsthat can
change the font, size, color, alignment, organization and style of the text in the
spreadsheet and individual cells. For example, the “Calibri” indicates the FONT of your text,
the “11” indicates the SI↕E of your text; etc. →e will go over how to use all of these
options to format your text in a little while. Each of these options expands into a menu if
you left-click on the tiny down-arrow in the bottom right corner of the window. This tab
works the exact same way as the MS Word Formatting Toolbar. The main difference isthat
the format changes will only affect the selected cell or cells, all unselected cells
remaininthedefaultsetting(“Calibri”font,size“11”).

Equation Editor
The Equation Editor is generally found below the ribbon menu. The left side denotes
whichcellisselected(“C5”)andtherightsideallowsyoutoinputequationsortextinto the
selected cell.
Therearetwo waystoinputinformationintoa cell.Youmayeitherselectanindividualcell and type
the equation or text into the equation editor or type the equation or text directly into the
selected cell.Equations (forexample, =SUM(D5+E5)) will automaticallybe hidden
insidethecellandcanonlybe viewedusing theequationeditor;theresultof theequation
willdisplayinthecell.Ifanywrittentextislongerthanthecellwidth,thenthespreadsheet will cover
up anyportion longer than the cellwidth. The information will still be in the cell, you just
won’t be able to see it at all times.

Keyboard Review
In orderto use Exceleffectively, you must input commands usingboth the mouse and the
keyboard. The above image of a keyboard should look similar to the keyboard in front of
you;learningjustafewcertainkeyswillhelptoimproveyourefficiencyintypingaswellas
presentyouwithmoreoptionswithintheprogram.Thefollowingisalistofcommonlyused keys
that you may already be familiar with:
1. Backspace:Thiskeydeletesletters backwards.
2. Delete:Thiskeydeleteslettersforward.
3. Shift:Thiskey,whenpressedWITHanotherkey,willperformasecondaryfunction.
4. Spacebar:Thiskeyentersaspacebetween wordsorletters.
5. Tab:Thiskeywillindentwhatyoutype,ormovethetexttotheright.Thedefaultindent distance
is usually ½ inch.
6. CapsLock:Pressingthiskeywillmakeeveryletteryoutypecapitalized.
7. Control(Ctrl):Thiskey,whenpressedWITHanotherkey,performsashortcut.
8. Enter:Thiskeyeithergivesyouanewline,orexecutesacommand.
9. NumberKeypad:Theseareexactlythesameasthenumbersatthetopofthe
keyboard; some people just find them easier to use in this position.
10. ArrowKeys:Likethemouse,thesekeysareusedtonavigatethroughadocumentor page.

Pointer Shapes
As with other Microsoft programs, the pointer often changes its shape as you work in
Excel.Eachpointershapeindicatesadifferentmodeofoperation.Thistableshowsthe various
pointer shapes you may see while working in Excel.



MICROSOFTEXCEL BASICS

Formatting Cells
Cells are the small rectangular boxes that make up the spreadsheet. All the information
entered into an Excel spreadsheet is entered into cells. The cell width and height will
usuallyneed to be adjusted to viewall the information entered into a cell.

To adjust the cell width, move the mouse pointer in between two cell columns in the
column header. Hold down the left mouse button and drag the mouse left to shorten the
widthorrighttoexpandthe width.Noticethatallcellswithinthecolumnareautomatically adjusted.
Adjust the cell height using the same method. Move the mouse cursor between
tworows,holddowntheleftmousebuttonandmovethemouseuptodecreasetheheight and down
to increase the height. Before you begin entering data into a spreadsheet, you may
already know the width and height you want your cells to have. In this case, you can
adjust all the widths and heights by doing the following: Select the “square” between
Column A and Row 1.

ThiswillselectALLthecellsinthespreadsheet.Fromthe“Home”tabof theRibbonMenu,
withinthe“Cells”box, clickon“Format,”andselectRowHeight.↔ouwillnowbeaskedto enter a
numerical value for height. The default value is 15, but you can enter your own height
value (10, 20, 25, etc.).

RepeatthesamestepsforColumnwidth.Fromthe“Home”taboftheRibbonMenu,within
the“Cells”box,clickon“Format,”andselectColumnWidth.Notethatthedefaultvaluefor
thewidthis8.43.Enteryourown widthvalue(5,10,15,20,etc.).

For any given cell or selected cells, you can also format the way your data is represented
within the cell(s). Select a single cell or multiple cells.
Again, from the “Home” tab of the Ribbon Menu, within the “Cells” box, click on Format.”
Select “Format Cells.”The format window will now appear, giving you a wide variety of
options on how to format your cell.

Number –Thisallowsyoutochoosehowtorepresentthenumbersthatareenteredintoa cell
(number, currency, time, etc.).
Alignment–Thisdetermineshowthedatawillbealignedwithinthecell(left-side, centered, or right-
side).
Font–Selectthetypeoffonttobeusedwithinthecells.
Border– This option lets you choose what type of border, if any, you would like around
the cells or some of the cells.
Fill –Thisallowsyoutochangethebackgroundcolorofthecell.
Protection– This option allows you to “lock” cell information so that other users cannot
make changes.
TypinginCells
Clickonacellto begintyping init.Itisthateasy!Whenyouarefinishedtypinginthecell,
presstheEnterkeyandyouwillbetakentothenextcelldown.Youcanthenbegintyping in that cell.
You can easily navigate around the cells using your arrow keys. Keep in mind
thattheFormattingtoolbarinMicrosoftExcel2010isexactlythesameastheoneusedfor Microsoft
Word 2010. The biggest difference between the two programs is that, in Excel, the format
is set for each individual cell.



So if you change the font and applied the bold option in cell C5, then this format will only
be applied to cell C5. All remaining cells will remain in default mode until they have been
changed. Sometimes you may only wish to adjust the format of one particular cell. In this
case, simply select the cell by clicking the mouse on it and make any necessary
adjustmentstothefont,size,style,andalignment.Thosechangeswillnotcarryoverwhen you
begin typing in a new cell. Other times, you may wish to adjust the text format of a group
of cells, entire rows, or entire columns.

In Excel, you can choose groups of cells in rectangular units—all the
cells you select must form a rectangle of some kind. To select a group of cells, begin by
clicking on the cell that would be in the upper-left hand corner of your rectangle. Hold
down the Shift key on your keyboard and use the arrows (›, ‹,‡, $) on the keyboard to
expand the selection of cells, or click and drag your mouse. Once the group of cells has
been selected, you can make adjustments to the font, size, style, and alignment and they
will be applied to all selected cells.

To select an entire row, click on the Row Number with your mouse—note how the entire
row becomes highlighted. All formatting changes will now be applied to the whole row. To
select an entire column, click on the Column Number with your mouse—again, the entire
column will become highlighted. All formatting changes will be applied to the whole
column.

InsertingRowsand Columns.
When you are working on a spreadsheet, you may realize that you left out a row or
column of data and need to add it in. To insert a row, click on the row below where you
wantyournewrowtobe(remembertoclickontherownumbertohighlighttheentirerow).
Fromthe“Home”tab,withinthe“Cells”box,click“Insert.”Select

“Insert Sheet Rows.” A new row will automatically be inserted and the row numbers
automatically adjusted. To insert a column, click on the column to the right of where you
wantyournewcolumntobe(remembertoclickonthecolumnlettertohighlighttheentire column).
From the “Home” tab, within the “Cells” box, click “Insert.” Select “Insert sheet Columns.”
A new column will automatically be inserted and the column letters automatically adjusted.

SortingData
Once you have created your spreadsheet and entered in some data, you may want to
organize the data in a certain way. This could be alphabetically, numerically, or another
way.Let’slookatthefollowingspreadsheetasan example.Thisinformationcanbesorted by
check number, date, alphabetically by description, or using any of the other columns.

First, select all the cells that represent the data to be sorted, including the header
descriptions (Check No., Date, Description, etc.). Then, select the first cell in Row 1(Check
No.) Click and drag to select all the cells that you want to sort. Using the mouse, select
Sort & Filter from the Editing panel. Select Custom Sort…
Select the column you wish to sort by. Do you want to sort by alphabetical order, reverse
alphabetical order, date, or amount? →hen you press “OK,” your spreadsheet will be
sorted in the order that you specified.



AutoSumandExcelEquations
Oneof themostpowerfulfeaturesofExcelis itsabilityto performbasicmathfunctionson data.
Excel can add, subtract, multiply, divide, find the average, and perform general counting
functions on the numerical data that you enter. To enable this feature, highlight all of the
cells in a column,plus one additional emptycell in which to displaytheresult.

SelecttheAutoSumiconfromtheribbonmenu:
If you click directly on the ∑, Excel will automatically add up the numbers you have
selected.Ifyouclickonthelittledropdownarrownexttoit (▼),youwillgetthefullchoice
ofmathematicalfunctions.Ifyoudouble-clickonthecellinwhichtheanswerappears,you will see
an equation that looks something like this (you will also see this equation in the Equation
Editor):
Let’sbreakdownwhatexactlytheequationmeans:
=indicatesthatyouarestartinganequationinthiscell.
SUMtellsthefunctiontobeperformed.Inthiscase,allthecellswillbeaddedtogether.
( )Theparentheses containthecells that thefunction will be performed on.
D2Thisisthefirstcelltobeincludedintheadditionformula.
D8Thisisthelastcelltobeincludedintheadditionformulaindicatesthatallcells between
the first and the last should be included in theformula.
Thespreadsheetwilloften“select”thecellsthatitthinksyouwishtoinclude.Butyou
can manually change the cell range by typing into the Equation Editor. When you are
readytoexecutetheformula,justpressthe“Enter”key.Othermathematicalfunctionsyou can
perform from the AutoSum button include:
Average – This function will calculate the average of the selected cells.
CountNumbers–Thisfunctionsimplycountsthenumberof cellsselected. Max –
This function will return the highest value of the selected cells.
Min–Thisfunctionwillreturnthelowestvalueoftheselectedcells.
*Remember* Excel equations are similar to programming languages, so have some
patience and if at first you don’t succeed, try again. Even Excel professionals create
incorrect formulas on their first try.
Onceyougetanequationtowork,youwilltechnicallybeacomputerprogrammer!
Creating Charts andGraphs:
InExcel,therearealsowaystorepresentyourdatainchartorgraphicalforms.
Tocreateachartorgraph,selecttheInserttabfromtheRibbonMenubar.Inthemiddle of this
new menu, you will see a “Charts” box.
1. Select the range of data to be represented in the chart or graph. Click on your
spreadsheet and select the data to be represented using the same method that you used
to select data in the sorting exercise. For this example, we want to see a visual
comparisonofhowmuchmoneywespentoneachiteminthelist.Selectrows1through8 in rows B,
C, and D.
2. Selectthetypeofchartorgraphyouwishtocreate(forourexample,we’llchooseabar graph).
3. Once you have created your graph, you can now “customize” it by giving it a title and
labeling different parts. You can also make certain design decisions regarding the
appearance of your graph or chart by choosing the different elements under the Design
tab that appears on the Ribbon Menu bar.
4. Finally, you will need to decide if your chart should be pasted on to the existing
spreadsheetorifitshouldbepastedontoabrandnewsheet.Ontheveryrightsideof the



Ribbon Menu bar, select Move Chart. Once the chart or graph has been created and you
realize a mistake has been made or it did not turn out the way you wanted it to, simply
click on the chart or graph and hit the Backspace key on your keyboard to delete it from
your spreadsheet. Don’t be afraid to go back and tryagain!

Multiple Sheets

Sometimes you may find it useful to have multiple spreadsheets for related data. For
example, personal finances are usually tracked on a monthly calendar and it’s generally
goodideatokeeprecordsofthepasttransactions.Excelcancreatemultiple spreadsheets
attached to the same Excel file, one for each month. Tabs for the different sheets are
located in the lower-left corner of the spreadsheet. The spreadsheet that is currently being
worked on is on the top tab. To access another spreadsheet, select the appropriate tab,
such as Sheet 2. The default names for the sheets are usually Sheet1, Sheet2, and
Sheet3.To rename a sheet or to create a new sheet, simply move the mouse pointer over
the sheet name and right-click. Select “Rename” to rename the sheet or select “Insert” to
create a new sheet.

You can transfer cell information between two or more sheets by creating a simple
formula. For example, most people who keep track of their personal finances don’t begin
every month with a balance of $0. Instead, the balance at the beginning of the month is
transferred over from the previous month. So if you have a March 2012 finance
spreadsheet and an April 2012 finance spreadsheet, you can select a cell in the April 2012
sheet and write in the formula

=‘March2012’!D11
The equalssign (=)tellsExcel that the value forthiscellisto be derived from somewhere in
the spreadsheet (such as a formula or another cell location).
‘Sheet name’ tells Excel what sheet to refer to when it retrieves the value. The single
quotation marks (‘ ‘) are important. ! D11 tells Excel that it is to copy the value that is
located in cell D11 (or whatever cells you wish to copy the value from).
Ifyouwanttotransfercellinformationfromonecelltoanotheronthesamesheet,youcan use the
exact same formula; just exclude ‘Sheet name.’

DOINGMOREWITHMICROSOFTEXCEL

Cutting,Copying,andPastingData
Whenyou are typingin yourspreadsheet, itcan be veryhelpful tocut orcopyinformation from
one cell and paste it into another. This can help reduce the amount of typing you have to
do, as well as limit the number of typographical errors. Cutting, copying, and pasting the
contents of cells in Excel is very similar to the way you do itin
MicrosoftWord.
Thesecommandsare allaccessiblefromtheHometab ontheRibbonMenubar.
To CUT the contentsof a cell, click on the cellto select it, then click on the Cut button on
the Home tab. ↔ou will see the border of the cell turn into little “marching ants.” The
contents are now on the Clipboard, ready for you to paste them somewhere else.



To PASTE the cut selection somewhere else, click on the cell where you want the
selection to go. Then click on the Paste button on the Home tab. The selection will now
appear in the new cell and be removed from the original cell.

To COPY the contents of a cell, simply follow the directions above but replace the CUT
command with COPY. This will leave the contents of the original cell in place andmake an
exact copy of them in another cell.

FillingDataacrossColumnsand Rows
Another way to copy text from one cell to another is to drag it or “fill” it across a range of
cells (a row or a column). This is a great method if you want all the text (or numbers) in
column or row to be the same. For example, if you have a spreadsheet for your yearly
budget with a column for rent, you could use this method to fill in all the cells in the rent
column with the same number without re-typing.

Tofillthecontentsofcellsinacolumn:
1. Clickonthecellwiththeinformationyouwanttocopytotheothercells.
2. Hoveryourmouseoverthelittlesquare(calleda“fillhandle”)inthebottomrightcorner of the
highlighted cell border. Your mouse will turn into a cross.
3. Click on the fill handle and drag your mouse (while still holding the button down) down
thecolumnuntilyou’vehighlightedallthecellswhereyouwantthetexttogo.
4. Letgoofthemousebutton.Thetextwillnowappearinallthecellsyouhighlighted.
5. Youcanfollowthesesamestepstofillthecontentsofarowratherthanacolumn— simply
drag your mouse across the row instead of down the column.
You canalso use this technique to copyformulas across columnsand rows in the
spreadsheet.

CLOSINGMICROSOFTEXCEL

SavingSpreadsheets

When you finish your spreadsheet and want to leave the computer, it is important to save
your work, even if you are printing a hard copy. To save your work in Excel, it is essential
to know WHAT you are trying to save and WHERE you are trying to save it.
Click on the File Tab, then click “Save As” to get started. You can change the filename
thatExcelhaschosenjustbytypinganewoneinthe“Filename”boxat thebottomofthe window
that appears. The My Documents folder on your computer’s hard drive is a good placeto
storeyour documents.AblankCD ora USB jumpdrive aregreat portablestorage options and
can contain a LOT of data. Excel will automatically save your document with the suffix
“.xlsx”–this is simply a tag that lets Excel know that your work is specific to this program
and what version it is in. You do not have to type it–just highlight what is there (default is
“Book1”) and write a new file name. ↔ou may also chose to save it in an older format so
that it can be opened with older versions of Excel. After the first save, you can just click
“Save” to preserve your work.

However,itisimportant tonotethat everyfollowingcommandof SAVE willoverwrite your
originalfile,creatingthemostup-to-dateversion.Ifyouwouldliketokeepsavingdifferent versions
of your worksheet, be sure to use the “Save As” function each time you save, using a
slightly different name for each version.



Printing Spreadsheets
To print your Excel document, click on the File Tab, then click “Print” from the left-side
column. A Print Preview and printing options will appear in your Excel window.
Click the large “Print” button to send your worksheet to the printer. ↔ou can change the
number of copies you would like to print, change the paper orientation, choose which
printer you want to use, and more.

Finding More Help
You can get help with Excel by clicking on the Question Mark symbol in the upper-right
handcornerofthemainmenubarorbypressingthe“F1”button.Thiswilltakeyoutohelp from
Office.com, Microsoft’s help website. There are also many other resources and tutorials
available online. ↔ou might try a Google search with the words “Excel 2010” and
thefunction you are trying to perform. Ask your instructorfor helpfindingthese resources if
you have any trouble.

Closing the Program
ClickontheFileTab,thenclick“Exit.” OR
ClickontheXinthetoprightcorneroftheExcelscreen.

MICROSOFTPOWERPOINT
Microsoft PowerPoint is a professional presentation program that allows the user to create
"presentation slides" that can be displayed on the computer screen or through a projector
that is plugged in to the computer. A PowerPoint presentation is a good way to convey
pieces of information, usually in the form of an outline, to a large audience. Generally,
PowerPoint presentations are appealing to users because they are easy to create and edit
and generally small enough to fit onto a CD or a USB Jump Drive. Therefore, a user does
not have to carry around any slides or a slide project, and, if necessary, can make last-
minute changes to the presentation.

MicrosoftPowerPointComponents:



BeforeyougetstartedwithMicrosoftPowerPoint(commonlyreferredtoasPowerPoint),
youwillneedtolocateandopenitonthecomputer.Itmaybeonyourdesktop.
Onthecomputerdesktop:
1. Double-clickontheMSPowerPointicon
IftheMSPowerPointiconisnotonthedesktop,gototheStartmenu:
1. Click ►Start►Programs►MicrosoftPowerPoint*
MSPowerPointwillopenablankpagecalled"Presentation1."

TheTitleBar
Thisisaclose-upviewoftheTitleBar,wherefileinformationislocated.Noticethedefault
title"Presentation1."Youwillgetachancetorenameyourpresentationslidesthefirsttime you
choose to save it.

TheMenu Bar
The Menu Bar is a common sight in almost all Microsoft Windows programs. It features
text based menus, on which virtually every option available to the user in the entire
program is listed.
Each menu expands when clicked (with the left mouse button), offering many options
categorized by specific tasks.

Standard Toolbar
Toolbars provide "shortcuts" to commands also found in the Menu Bar. Toolbars are
usually located just below the Menu Bar and exist to offer another way to perform the
same task.
The most commonly used commands in MS PowerPoint are also the most accessible.Some
of these commands are:
New|Open|Save |Print|Preview| Spell-check|Copy| Paste|Undo| Insert



Formatting Toolbar
The Formatting Toolbar offers options that can change the font, size, color, alignment,
organization, and style of the text in the presentation slides. For example, (starting from
the left side of the Toolbar) the "Arial" indicates the FONT of your text; the "32" indicates
the SIZE of your text; and so on. This toolbar works the exact same way as the MS Word
FormattingToolbar.Themaindifferenceisthattheformatchangeswillonlyaffectthetext box in
which you are currently working.
All other text boxes will remain in the default setting ("Arial" font, size "32"). Design/New
Slide Icons additional shortcut icons appear on the MS PowerPoint toolbar: the Designicon
and the New Slide icon. Both commands are frequently used, and it is good to be familiar
with their location on the toolbar.

The Design icon is a shortcut to the slide design page. Here you will be
able to create and edit the appearance of your slide(s). The New Slide icon automatically
adds a new, blank slide for you to work on. You can keep track of the slides you have
already worked on in the Slide Outline box on the left-hand side of the screen. You can
access a slide at any time by clicking on it with your mouse through this screen.

SIMPLETASKSINMICROSOFTPOWERPOINT
Text Boxes:
Text Boxes are "designated" areas that allow you to type words, sentences, and bullet
points into the slide. You can adjust the size and placement of the text box within any
given slide. It is also possible to have multiple text boxes perslide.

When you first open MS PowerPoint, there will automatically be two text boxes on the
slide:

"Click to add title" and "Click to add subtitle." These text boxes already have a preset
formatappliedtothem.The"title"boxhasafontsizeof"44"whilethe"subtitle"boxhasa font size of
"32." You can change the text format of any box at anytime by adjusting the format
settings on the Formatting Toolbar. To adjust the size of the text box, first click on
thetextbox.Noticethechangeinborder.Onceyouhaveclickedonatextbox,theborder of the box
becomes thicker and little circles appear on the corners and at the midpointsof the box.
Move the mouse pointer over any one of the circles. Notice that the mouse pointer will
change to either — or ‡. Click and hold down the left mouse button. To adjust
theheight,movethemouseupordown;toadjustthewidth,movethemouseleftorright. Note that
the corner circles can adjust both height and width, while the mid-point circles can only
adjust either height or width.

To move the text box to a different location on the slide, move your mouse pointer over
anypartofthethick,grayboxoutline.Noticethechangeinyourmousepointer(itwilllook something
like a "plus" sign (+) with arrows). Click and hold down the left button on your mouse.
You can now drag the text box to any position on the slide by simply moving your mouse.
To write in a text box, simplyclick inside the box with your mouse.When a cursor is
flashing, you are ready to type.

Slide Design:

One of the more popular features of MS PowerPoint is that it gives the use a wide variety
of design choices. At some point, you may wish to change the design and color ofthe



background of your slides. To do so, simply click on the Design icon. On the right-hand
side of your screen, the "Slide Design" pane will appear. Here, you are given three design
options to apply to your slides.

Design Templates: Here is a list of over 20 templates that you can choose from to apply
to the background of your slides. For each template, you have the option of applying the
design to all slides or to only the selected slide. You can view these options by clicking on
the arrow on the right side of the template. If you are connected to the Internet, you can
also choose to view hundreds of additional templates by choosing "Design Templates on
Microsoft Office Online" on the bottom of the template screen.

Color Schemes:Thisoptiongives youavarietyofcolorschemestochoosefromtoapply to your
selected design template.

Animation Schemes:Thisoption willallowyou to select differenttypes of animationthat can
be applied to either all the slides or selected slides. The animation schemes are different
ways the slides are "introduced" to your audience, such as "faded wipe" or "pinwheel."

Designingyour ownbackground:

Sometimesyoumaywishtodesignyourownbackground.

To do this, select Format ► Background…from the Menu Bar. Select the Color Bar on the
bottom of the Background window and choose the appropriate color and or/effects that
you desire. There is no right or wrong way to design your own background, so if you
choose this option, have some patience and don't be afraid toexperiment.

Slide Layout:

The default in PowerPoint foreach newslide is to have a Title textboxand a Text box. As
discussedearlier,youdohavetheoptionofrearrangingthetextboxestofitanylayoutyou have in
mind. However, sometimes it will be easier simply to select a layout that fits your needs
rather than reformatting the default layout for each slide. To choose a slide layout, select
Format ► Slide Layout from the Menu Bar. On the right-hand side of your screen, the
"Slide Layout" pane will appear. From here, you have the option of applying a slide layout
either toa selected slide or to anewslide thathas yet to be inserted. You can view
theseoptionsbyclickingon thearrowon theright side of thetemplate.

Notethefourdifferenttypesoflayout categories.

Text Layout: These options are for choosing a layout in which you are only organizing
different text boxes. There is no room for pictures, charts, or graphs.

Content Layout: These options are for choosing a layout that will only contain pictures,
charts, or graphs. There is no room for text boxes.

Text and Content Layout: These options have room for both text boxes and pictures,
charts, or graphs.



Other Layouts: Theselayoutsaredesignedforothermediacontentsuchasvideoclipsor audio
tracks.

Inserting a Picture:

InsertingapictureintoMSPowerPointisverysimilartoinsertingapictureintoMSWord.

1. Selecttheslidethatyouwishtoaddapictureto.

2. FromtheMenuBar,selectInsert►Picture►From File(orClipArt).

3. Choosethepictureyouwishtoinsertandselect"Insert."

*Note*: The picture will be inserted in its original size, so you will probably have to re-size
it.Youcanre-sizeapicturethesamewayyoure-sizedatextbox. Clickonthepictureand note the
circles at the corners and at the midpoints of the length and width. Move your mouse
pointer over the circles, left-click the mouse and hold the button down. Move the mouse
vertically or horizontally to re-size.

Rotating a picture: It is possible to rotate pictures in MS PowerPoint. Once a picture has
beeninsertedontoaslideandyouhaveclickedonthepicturesoitis"outlined,"noticethe green
circle above the center of the picture.

Move the mouse pointer over the green circle, and left-click and hold the button down.
Now move the mouse either clockwise or counter-clockwise and the picture will rotate in
the same direction.

Inserting aGraph or Table:

TherearetwowaystoinsertagraphortableintoaPowerPointslide.

1. Thegraphortablemayalreadyexistinanotherdocumentorfile.Ifthisisthecase,then you can
simply insert the graph or table as you would a picture. Follow the instructions under

Inserting a Picture.

Or you could Cut and Paste a graph or chart from another document or file into your slide
presentation.

2. MS PowerPoint can create graphs or tables directly in the slide. From the Menu Bar,
select

Insert►Chart(orTable).

FortheChartoption,PowerPointwillpresentaverysimplebargraph.



You will need to go in and edit the information in the bar graph to conform to the
information you wish to represent in a chart. From the Datasheet, you can enter in the
appropriate values for the columns and re-name the entities.

TheTableoptionwillpresentyouwiththefollowingwindow:

Select the appropriate number of rows and columns you wish to have in your table. Click
"OK"to insert the table. Once the table has been inserted you will be able to put
information into the table cells.

Slide Management:

Once you have completed a slide, you can create a new slide by clicking on the New Slide
icon. Notice that your previous slides still appear on the left-side frame. You can still
access your previous slides by simply clicking on them from this location.

Once all your slides have been completed, you can present your slides in a "slideshow."
From the Menu Bar select Slide Show► ↑iew Show. Notice that the slide takes over our
entire screen. To navigate through the slides, use the arrow

keysonyourkeyboard(›, ‹or‡,$).↔oucanalsonavigatethroughyourslidesby clicking
on the left or right arrows in the lower left corner of your slide. To end your slide show,
click on the square box on the lower left side of your slide show (this is difficult to see at
first because it is designed to blend into you slide show so it won't be noticeable to
youraudience).SelectEnd Show fromthe pop-upwindow.

CLOSINGMICROSOFT POWERPOINT

SavingSlideShows:

Whenyoucometoastoppingpointandwanttoleavethecomputer,itisimportanttosave
yourwork(evenifyouareprintingahardcopy —savingshouldbeareflex).Tosaveyour work in MS
PowerPoint, it is essential to know WHAT you are trying to save as well as WHERE you are
trying to save it.

Click►File►Save fromtheMenu Bartogetstarted.

You can change the filename that PowerPoint has chosen just by typing a new one in the
File name box at the bottom of the window that appears.

MSPowerPointwillautomaticallysaveyourdocumentwith the suffix“.ppt” – thisissimply
atagthatletsPowerPointknowthatyourworkisspecifictothisprogram.Youdonothave to type it
– just highlight what is there (default is “Presentation1”) and write a new file name.

The My Documents folder on your computer’s hard drive is a good place to store your
documents. A blank CD (compact disc) or a USB Jump Drive are great portable storage
devices and can contain a LOT of data. It is important to note that every consequent
command of SAVE will overwrite your original file, creatingthemostup-to-date version.If



you want to save any changes to your PowerPoint slides without destroying the original
one:

In the Menu Bar,click ►File►Save Asfromthe menu barand give your documenta new
filename (unique from the original). To bring a saved document back up on the screen
from MS PowerPoint:

Click►File►OpenfromtheMenuBar.Locatewherethefileislocated(whichfolder,that is) and
click on the filename of the document you want.

Click ►Open.

PrintingSlides:

Toprint your MS PowerPointslides:

Click►File►PrintfromtheMenuBarandaPrintwindowwillpopuponthescreen. Click ►OK

for your document to start printing.

As with all commands in MS PowerPoint, you can make changes along the way. From the
Print menu, you can alter how many copies will be made, in what order the pages will be,
andmuchmore.OtherusefultoolsarethePrintPreviewfunctionfoundalongsidethePrint
command and the

PageSetupfunction.PrintPreviewwillallowyoutolookoveranexactcopyofwhatwill come out
of the printer before actuallyexecuting the print command.

Closing the Program:

Whenyouarefinished,

Click►File►Exitfromthemenubar OR

ClickontheXinthetoprightcornerofthecomputerscreen.

IntroductionToInternet:

The internet in simple terms is a network of the interlinked computer networking
worldwide, which is accessible to the general public. These interconnected
computersworkbytransmittingdatathroughaspecialtypeofpacketswitchingwhichisknownasth
e IP or the internet protocol.



Internet is such a huge network of several different interlinked networks relating to the
business, government, academic, and even smaller domestic networks, therefore internet
is known as the network of all the other networks. These networks enable the internet to
be used for various important functions which include the several means of
communications like the file transfer, the online chat and even the sharing of the
documents and web sites on the WWW, or the World WideWeb.

It is always mistaken said that the internet and the World Wide Web are both the same
terms, or are synonymous. Actually there is a very significant difference between the two
whichhastobecleartounderstandboththeterms.TheinternetandWorldWide Web are
boththenetworksyet;theinternetisthenetworkoftheseveraldifferentcomputerswhich
areconnectedthroughthelinkageof theaccessorieslikethecopper wires,thefiberoptics and
even the latest wireless connections. However, the World Wide Web consists of the
interlinkedcollectionoftheinformationanddocumentswhicharetakenastheresourceby the
general public. These are then linked by the website URLs and the hyperlinks. Therefore
World Wide Web is one of the services offered by the whole complicated and huge
network of the internet. The use of IP in the Internet is the integral part of the network,
as theyprovide the services of the internet, through different layers organization through
the IP data packets. There are other protocols that are the sub-classes of the IP itself, like
the TCP, and the HTTP.

Bytheturnofthecentury,information,includingaccesstotheInternet,willbethebasisfor personal,
economic, and political advancement. The popular name for the Internet is the
information superhighway. Whether you want to find the latest financial news, browse
through library catalogs, exchange information with colleagues, or join in a lively political
debate, the Internet is the tool that will take you beyond telephones, faxes, and isolated
computerstoaburgeoningnetworkedinformationfrontier. The Internet supplements the
traditional tools you use to gather information, Data Graphics, News and correspond with
other people. Used skillfully, the Internet shrinks the world and brings information,
expertise, and knowledge on nearly every subjectimaginable straight to your computer.

WhatistheInternet?

The Internet links are computernetworks all over the world so thatusers can share
resources and communicate with each other. Some computers have direct access to all
the facilities on the Internet such as the universities. And other computers, example
privately-owned ones, have indirect links through a commercial service provider, who
offerssomeoralloftheInternetfacilities.InordertobeconnectedtoInternet,youmust go
through service suppliers. Many options are offered with monthly rates. Depending on the

option chosen, access time may vary.
TheInternetiswhatwecallaMetanetwork,thatis,anetworkofnetworksthatspansthe globe.
It'simpossible to give an exact countof the numberof networksorusersthat comprise the
Internet, but it is easily in the thousands and millions respectively. The Internet employs
a set of standardized protocols which allow for the sharing of resources
amongdifferentkindsof computersthatcommunicatewitheachotheronthenetwork.
These standards, sometimes referred to as the Internet Protocol Suite, are the rules that
developers adhere to when creating new functions for the Internet.
TheInternetisalsowhatwecalladistributedsystem;therearenocentralarchives.



Technically, no one runs the Internet. Rather, the Internet is made up of thousands of
smaller networks. The Internet thrives and develops as its many users find new ways to
create,displayandretrievetheinformationthatconstitutestheInternet.

Who OwnstheInternet?
No one actually owns the Internet, and no single person or organization controls the
Internetinitsentirety.TheInternetismoreofaconceptthananactualtangibleentity,and it relies
on a physical infrastructure that connects networks to othernetworks.

Is WebandInternetthe Same?
The Internet is not synonymous with World WideWeb. The Internet is a massive network
of networks, a networking infrastructure. It connects millions of computers together
globally, forming a network in which any computer can communicate with any other
computer as long as they are both connected to the Internet. The World Wide Web, or
simply Web, is a way of accessing information over the medium of the Internet. It is an
information-sharingmodelthatisbuiltontopoftheInternet.

WEBBROWSER:

A web browser (commonlyreferred to as a browser) is a software application for
retrieving,presenting,andtraversinginformationresourcesontheWorldWideWeb.
Aninformationresourceisidentifiedbya UniformResourceIdentifier(URI/URL)andmay be a
web page, image, video or other piece of content. Hyperlinks present in resources enable
users easily to navigate their browsers to related resources.

AlthoughbrowsersareprimarilyintendedtousetheWorldWideWeb,theycanalsobe used to
access information provided by web servers in private networks or files in filesystems.

Usesof Internet

Internetistodayoneofthemostimportantpartofourdailylife.Therearelargenumbers
ofthingsthatcanbedoneusingtheinternetandsoitisveryimportant.Youcansaythat
withtheprogressintheinternetweareprogressingineverysphereof lifeas itnotonly makes our
tasks easier but also saves a lot of time. Today internet is used for different purposes
depending upon the requirement. Here in this very article we have mentioned then ten
best uses of the internet. Here goes the list.
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1) Email:

By using internet now we can communicate in a fraction of seconds with a person who is
sittingintheotherpartoftheworld.Todayforbettercommunication,wecanavailthe
facilitiesofEmail.Wecanchatforhourswithourlovedones.Thereareplentymessenger services
and emailservices offeringthis serviceforfree.Withhelpof such services, it has become very
easy to establish a kind of global friendship where you can share your thoughts, can
explore other cultures of different ethnicity.

2) Information:

Thebiggestadvantagethatinternetofferingisinformation.TheinternetandtheWorld WideWeb
hasmadeiteasyforanyonetoaccessinformationanditcanbeof anytype,as
theinternetisfloodedwithinformation.TheinternetandtheWorldWideWebhasmadeit easyfor
anyone to access information and itcan be of anytype. Anykind of information on any
topic is available on the Internet.

3) Business:

Worldtradehasseenabigboomwiththehelpoftheinternet,asithasbecomeeasierfor buyers and
sellers to communicate and also to advertise their sites. Now a day's most of the people
are using online classified sites to buy or sell or advertising their products or services.
Classified sites save a lot of money and time so this is chosen as medium by most of
people to advertise their products. We have many classified sites on the web like craigslist,
Adsglobe.com, Kijiji etc.

4) SocialNetworking:

Today social networking sites have become an important part of the online community.
Almostall usersare members use it for personal and businesspurposes. It's anawesome
place to networkwith manyentrepreneurswho comeheretobeginbuildingtheirown personal
and business brand.



5) Shopping:

Intoday'sbusylifemostofusareinterestedtoshoponline.Nowaday'salmostanything
canbeboughtwiththeuseoftheinternet.IncountrieslikeUSmostofconsumersprefer to shop
from home. We have many shopping sites on internet like amazon.com, Dealsglobe.com
etc. People also use the internet to auction goods. There are many auction sites online,
where anything can be sold.

6) Entertainment:

Oninternetwecanfindallformsofentertainmentfrom watchingfilmstoplayinggames online.
Almost anyone can find the right kindof entertainmentfor themselves.When
peoplesurftheWeb,therearenumerousthingsthatcanbefound.Music,hobbies,news
andmorecanbefoundandsharedontheInternet.Therearenumerousgamesthatmay be
downloaded from the Internetfor free.

7) E-Commerce:

Ecommerce is the concept used for any type of commercial maneuvering, or business
dealsthatinvolvesthetransferofinformationacrosstheglobeviainternet.Ithasbecome a
phenomenon associated with any kind of shopping, almost anything. It has got a real
amazing and range of products from household needs, technology to entertainment.

8) Services:

Many services are now provided on the internet such as online banking, job seeking,
purchasingticketsforyourfavoritemovies,andguidanceservicesonarrayoftopicsinthe every
aspect of life, and hotel reservations and bills paying. Often these services are not
available off-line and can cost you more.

9) Job Search:

Internetmakeslifeeasyforbothemployersandjobseekersasthereareplentyofjobsites which
connect employers and job seekers.

10) Dating/Personals:

Peopleareconnectingwithothersthoughinternetandfindingtheirlifepartners.Internet
notonlyhelps tofind the right person butalso to continuetherelationship.

E-mailing

Shortforelectronic mail,e-mail oremail istextmessagesthatmaycontainfiles,images, or
other attachments sent through a network to a specified individual or group of individuals.
The first e-mail was sent by Ray Tomlinson in 1971. By 1996, more electronic mail was
being sent than postal mail.



“Email,e-mailorelectronicmailisthetransmissionofmessages(emailsoremail messages)
over electronic networks like the internet.”

Email, sometimes written as e-mail, is simply the shortened form of “electronic mail,” a
system for receiving, sending, and storing electronic messages. It has gained nearly
universalpopularityaroundtheworldwiththespreadoftheInternet.Inmanycases,email has
become the preferred method for both personal and business communication.

HowItIsUsed

Messages sent by electronic mail normally reach a recipient’s account within seconds.They
frequently include more than just text; images and numerous types of formatted
documents are now easily included as attached files. Moreover, it is no longer necessaryto
be sitting in front of a PC to send or receive an email. A variety of mobile devices, such as
tablet computers and smart phones, make it possible manage correspondence on the go.

Most e-mail systems include a rudimentary text editor for composing messages, but many
allowyou to edityourmessagesusinganyeditoryou want. You then sendthemessage to the
recipient by specifying the recipient's address. You can also send the same messageto
several users at once. This is called broadcasting.

Sent messages are stored in electronic mailboxes until the recipient fetches them. To seeif
you have anymail, you mayhave to check your electronic mailboxperiodically, although
many systems alert you when mail is received. After reading your mail, you can store it in
atextfile,forwardittootherusers,ordeleteit.Copiesofmemoscanbeprintedouton aprinterif
youwanta papercopy.E-mailcanbedistributedtolistsof peopleaswellasto individuals. A shared
distribution list can be managed by using an e-mail reflector. Some
mailinglistsallowyoutosubscribebysendingarequesttothemailinglistadministrator.A mailing
list that is administered automatically is called a list server.

To get a grasp of what email is it's best — the terminology indicates it — to think in
equivalents of "traditional" postal mail.

 Theemailmessage -Insteadofusingapentowritealetteronpaper,you'reusing your
keyboard to type an email message in an email program on yourcomputer.

 Sending the email - When the email is finished and has been addressed to the
recipient'semailaddress,youdon'tputastamponitandpostitbutpressthe Send button in the
email program. This makes the email message go on itsjourney.

 Emailtransport- Like postalservicestransportlettersandparcel,emailserverstransmit
email messages from sender to recipient. Usually, emails are not delivered to the
recipient directly, though, but waiting at the "nearest" mail server to be picked up by
them.

 Fetching new mail - If you've got new mail in your mailbox, you go and fetch it.
Similarly, your email program can check for new email messages at your mail serverand
download them for you to read.
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Desktop Publishing
AdobePageMaker
PAGEMAKER:

PageMaker was one of the first desktop publishing programs, introduced in 1985 by
AldusCorporation, initially for the then-new Apple Macintosh
and in 1987
forPCsrunningWindows1.0.

PageMakerwasawardedanSPAExcellenceinSoftwareAwardforBestNewUseofa Computer in
1986.

PageMaker relies on Adobe Systems'PostScript page descriptionlanguage,andin 1994
Adobe Systems acquired Aldus and PageMaker.

As an application relying on a graphical user interface, PageMaker helped to popularize
the Macintosh platform and the Windows environment.

Adobe PageMaker is a desktop publishing software program that allows you to view
entirepagesofapublication,suchasareport,pamphletorbooklet.Therefore,it'seasy to
format a document's layout and control various design details, such as fonts and
graphics, prior to printing or distribution.

Adobe PageMaker provides graphic designers, print professionals or production artists
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withtheabilitytocreateprofessionalpagelayouts.Ifyou'repursuingsuchacareer,orif



you'reinterestedindesktoppublishingforeducationalorsmallbusinesspurposes,you may want
experience with this program.

SystemRequirements

Adobe PageMaker runs on both Windows and Macintosh computers. On Windows
machines, it'srecommended thatyour system has 48 MB ormoreof RAM, 200 MBof
available hard-disk space and a high-resolution display. If you have a Mac, 45 MB of
memory is recommended in addition to the same storage and monitor requirements.
Adobe has released updates to ensure the product continues to function with newer
computer hardware.

Toolsusedinpagemaker
ThefunctionsoftheToolboxshouldbelearnedinordertomakegooduseofthe PageMaker
program.

WhenPageMakerisflashed up, the toolboxshouldbe seen on themonitor.TheToolbar
consists of 14 separate boxes.

TextTool

Thetexttool(theletterT)islocatednexttothepointertoolatthetopoftheToolbox..If
textistobewritten,theTshouldbeclicked.Thetextboxwilllightenup.Thecursorcanbe placed
anywhere and text can be written.

The Pointer Tool
The pointer tool is the power tool. It is used for many applications such as moving
graphics, changing size of graphics, deleting graphics, altering drawing sizes and shapes
madefrom thedrawing tools intheToolboxandmovingtext to anewpage.
RotateTool

Therotationtoolisusedtorotateagraphicortext.Torotateagraphic,Clickonagraphic, Click on the
rotation tool



Rotatethegraphic

Torotate text,
Clickinthedocumentuntilthelineswiththehandlesshowup.Movethehandleoverthe
desiredtext.Gotothetoolboxandclickontherotatetool.Withamouse,movethetext how you
want it presented



CroppingTool

TheCroppingToolisusedtocutoutsomeofagraphic.
Tocrop agraphic,
Clickingonagraphicwiththepointertoolorcroppingtool.Clickthecroppingtoolto activate it.

Dragoneofthecornersorsideblackboxesuntilthesectionyouwanttocutoutgetscut out.

Thenexttwotoolsareusedtomakelines.



RectangularTools

The next two commands are the rectangle tool and the rectangle tool with an Xinsideof
therectangle.Theboxontheleftismadeforrectangles.Anylinethicknessandcolorcan be
customized. The rectangle on the right-hand side, works well for placing graphics and
aligned text inside of the rectangle or square.

Tochangethepatterninsidetherectangle,

Rightclickontherectanglewiththepolygontoolorthepointertool.Clickfillandstroke. Make
choices

Elliptical Tools

Thenexttwotools(9-10)dothesamethingastherectangulartoolswiththeonly
difference being the circular.6.11.

Theboxontheleftismadeforellipticaldesign.Anylinethicknessandcolorcanbe



customized.Theellipseontheright-handsideisusedisusedtomakeellipsesforwhich graphics
and aligned text can be inserted inside of the circle.

Tochangethepatterninsidetheellipse,Rightclickontheellipsewiththepolygontoolor the
pointer tool. Click fill and stroke. Make choices

PolygonTools

Thenexttwotoolsmakepolygonshapes.
The box on the left is made for a polygon design. Any line thickness and color can be
customized. The polygon on the right-hand side is used is used to make polygons for
whichgraphicsandalignedtextcanbeinsertedinsideofthecircle.Todrawapolygon,

 Click apolygontool
 Leftclickthemouseanddragthemouseuntilyougetthesizeanddesired shape.
 Tochangethepatterninsidethepolygon,
 Rightclickonthepolygonwiththepolygontoolorthepointertool.
 Clickfillandstroke
 Makechoices

Tomakeapolygonwithadifferentnumberofsides,Clicktherightpolygontool, Click
Polygon Settings



Putin aspecificnumber

ClickOK

To make a unique shape,

Clicktherightpolygontool

Make a single click on the page

Movethemousetoanewplace

Click the mouse



Repeatforallnewlines

HandTool

Thehandtoolisusedinlayoutmodetomovethepagestoadesiredposition.

Tomoveapage,
Leftclickthemouseonapageanddragthepageswhereyouwantthem.

Magnifyingtool

Themagnifyingglassisusedtomagnifythedocument.Tomagnifythepage,Clickthemagnifying tool.
Clickthepage.

CORELDRAW
CorelDraw(styledCorelDRAW)isavectorgraphicseditordevelopedandmarketed by Corel
Corporation of Ottawa, Canada. It is also the name of Corel's Graphics Suite, which
bundles CorelDraw with a bitmap image editor, Corel PhotoPaint, and other graphics-
related programs (see below). The latest version is designated X6 (equivalent to version
16), and was released in March 2012.
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Supportedplatforms
CorelDrawwasoriginallydevelopedforMicrosoft Windows3 andcurrentlyruns on WindowsXP,
WindowsVista,and Windows7.Thecurrentversion,X6,wasreleased on 20 March 2012.

Versions for Mac OS and Mac OS X were at one time available, but due to poor
salesthesewerediscontinued.ThelastportforLinuxwasversion9(releasedin2000,itdidnot
runnatively;instead,itusedamodifiedversionofWinetorun)andthelastversionforOS X was
version 11 (released in 2001). Also, up until version 5, CorelDraw was developedfor
Windows 3.1x, CTOS and OS/2.

Characteristicfeatures
Severalinnovationstovector-basedillustrationoriginatedwithCorelDraw:anode-edittool that
operates differently on different objects, fit text-to-path, stroke-before-fill, quick fill/stroke
color selection palettes, perspective projections, mesh fills and complex gradient fills.

CorelDrawdifferentiatesitselffromitscompetitorsinanumberofways:

Thefirstisitspositioningasagraphicssuite,ratherthanjustavectorgraphicsprogram.A full range
of editing tools allow the user to adjust contrast, color balance, change the format from
RGB to CMYK, add special effects such as vignettes and special borders to
bitmaps.BitmapscanalsobeeditedmoreextensivelyusingCorelPhotoPaint,opening
thebitmapdirectlyfromCorelDrawandreturningtotheprogramaftersaving.Italsoallows a laser
to cut out any drawings.

CorelDraw is capable of handling multiple pages along with multiple master layers.
Multipage documents are easy to create and edit and the Corel print engine allows for
booklet and other imposition so even simple printers can be used for producing finished
documents.Oneoftheusefulfeaturesforsingleand multi-pagedocumentsistheabilityto create
linked text boxes across documents that can be resized and moved while the text itself
resets and flows through the boxes. Useful for creating and editing multi-article
newsletters etc.

Smaller items, like business cards, invitations etc., can be designed to their final page size
andimposedtotheprinter'ssheetsizeforcost-effectiveprinting.Anadditionalprint-merge feature
(using a spreadsheet or text merge file) allows full personalization for many things like
numbered raffle tickets, individual invitations, membership cards and more.

CorelDraw's competitors include Adobe Illustrator and Xara Photo & Graphic Designer.
Although all of these are vector-based illustration programs, the user experience differs
greatly between them. While these programs will read their native file types and vice
versa, the translation is rarely perfect. CorelDraw can open Adobe PDF files: Adobe
PageMaker, Microsoft Publisher and Word, and other programs can print documents to
PDFusingtheAdobePDFWriterprinterdriver,whichCorelDrawcanthenopenandedit
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everyaspectoftheoriginallayoutanddesign.CorelDRAWcanalso
openPowerPointpresentationsandotherMicrosoftOfficeformatswithlittleornoproblem.

CorelDrawGraphicsSuite

Over time, additional components were developed or acquired and bundled with
CorelDraw. The list of bundled packages usually changes somewhat from one release to
the next, though there are several mainstays that have remained in the package for many
releases now, includingPowerTrace (a bitmap to vector graphic converter), Photo-Paint (a
bitmap graphic editor), and Capture (a screen capture utility).

The current version of CorelDraw Graphics Suite X6 (version 16), contains the following
packages:

 CorelDrawX6,anintuitivevector-illustrationandpage-layoutapplication
 Corel Photo-PaintX6,animage-editingapplication
 CorelPowerTraceX6,autilitytoconvertbitmapsintoeditablevectorgraphics
 CorelConnect,afull-screenbrowsertosearchthesuite’sdigitalcontent
 CorelCaptureX6,ascreencaptureutility
 CorelWebsiteCreatorX6,newwebsitecreationsoftware

CDRFileFormat
CDR file format is a proprietaryfile format developed by Corel Corporation and primarily
used for vector graphic drawings. There is no publicly available CDR file format
specification.

Other CorelDraw file formats include CorelDraw Compressed (CDX), CorelDraw
Template (CDT) and Corel Presentation Exchange (CMX).
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InDecember2006thesK1opensourceprojectteamstartedtoreverse-engineerthe CDR
format. The results and the first working snapshot of the CDR importer were
presentedattheLibreGraphicsMeeting2007conferencetakingplaceinMay2007in
Montreal (Canada). Later on the team parsed the structure of other Corel formats with
thehelpoftheopensourceCDRExplorer.Asof2008,thesK1projectclaimstohave the best
import support for CorelDraw file formats among open source software programs.
The sK1 project developed also the UniConvertor, a command line open source
tool which supports conversion from CorelDraw ver.7-X4 formats
(CDR/CDT/CCX/CDRX/CMX)tootherformats.UniConvertorisalsoused in Inkscape and
Scribusopen source projects as an external toolfor CorelDrawfiles importing.

In 2007, Microsoft blocked CDR file format in Microsoft Office 2003 with the release of
Service Pack 3 for Office 2003. Microsoft later apologized for inaccurately blaming the
CDR file format and other formats for security problems in Microsoft Office and
released some tools for solving this problem.

In 2012 the joint LibreOffice/re-lab team implemented libcdr, a library for reading CDR
files from v1 to the currently latest X6 version and CMX files. The library has extensive
support for shapes and their properties, including support for color management and
spotcolors,andhasabasicsupportfortext.Thelibraryprovidesabuilt-inconverterto SVG, and
a converter to OpenDocument is provided by writerperfect package. The libcdr library
is expected to be used in LibreOffice 3.6, and thanks to public API it can be freely used
by other applications.

CorelDrawTools:

Picktool-Select,position,ortransformobjects.

Freehand Pick tool -Selectobjectsbyusingafreehandselectionmarquee. Position
and transform objects.

Shapetool(F10)-Editacurveobjectortextcharacterbymanipulatingnodes.

Smudge Brush tool -Changetheshapeofanobjectbydraggingalongits outline.

RoughenBrushtool-Distorttheedgeofanobjectbydraggingalongitsoutline.

FreeTransformtool-Rotate,skew,mirror,andscaleobjects.

Smear tool-Changetheedgeofanobjectbydraggingalongitsoutline.

Twirltool-Addswirleffectsbydraggingalongtheoutlineofanobject.

Attracttool-Reshapeobjectsbyattractingnodestothecursor.

Repeltool-Reshapeobjectsbypushingnodesawayfromthecursor.

Smoothtool -Smoothobjectbydraggingalongitsoutline.
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Croptool-Removetheareasoutsideaselection.

Knifetool-Sliceanobjecttosplititintotwoseparateobjects.

Erasertool(X)-Removeunwantedareasinadrawing.

VirtualSegmentDeletetool-Removeoverlappingsegmentsinobjects.

Zoomtool(Z)-Changethemagnificationlevelofthedocumentwindow.

Pantool(H)-Draghiddenareasofadrawingintoviewwithoutchangingthe zoom level.

Freehandtool(F5) -Drawcurvesandstraightlinesegments.

2-PointLinetool-Drawastraightlinebydrawingfromthestartingpointtothe endpoint.

Beziertool-Drawcurvesonesegmentatatime.

Artistic Media tool (I) -Addartisticbrush,spray,andcalligraphiceffectsbyusing
freehand strokes.

Pentool-Drawcurvesinsegments,andprevieweachsegmentasyoudraw.

B-Spline tool -Drawcurvedlinesbysettingcontrolpointsthatshapethecurve without
breaking it into segments.

Polyline tool -Drawconnectedcurvesandstraightlinesinonecontinuous action.

3-PointCurvetool-Drawacurvebydraggingfromthestartingpointtothe endpoint and
then positioning the center point.

Smart Filltool -Createobjectsfromoverlappingareas,andapplyafilltothose objects.

Smart Drawing tool (Shift+S) -Convertfreehandstrokestobasicshapesor smoothed
curves.

Rectangle tool (F6) -Drawsquaresandrectanglesbydragginginthedrawing window.

3-Point Rectangletool-Drawrectanglesatanangle.

Elipsetool(F7)-Drawcirclesandelipsesbydragginginthedrawingwindow.

3-PointElipsetool-Drawselipsesatanangle.

Polygontool(Y)-Drawpolygonsbydraggiginthedrawingwindow.

Startool-Drawuniform,outlinedstars.

ComplexStartool-Drawstarsthathaveintersectingsides.



GraphPaper tool (D)-Drawagrid.

Spiraltool(A)-Drawsymmetricalandlogarithmicspirals.

BasicShapes tool-Drawtriangles,circles,cylinders,heartsandothershapes.

ArrowShapestool-Drawarrowsofvariousshapesanddirections.

FlowchartShapestool-Drawflowchartsymbols.

Banner Shapestool-Drawribbonobjectsandexplosionshapes.

CalloutShapestool-Drawlabelsandspeech bubbles.

Texttool(F8)-Addandeditparagraphandartistictext.

Tabletool-Draw,select,andedittables.

Parallel Dimension tool-Drawslanteddimensionlines.
HorizontalorVerticalDimensiontool -Drawhorizontalorverticaldimension lines.

AngularDimension tool-Drawangulardimensionlines.

Segment Dimension tool -Displaythedistancebetweenendnodesonsingleor
multiple segments.

3-PointCallouttool-Drawacalloutwithatwo-segmentleadingline.

Straight-LineConnectortool-Drawastraightlinetoconnecttwoobjects.

Right-AngleConnectortool-Drawarightangletoconnecttwoobjects.

Right-AngleRoundConnectortool-Drawarightanglewitharoundedcornerto connect
two objects.

EditAnchortool -Modifytheconnectorlineanchorpointsofobjects.
Blend tool -Blendobjectsbycreatingaprogressionofintermediateobjectsand colors.

Contour tool -Applyaseriesofconcentricshapesthatradiateintooroutofan object.

Distort tool -TransformobjetsbyapplyingPushandPull,Zipper,orTwister effects.

DropShadowtool-Applyshadowsbehindorbelowobjects
Envelope tool -Changetheshapeofanobjectbyapplyinganddraggingthe nodes of
an envelope.

Extrudetool-Apply3Defecttoobjectstocreatetheillusionofdepth.

Transparencytool-Partiallyrevealimageareasunderneaththeobject.

ColorEyedroppertool-Samplecolors,andapplythemtoobjects

OutlinePen(F12)-Setoutlinepropertiessucjaslinethickness,cornershape,



andarrowtype.

Outline Color (Shift+F12) -Choosetheoutlinecolorbyusingcolorviewersand color
palettes.

Uniform Fill (Shift+F11) -Chooseasolidfillcolorforanobjectbyusingcolor palettes,
color viewers, color harmonies, or color blends.

FountainFill(F11)-Fillanobjectwithagradientofcolorsorshades.

PatternFill-Applyapresetpatternfilltoanobjectorcreateacustompatternfill.

TextureFill-Applypresettexturefillstoobjectstocreatetheillusionofavariety of
textures, such as water, clouds and stone.

PostScriptFill-ApplyanintricatePostScripttexturefilltoanobject.

Interactive Fill tool (G) -Createafilldynamicallybyusingmarkersinthedrawing
window and property bar to change the angle, midpoint, and color.

Mesh Fill tool (M) -Fillanobjectbyblendingmultiplecolorsorshadesarranged over a
mesh grid.

AdobePhotoshop
Adobe Photoshop is a graphics editing program developed and published by
AdobeSystems.

Adobe's 2003 "Creative Suite" rebranding led to Adobe Photoshop 8's renaming to Adobe
Photoshop CS. Thus, Adobe Photoshop CS6 is the13th major release of AdobePhotoshop.
The CS rebranding also resulted in Adobe offering numerous software packages containing
multiple Adobe programs for a reduced price. Adobe Photoshop is released in two editions:
Adobe Photoshop, and Adobe Photoshop Extended, with the Extended having extra 3D
image creation, motion graphics editing, and advanced image analysis features. Adobe
Photoshop Extended is included in all of Adobe's Creative Suite offerings except Design
Standard, which includes the Adobe Photoshop edition.

AlongsidePhotoshopandPhotoshopExtended,AdobealsopublishesPhotoshopElements and
Photoshop Lightroom, collectively called "The Adobe Photoshop Family". In 2008, Adobe
released Adobe Photoshop Express, a free web-based image editing tool to edit photos
directly on blogs and social networking sites; in 2011 a version was released for the
Android operating system and the iOSoperating system.
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FileFormat
Photoshop files have default file extension as .PSD, which stands for "Photoshop
Document." A PSD file stores an image with support for most imaging options available in
Photoshop. These include layers with masks, transparency, text, alpha channels and
spotcolors, clipping paths, and duotone settings. This is in contrast to many other file
formats (e.g. .JPG or .GIF) that restrict content to provide streamlined, predictable
functionality. A PSD file has a maximum height and width of 30,000 pixels, and a length
limit of 3 Gigabytes.

Photoshop files sometimes have the file extension .PSB, which stands for "Photoshop Big"
(also known as "large document format"). A PSB file extends the PSD file format,
increasingthemaximum heightand width to300,000pixels and thelength limit toaround 4
Exabytes. The dimension limit was apparently chosen arbitrarily by Adobe, not based on
computerarithmeticconstraints(itisnotclosetoapoweroftwo,asis30,000)butforease of
software testing. PSD and PSB formats are documented.

Because of Photoshop's popularity, PSD files are widely used and supported to some
extent by most competing software. The .PSD file format can be exported to and from
Adobe's other apps like Adobe Illustrator, Adobe Premiere Pro, and After Effects, to make
professional standard DVDs and provide non-linear editing and special effects services,
such as backgrounds, textures, and so on, for television, film, and the web. Photoshop's
primary strength is as a pixel-based image editor, unlike vector-based image editors.
Photoshop also enables vector graphics editing through its Paths, Pen tools, Shape tools,
Shape Layers, Type tools, Import command, and Smart Object functions. These tools and
commands are convenient to combine pixel-based and vector-based images in one
Photoshop document,because it maynot benecessaryto use morethan one program.To
create very complex vector graphics with numerous shapes and colors, it may be easier to
use software that was created primarily for that purpose, such as Adobe
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Illustrator or CorelDRAW.Photoshop's non-destructive Smart Objects can also import
complex vector shapes.

LanguageAvailabilities
Photoshopisavailableinmorethan20languages.Thesearethefollowing:

Chinese Simplified, Chinese Traditional, Czech, Danish, Dutch, English, Finnish, French,
German,Hungarian,Italian,Japanese,Korean,Norwegian,Polish,Portuguese,
Romanian,Russian,Spanish,Swedish,TurkishandUkrainian.AlsoArabicandHebrew as of
Photoshop CS6.

Plugins
Photoshopfunctionalitycan be extended by add-on programs called Photoshop plug-in (or
plug-ins). Adobe creates some plug-in, such as Adobe Camera Raw, but third-party
companies develop most plug-in, according to Adobe's specifications. Some are free and
some are commercial software. Most plug-in work with only Photoshop or Photoshop-
compatible hosts, but a few can also be run as standalone applications.

Therearevarioustypesofplug-in,suchasfilter,export,import,selection,colorcorrection, and
automation. The most popular plug-in are the filter plug-in (also known as a 8bf plug- in),
available under the Filter menu in Photoshop. Filter plug-in can either modify the current
image or create content. Below are some popular types of plug-in, and some well- known
companies associated with them:

 Colorcorrectionplug-in
 Specialeffectsplug-in
 3Deffectsplug-in

Adobe Camera Raw (also known as ACR and Camera Raw) is a special plugin, supplied
free by Adobe, used primarily to read and process raw image files so that the resultant
images can be processed by Photoshop. It can also be used from within Adobe Bridge.

Tools
Upon loading Photoshop, a sidebar with a variety of tools with multiple image-editing
functions appears to the left of the screen. These tools typicallyfall under the categories of
drawing; painting; measuring and navigation; selection; typing; and retouching. Some
tools contain a small triangle in the bottom right of the toolbox icon. These can be
expanded to reveal similar tools. While newer versions of Photoshop are updated to
include new tools and features, several recurring tools that exist in most versions are
discussed below.

Pen Tool
Photoshop includes a fewversions of the pen tool.The pen tool creates precise paths that
can be manipulated using anchor points. The freeform pen tool allows the user to draw
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paths freehand, and with the magnetic pen tool, the drawn path attaches closely to
outlinesof objects in an image,which is usefulfor isolating them from abackground.

Measuring and navigation
The eyedropper tool selects acolorfrom an area of the image that is clicked, and samples
it for future use. The hand tool navigates an image by moving it in any direction, and the
zoom tool enlarges the part of an image that is clicked on, allowing for a closer view.

Selection
Byusingpathselectiontool,wecanselectpathnodes.

Cropping
The crop tool can be used to select a particular area of an image and discard the portions
outside of the chosen section. This tool assists in creating a focus point on an image and
excluding unnecessary or excess space. Cropping allows enhancement of a photo’s
composition while decreasing the file size. The "crop" tool is in the tools palette, which is
located on the right side of the document.

Slicing
The "slice" and slice select tools, like the crop tool, are used in isolating parts of images.
The slice tool can be used to divide an image into different sections, and these separate
parts can be used as pieces of a web page design once HTML and CSS are applied. The
slice select tool allows sliced sections of an image to be adjusted and shifted.

Moving
Onceanareaof animageishighlighted,themovetoolcanbeusedtomanuallyrelocate the
selected piece to anywhere on the canvas.

Marquee
The marquee tool can make selections thatare single row, single column, rectangular and
elliptical. An area that has been selected can be edited without affecting the rest of the
image. This tool can also cropanimage;itallowsforbettercontrol.Incontrastto the crop tool,
the "marquee" tool allows for more adjustments to the selected area before cropping. The
only marquee tool that does not allow cropping is theelliptical.

Lasso
The lasso tool is similar to the "marquee" tool, however, the user can make a custom
selection by drawing it freehand. There are three options for the "lasso" tool – regular,
polygonal, and magnetic. The regular "lasso" tool allows the user to have drawing
capabilities. Photoshop will complete the selection once the mouse button is released. The
usermayalsocompletetheselectionbyconnectingtheendpointtothestartingpoint.The
“marching ants” will indicate if a selection has been made. The "polygonal lasso" tool will
only draw straight lines, which makes it an ideal choice for images with many straight lines.
Unlike theregular "lasso" tool,the user must continually clickaround theimageto



outline the shape. To complete the selection, the user must connect the end point to the
starting point just like the regular lasso tool. "Magnetic lasso" tool is considered the smart
tool.

Quick Selection
The quick selection tool selects areas based on edges, similarlyto the magnetic lasso tool.
The difference between this tool and the lasso tool is that there is no starting and ending
point. Since there isn’t a starting and ending point, the selected area can be added on to
as much as possible without starting over.

Magic Wand
Themagicwandtool selectsareas basedonpixels.Theuseronly needstoclickonce,
andthistoolwill detect pixels thatare verysimilar toeachother. If theeye dropper tool is
selected in the options bar, then the magic wand can determine the value needed to
evaluate the pixels; this is based on the sample size setting in the eyedropper tool. When
the image requires more than a few clicks, this tool becomes a disadvantage. The user
mustdecidewhatsettingstouseorif theimageisrightforthistool.

Eraser
Theerasertooldoesexactlywhatit’scalled.Iterasesanimagebasedonthelayeritison. If
theuserisonthetextlayer,thenanytext thatthetoolisdraggedacrosswillbeerased. The erased
area will convert the pixels to transparent, unless it is the background layer. The size and
style of the eraser can be selected in the options bar. This tool is unique in
thatitcantaketheformofthepaintbrushandpenciltools.Inadditiontothestraighteraser tool,
there are two more available options – background eraser and magic eraser.

Typing
Photoshop also provides tools for adding and editing text. The type tools create an area
where text can be entered, and the type mask tools create a selection area that has the
shape of text. The type tool creates vector-based text, so symbols, letters and numbers in
various fonts and colors can be re-sized while maintaining the same quality.

Retouching
There are several tools that are used for retouching, manipulating and adjusting photos,
such as the clone stamp, eraser, burn, dodge, smudge and blur tools. The clone stamp
tool samples a selected portion of an image, and duplicates it over another area using a
brush that can be adjusted in size, flow and opacity. The smudge tool, when dragged
across part of an image, stretches and smudges pixels as if they are real paint, and the
blurtoolsoftensportionsof animagebyloweringtheamountofdetailwithintheadjusted area.

Content-aware
Content-awareness is a useful aspect of Photoshop where image editing is done
automaticallyand intelligently. It comes in two forms, content-aware scaling, and content-
awarefilling, in which elements in abackgroundautomaticallyrecompose accordingtothe
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areas a user of the program decides to fill or scale. More specifically, content-awarescaling
works by rescaling an image and causing its content to adapt to the new dimensions and
preserving important areas of it. Content-aware filling functions by matching tone, color,
and noise of an area of the image that contained an object or detail in which the user
decides to remove.

Healingtools
With improvement retouching tools like the Clone Stamp tool and Healing Brush tool,
imperfections of an image can easily be removed. These tools essentially function by
locatinga sourcepoint(ormultiple sourcepoints)that can be scaled orrotated inorderto cover
an imperfection or unwanted detail in a specific area of an image.

Puppetwrap
Similartothecontent-awaretool,thepuppetwarptoolrevealsPhotoshop’sintelligenceby
allowing a user to reposition an object in an image such as a flower or arm. This is done
byusingpointsthatoutlinethestructureofanobjectandeasilyrepositioninginthewanted
orientation.

Video Editing
In Adobe CS5 Extended edition, video editing is comprehensive and efficient with a broad
compatibility of video file formats such as MOV, AVI,MPEG-4, and FLVformats and easy
workflow.Usingsimplecombinationof keysvideolayerscaneasilybemodified,withother
features such as adding text and the creation of animations using single images.

3D

With the Extended version of Photoshop CS5, 2D elements of an artwork can easily
become three-dimensional with the click of a button. Extrusions of texts, an available
library of materials for three-dimensional, and even wrapping two-dimensional images
around 3D geometry are all possible with this version of Photoshop. Realism can also be
added to an image using the 3D features of Photoshop such as animating image-based
lights and depth of field.

Mobile integration
Third-party plug-in have also been added to the most recent version of Photoshop where
technologies such as the iPad have integrated the software with different types of
applications. Applications like theAdobe Easel painting app allows the user to easilycreate
paintings with their fingertips and use an array of different paint from dry to wet in order
to create rich color blending.
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HTML/DHTML,CSS&Div
HTML

Hyper Text Markup Language (HTML) is the main markup language for creating webpages
and other information that can be displayed in a web browser.

HTML is written in the form of HTML elements consisting of tags enclosed in anglebrackets
(like <html>), within the web page content. HTML tags most commonly come in
pairslike<h1>and</h1>,althoughsometags,knownasemptyelements,areunpaired,for
example<img>.Thefirsttaginapairisthestarttag,andthesecondtagistheend tag (they are also
called opening tags and closing tags). In between these tags web designers can add text,
tags, comments and other types of text-basedcontent.

The purpose of a web browser is to read HTML documents and compose them into visible
or audible web pages. The browser does not display the HTML tags, but uses the tags to
interpret the content of the page.

HTMLelementsformthebuildingblocksofallwebsites.HTMLallowsimagesandobjects to be
embedded and can be used to create interactive forms. It provides a means
tocreatestructureddocumentsbydenotingstructuralsemanticsfortextsuchasheadings,
paragraphs, lists, links, quotes and other items. It can embed scripts written in languages
such as JavaScript which affect the behavior of HTML web pages.

Web browsers can also refer to Cascading Style Sheets (CSS) to define the appearance
and layout of text andothermaterial. The W3C, maintainerof both the HTMLand the CSS
standards, encourages the use of CSS over explicit presentational HTML markup.

Markup

HTMLmarkupconsistsofseveralkeycomponents,including elements (and their attributes),
character-based data types, character references and entity references. Another important
component is the document type declaration, which triggers standardsmode rendering.

The following is an example of the classic Hello world program, a common test employed
for comparing programming languages, scripting languages and markup languages. This
example is made using 9 lines of code:

<!DOCTYPEhtml>
<html>
<head>
<title>HTML</title>
</head>
<body>
<p>Helloworld!</p>
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</body>
</html>
(Thetextbetween<html>and</html>describesthewebpage,andthetextbetween
<body>and</body>isthevisiblepagecontent.Themarkuptext'<title>Hello
HTML</title>' defines the browser page title.)

ThisDocumentTypeDeclarationisforHTML5.Ifthe<!DOCTYPE html>declarationisnot included,
various browsers will revert to "quirks mode" for rendering.

Elements
HTML documents are composed entirely of HTML elements that, in their most
generalformhavethreecomponents:apairof tags,a"starttag"and"endtag";
someattributeswithinthestarttag;andfinally,anytextualandgraphicalcontentbetween the
start and end tags, perhaps including other nested elements. The HTML element is
everything between and including the start and end tags. Each tag is enclosed in angle
brackets.

The general form of an HTML element is therefore: <tag

attribute1="value1"attribute2="value2">content</tag>. Some HTML elements are defined as
empty elements and take the form <tag attribute1="value1" attribute2="value2">. Empty
elements may enclose no content, for instance, the BR tag or the inline IMG tag. The
name of an HTML element is thenameused in thetags. Notethatthe endtag's name
ispreceded bya slash character,
"/",andthatinemptyelementstheendtagisneitherrequirednorallowed.Ifattributesare not
mentioned, default values are used in each case.

Element examples
Header of the HTML document:<head>...</head>. Usually the title should be included in
the head, for example:

<head>
<title>The Title</title>
</head>

Headings:HTMLheadingsaredefinedwiththe<h1>to<h6>tags:

<h1>Heading1</h1>
<h2>Heading2</h2>
<h3>Heading3</h3>
<h4>Heading4</h4>
<h5>Heading5</h5>
<h6>Heading6</h6>Paragr
aphs:

<p>Paragraph1</p><p>Paragraph2</p>

Linebreaks:<br/>.Thedifferencebetween<br/>and<p>isthat'br'breaksalinewithout
alteringthesemanticstructureofthepage,whereas'p'sectionsthepageintoparagraphs.
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Notealsothat'br'isanemptyelementinthat,whileitmayhaveattributes,itcantakeno content
and it may not have an end tag.

<p>This<br/>isaparagraph<br/>with<br/>linebreaks</p>Comments:

<!--Thisisacomment-->

Commentscanhelpintheunderstandingofthemarkupanddonotdisplayinthe webpage.

ThereareseveraltypesofmarkupelementsusedinHTML:

Structuralmarkupdescribesthepurposeoftext
For example, <h2>Golf</h2> establishes "Golf" as a second-level heading. Structural
markup does not denote any specific rendering, but most web browsers have defaultstyles
for element formatting. Content may be further styled using CascadingStyleSheets (CSS).
Presentationalmarkupdescribestheappearanceofthetext,regardlessofits purpose
For example <b>boldface</b> indicates that visual output devices should render
"boldface" in bold text, but gives little indication what devices that are unable to do this
(suchasauraldevicesthatreadthetextaloud)shoulddo.Inthecaseof both <b>bold</b> and
<i>italic</i>, there are other elements that may have equivalent visual renderings but
which are more semantic in nature, such as <strong>strongtext</strong> and
<em>emphasised text</em> respectively. It is easier to see how an
auraluseragentshouldinterpretthelattertwoelements.However,theyarenotequivalent to their
presentational counterparts: it would be undesirable for a screen-reader to emphasize the
name of a book, for instance, but on a screen such a name would be
italicized.Mostpresentationalmarkupelementshavebecomedeprecatedunderthe HTML 4.0
specification in favor of using CSS for styling.

Hypertextmarkupmakespartsofadocumentintolinkstootherdocuments
Ananchorelementcreatesahyperlinkinthedocumentandits hrefattributesetsthelink's target
URL. For example the HTML
markup,<ahref="http://www.google.com/">Wikipedia</a>,willrendertheword"Wikipedia"as a
hyperlink. To render an image as a hyperlink, an 'img' element is inserted as content into
the 'a' element. Like 'br', 'img' is an empty element with attributes but no content or
closing tag. <a href="http://example.org"><img src="image.gif" alt="descriptive
text"width="50"height="50"border="0"></a>.

Characterand entityreferences[edit]
As of version 4.0, HTML defines a set of 252 character entity references and a set of
1,114,050 numeric character references, both of which allow individual characters to be
written via simple markup, rather than literally. A literal character and its markup
counterpart are considered equivalent and are rendered identically.

The ability to "escape" characters in this way allows for the characters <and &(when
writtenas&lt;and&amp;,respectively)tobeinterpretedascharacterdata,ratherthan
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markup. For example, a literal <normally indicates the start of a tag, and &normally
indicatesthestartof acharacterentityreferenceornumericcharacterreference;writingit as
&amp;or &#x26;or &#38;allows &to be included in the content of an element or in the value
of an attribute.The double-quote character ("), when not used to quote an attribute
value,mustalsobeescapedas&quot;or&#x22;or&#34;whenitappearswithintheattribute value
itself. Equivalently, the single-quote character ('), when not used to quote an attribute
value, must also be escaped as &#x27;or &#39;(not as &apos;except in XHTML
documents)whenitappearswithintheattributevalueitself.Ifdocumentauthorsoverlook the
need to escape such characters, some browsers can be very forgiving and try to use
context to guess their intent. The result is still invalid markup, which makes the document
less accessible to other browsers and to other user agents that may try to parse the
document for search and indexing purposes for example.

Data types
HTML defines several data types for element content, such as script data and stylesheet
data, and a plethora of types for attribute values, including IDs, names, URIs, numbers,
units of length, languages, media descriptors, colors, character encodings, dates and
times, and so on. All of these data types are specializations of character data.

DHTML
Dynamic HTML, or DHTML, is an umbrella term for a collection of technologies used
together to create interactive and animated web sites byusingacombinationofa
staticmarkuplanguage(suchasHTML),aclient-sidescriptinglanguage(such as JavaScript), a
presentation definition language (such as CSS), and the DocumentObject Model.

DHTML allows scripting languages to change variables in a web page's definitionlanguage,
which in turn affects the look and function of otherwise "static" HTML page content, after
the page has been fully loaded and during the viewing process. Thus the dynamic
characteristic of DHTML is the way it functions while a page is viewed, not in its ability to
generate a unique page with each page load.

By contrast, a dynamic web page is a broader concept, covering any web page generated
differently for each user, load occurrence, or specific variable values. This includes pages
createdbyclient-sidescripting,andonescreatedbyserver-sidescripting (suchas PHP, Perl, JSP
or ASP.NET) where the web server generates content before sending it to the client.

DHTML is differentiated from AJAX by the fact that a DHTML page is still request/ reload-
based. With DHTML, there may not be any interaction between the client and server after
the page is loaded; all processing happens in Javascript on the client side. By contrast, an
AJAX page uses features of DHTML to initiate a request (or 'subrequest') to the server to
perform actions such as loading more content.

USES
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DHTML allows authors to add effects to their pages that are otherwise difficult to achieve.
In short words: scripting language is changing the DOM and style. For example, DHTML
allows the page author to:

 Animate text and images in their document, independently moving each element
from any starting point to any ending point, following a predetermined path or one
chosen by the user.

 Embed a ticker that automatically refreshes its content with the latest news, stock
quotes, or other data.

 Useaform to captureuserinput,andthenprocess,verifyandrespondto thatdata without
having to send data back to theserver.

 Includerolloverbuttonsordrop-downmenus.

A less common use is to create browser-based action games. Although a number ofgames
were created using DHTML during the late 1990s and early 2000s, differences between
browsers made this difficult: many techniques had to be implemented in code to enable
the games to work on multiple platforms. Recentlybrowsers have been converging
towards the web standards, which has made the design of DHTML games more viable.
Thosegamescanbeplayedonallmajorbrowsersandtheycanalsobeported to Plasma for KDE,
Widgets for Mac OS X and Gadgets for Windows Vista, which arebased on DHTML code.

The term "DHTML"hasfallen out of use in recent yearsasit wasassociated with practices
and conventionsthat tended tonotworkwell betweenvariousweb browsers.DHTML may now
be referred to as unobtrusive JavaScript coding (DOM Scripting), in an effort to place an
emphasis on agreed-upon best practices while allowing similar effects in an
accessible,standards-compliant way.

DHTML support with extensive DOM access was introduced with Internet Explorer 4.0.
although there was a basic dynamic system with Netscape Navigator 4.0, not all HTML
elements were represented in the DOM. When DHTML-style techniques became
widespread, varying degrees of support among web browsers for the technologiesinvolved
made themdifficulttodevelopand debug.Developmentbecameeasier when
InternetExplorer5.0+, MozillaFirefox 2.0+,and Opera7.0+adopteda shared DOM inherited
from ECMAscript.

More recently, JavaScript libraries such as jQuery have abstracted away much of the day-
to-day difficulties in cross-browser DOM manipulation.

Structureof aWeb Page

TypicallyawebpageusingDHTMLissetupinthefollowingway:

<!doctypehtml>
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<htmllang="en">
<head>
<metacharset="utf-8">
<title>DHTMLexample</title>

</head>
<body>
<divid="navigation"></div>

<script>
varinit=function(){
myObj=document.getElementById("navigation");
//...manipulatemyObj

};
window.onload=init;

</script>

<!--
Oftenthecodeisstoredinanexternalfile;thisisdone by
linking the file that contains the JavaScript.
Thisis helpful when several pages usethe same script:
-->
<scriptsrc="myjavascript.js"></script>

</body>
</html>

DocumentObject Model
DHTML is not a technology in and of itself; rather, it is the product of three related and
complementary technologies: HTML, Cascading Style Sheets (CSS), and JavaScript. To
allow scripts and components to access features of HTML and CSS, the contents of the
document are represented as objects in a programming model known as the Document
Object Model (DOM).

The DOM API is the foundation of DHTML, providing a structured interface that allows
access and manipulation of virtually anything in the document. The HTML elements in the
document are available as a hierarchical tree of individual objects, meaning you can
examineandmodifyanelementanditsattributesbyreadingandsetting propertiesandby calling
methods. The text between elements is also available through DOM properties and
methods.

The DOM also provides access to user actions such as pressing a key and clicking the
mouse. You can intercept and process these and other events by creating event handler
functions and routines. The event handler receives control each time a given event occurs
and can carry out any appropriate action, including using the DOM to change the
document.

Data Binding
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Data binding is a DHTML feature that lets you easily bind individual elements in your
document to data from another source, such as a database or comma-delimited text file.
When the document is loaded, the data is automatically retrieved from the source and
formatted and displayed within the element.

One practical way to use data binding is to automatically and dynamically generate tables
in your document. You can do this by binding a table element to a data source. When the
document is viewed, a new row is created in the table for each record retrieved from the
source,andthecellsofeachrowarefilledwithtextanddatafromthefieldsoftherecord. Because
this generation is dynamic, the user can view the page while new rows are created in the
table. Additionally, once all the table data is present, you can manipulate (sort or filter)
the data without requiring the server to send additional data. The table is regenerated,
usingthepreviouslyretrieved data tofillthe newrows and cellsof thetable.

Another practical use of data binding is to bind one or more elements in the document to
specificfields of agiven record.Whenthepage isviewed, theelementsarefilled with text
anddatafrom thefieldsin that record, sometimescalled the"current" record.An example
isaformletterinwhichthename,e-mailaddress,andotherdetailsaboutanindividualare filled
from a database. To adapt the letter for a given individual, you specify which record
should be the current record. No other changes to the letter are needed.

CSS
CascadingStyleSheets (CSS)isastylesheetlanguage usedfordescribing the presentation
semantics (the look and formatting) of a document written in a
markuplanguage.Itsmostcommonapplicationisto style webpages writtenin HTML and
XHTML, but thelanguagecanalso beappliedtoanykindofXMLdocument,includingplainXML,
SVG and XUL.

CSS is designed primarily to enable the separation of document content (written in HTML
or a similar markup language) from document presentation, including elements such asthe
layout, colors, and fonts. This separation can improve content accessibility, provide more
flexibility and control in the specification of presentation characteristics, enable multiple
pages to share formatting, and reduce complexity and repetition in the structural content
(such as by allowing for tableless web design). CSS can also allow the same markup page
to be presented in different styles for different rendering methods, such as on-screen, in
print, by voice (when read out by a speech-based browser or screen reader) and on
Braille-based, tactile devices. It can also be used to allow the web page to display
differently depending on the screen size or device on which it is being viewed. While the
author of a document typically links that document to a CSS file, readers can use a
different style sheet, perhaps one on their own computer, to override the one the author
has specified.

CSS specifies a priority scheme to determine which style rules apply if more than one rule
matches against a particular element. In this so-called cascade, priorities or weights are
calculated and assigned to rules, so that the results are predictable.
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The CSS specifications are maintained by the World Wide Web Consortium (W3C).Internet
media type (MIME type)text/cssisregisteredforuse with CSS by RFC2318 (March 1998), and
they also operate a free CSS validation service.

Syntax
CSS has a simple syntax and uses a number of English keywords to specify the names of
various style properties.

Astylesheetconsistsofalistofrules.Eachruleorrule-setconsistsofoneor more selectors,
and a declaration block.

Selector
InCSS,selectorsareusedtodeclarewhichpartofthemarkupastyleappliesto,akindof match
expression. Selectors may apply to:

 allelementsofaspecifictype,e.g.thesecondlevelheadersh2
 toelementsspecifiedbyattribute,inparticular:
 id:anidentifieruniquetothedocument
 class
 toelementsdependingonhowtheyareplacedrelativeto,ornestedwithin,others in the

document tree.

Pseudo-classes are usedin CSSselectors topermit formatting basedoninformationthat is
outside the document tree. An often-used example of a pseudo-class is :hover, which
identifies content only when the user 'points to' the visible element,usually by holding the
mousecursoroverit.Itisappendedtoaselectorasina:hoveror#elementid:hover.Apseudo-
classclassifiesdocumentelements,suchas:linkor:visited,whereasapseudo- element makes a
selection that may consist of partial elements, such as :first-lineor :first-letter.

Selectors may be combined in many ways, especially in CSS 2.1, to achieve great
specificity and flexibility.

Declarationblock
A declaration-block consists of a list of declarations in braces. Each declaration itself
consistsofaproperty,acolon(:),andavalue.Iftherearemultipledeclarationsinablock, a semi-
colon (;) must be inserted to separate each declaration.

DIV
In HTML, the span and div elements are used for generic organizational or stylistic
applications, typically when extant meaningful elements have exhausted their purpose.
Most HTML elements signify the specific meaning of their content – i.e. the element
describes, and can be made to function according to, the type of data contained within.
For example, a p element should contain a paragraph of text, while an h1 element should
contain the highest-level heading of the page; user agents shoulddistinguish them
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accordingly. span and div signify no specific meaning besides the generic grouping of
content, and are therefore more appropriate for creating organization or stylistic additions
without signifying superfluous meaning.
Default Behaviour
There is one difference between div and span. In standard HTML, a div is a block-
levelelement whereas a span is an inline element. The div block visually isolates a section
of a document on the page, in the same way as a paragraph. The span element contains a
piece of information inline with the surrounding text. In practice, even this feature can be
changed by the use of Cascading Style Sheets (CSS).
Practical Usage
spananddivelementsareusedpurelytoimplyalogicalgroupingofenclosedelements. There are
three main reasons to use span and div tags with class or id attributes: Styling with
CSS
Perhapsthemostcommonuseof spananddivelementsistocarryclassoridattributesin
conjunction with CSS to apply layout, typographic, color, and other presentation attributes
to partsof the content.CSS does not just applyto visualstyling: when spokenout loud by a
voice browser, CSS styling can affect speech-rate, stress, richness and even position
within a stereophonic image.
For these reasons, and for compatibility with the concepts of the semantic web, discussed
below, attributes attached to elements within any HTML should describe their semantic
purpose,ratherthanmerelytheirintendeddisplaypropertiesinoneparticularmedium.For
example,theHTMLin<spanclass="redbold">passwordtooshort</span>issemantically weak,
whereas <em class="warning">password too short</em> uses an em element to signify
emphasis, and uses a more appropriate class name. By the correct use of CSS,
'warnings'mayberenderedinared,boldfontonascreen,butwhenprintedouttheymay
beomitted,asbythenitistoolatetodoanythingaboutthem.Perhapswhenspokenthey should be
given extra stress, and a small reduction in speech-rate. The second example is
semantically correct markup, rather than merely presentational.
Semantic clarity
Thiskind of groupingand labelingof partsof the page content might be introduced purely to
make the page more semantically meaningful in general terms. It is impossible to say how
and in what ways the World Wide Webwill developinyearsanddecadesto come. Web pages
designed today may still be in use when information systems that we cannot yet imagine
are trawling, processing, and classifying the web. Even today's search engines such as
Google and others use proprietary information processing algorithms of considerable
complexity.
Forsomeyears,the WorldWideWebConsortium(W3C)hasbeenrunninga major Semantic Web
project designed to make the whole web increasingly useful and meaningful to today's and
the future's information systems.
The micro formats movement is an attempt to build an idea of semantic classes. For
example, micro formats-aware software might automatically find an element like <span
class="tel">123-456-7890</span> and allow for automatic dialing of the telephone
number.
Accessfromcode
Once the HTML or XHTML markup is delivered to a page-visitor's client browser, there is a
chance that client-side code will need to navigate the internal structure (or
DocumentObject Model) of the web page. The most common reason for this is that the
page is delivered with client-side JavaScript that will produce on-going dynamic behavior
after the pageisrendered.Forexample,ifrollingthemouseovera'Buynow'linkismeanttomake
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the price, elsewhere on the page, become emphasized, JavaScript code can do this, but
JavaScript needs to identify the price element, wherever it is in the markup, in order to
affect it. The following markup would suffice: <div id="price">$45.99</div>. Another
example is the Ajax programming technique, where, for example, clicking a hypertext link
maycauseJavaScriptcodetoretrievethetextforanewpricequotationtodisplayinplace of the
currentone within the page, without re-loadingthe whole page.When the newtext arrives
back from the server, the JavaScript must identify the exact region on the page to replace
with the new information.
Less common, but just as important examples of code gaining access to final web pages,
andhaving tousespan anddivelements'class or id attributes tonavigate within thepage
include the use of automatic testing tools. On dynamically generated HTML, this may
includetheuseofautomaticpagetestingtoolssuchasHttpUnit,amemberof
thexUnitfamily,andloadorstresstesting toolssuchasApache JMeterwhenapplied to form-
driven web sites.

Dreamweaver,
InDesign,Illustrator

AdobeDreamweaver
Adobe Dreamweaver is a proprietaryweb developmentapplication developed by
AdobeSystems. Dreamweaver was originally developed by Macromedia in 1997, and was
maintained by them until Macromedia was acquired by Adobe Systems in 2005. Adobe
Dreamweaver is available for both Mac and Windowsoperating systems.
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Following Adobe's acquisition of the Macromedia product suite, releases of Dreamweaver
subsequent to version 8.0 have been more compliant with W3C standards.
RecentversionshaveimprovedsupportforWebtechnologiessuchasCSS,JavaScript,and various
server-side scriptinglanguages and frameworks including ASP (ASP
JavaScript,ASPVBScript,ASP.NETC#,ASP.NETVB),ColdFusion,Scriptlet,andPHP.
Features
AdobeDreamweaver is awebdesignand development applicationthatprovidesa
visualWYSIWYGeditor (colloquiallyreferredto asthe Design view) anda codeeditor with
standard features such as syntax highlighting, code completion, and code collapsing as
well as more sophisticated features such as real-time syntax checking and code
introspection for generating code hints to assist the user in writing code.[4]The Design
viewfacilitates rapid layout design and code generation asitallows usersto quicklycreate
and manipulate the layout of HTML elements. Dreamweaver features an integrated
browser for previewing developed webpages in the program's own preview pane in
addition to allowing content to be open in locally installed web browsers. It provides
transferandsynchronizationfeatures,theabilitytofindandreplacelinesoftextorcodeby search
terms or regular expressions across the entire site, and a templating feature that allows
single-source update of shared code and layout across entire sites without server- side
includes or scripting. The behaviors panel also enables use of basic JavaScriptwithout any
coding knowledge, and integration with Adobe's Spry Ajax framework offers easy access
to dynamically-generated content and interfaces.

Dreamweaver can use third-party "Extensions" to extend core functionality of the
application, which any web developer can write (largely in HTML and JavaScript).
Dreamweaver is supported by a large community of extension developers who make
extensions available (both commercial and free) for most web development tasks from
simple rollover effects to full-featured shopping carts.

Dreamweaver, like other HTML editors, edits files locally then uploads them to the remote
webserverusingFTP,SFTP,or WebDAV.DreamweaverCS4nowsupports the Subversion (SVN)
version control system.

Syntaxhighlighting
Asof version5,Dreamweaversupports syntaxhighlightingforthefollowinglanguagesout of the
box:

 ActionScript
 ExtensibleMarkupLanguage(XML)
 ExtensibleStylesheetLanguageTransformations(XSLT)
 HyperTextMarkupLanguage(HTML)
 Java
 JavaScript
 PHP:HypertextPreprocessor(PHP)
 VisualBasic (VB)
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 VisualBasicScriptEdition(VBScript)
 WirelessMarkupLanguage(WML)

SupportforASP.NETandJavaServerPageswasdroppedasofversionCS4.

Itisalsopossibleforuserstoaddtheirownlanguagesyntaxhighlighting.Inaddition, codecompletion is
available for many of these languages.

Localization
Languageavailability
Adobe Dreamweaver CS6 is available in the following languages: Brazilian Portuguese,
Chinese Simplified, Chinese Traditional, Czech, Dutch, English, French, German, Italian,
Japanese, Korean (Windows only), Polish, Russian, Spanish, Swedish, and Turkish.

SpecificfeaturesforArabic andHebrewlanguages
The older Adobe Dreamweaver CS3 also features a Middle Eastern version that allows
typing Arabic, Persian or Hebrew text (written from right to left) within the code view.
WhetherthetextisfullyMiddleEastern(writtenfrom rightto left)orincludesbothEnglish
andMiddleEasterntext(writtenlefttorightandrighttoleft),itwillbedisplayedproperly.

AdobeInDesign
Adobe InDesign is a desktop publishing software application produced by Adobe Systems.
It can be used to create works such as posters, flyers, brochures, magazines, newspapers
and books. InDesign can also publish content suitable for tablet devices in conjunctionwith
Adobe Digital Publishing Suite. Graphic designers and production artists are the principal
users, creating and laying out periodical publications, posters, and print media. It also
supports export to EPUB and SWF formats to create digital publications, and content
suitableforconsumption on tablet computers. The Adobe InCopy word processoruses the
same formatting engine as InDesign.

Localization
Languageavailability
Adobe InDesign CS5 is available in the following languages: Arabic (Middle Eastern
version), Brazilian Portuguese, Chinese Simplified, Chinese Traditional, Czech, Danish,
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Dutch, English (International & United States), Finnish, French, German, Greek, Hebrew
(Middle Eastern version), Hungarian, Italian, Japanese, Korean, Norwegian, Polish,
Russian, Spanish, Swedish, Turkish, Ukrainian.

Historicallanguageavailability
Adobe InDesign CS4 offered a Romanian version, though this is no longer available for
CS5. French (Canadian) and Spanish (Latin American) versions use the same files as are
used in French and Spanish versions, respectively.

Text settings
InDesign Middle Eastern versions come with special settings for laying out Arabic or
Hebrew text, such as:

 Abilitytouse Arabic,Persian orHindidigits
 Usekashidasforletterspacingandfulljustification
 Ligatureoption
 Setvowels/diacriticspositioning
 Justify text in three possible ways to get the desired results (Standard,

Arabic, Naskh)
 Option to "Insert Special Character": three Hebrew characters

(Geresh, Gershayim, Maqaf) and an Arabic one (Kashida)
 Applystandard,ArabicorHebrewstylesforpage,paragraphandfootnote

numbering

Bi-directionaltextflow
InInDesignMiddleEasternversions,thenotion ofright-to-leftbehaviourappliestoseveral
objects:Story,Paragraph,CharacterandTable.ItallowsformixingRight-to-LeftandLeft- to-Right
Words, Paragraphs and Stories in a document.

 InDesign CS4 Middle Eastern versions make it possible to change the direction of
neutral characters (forex.:,/?, etc.) according to the user's keyboard language with
a single click.

 InDesign CS6 Middle Eastern Editions provide additional support for right-to-left
languages.

Tableof contents
InDesign Middle Eastern versions come with a set of Table of contents titles, one for each
supported language. The TOC is also sorted according to the chosen language. InDesign
CS4 Middle Eastern versions allow to choose the language of the index title and cross-
referencesbyright clickingin thetitlefieldin the Generate Indexwindow.
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Indices
InDesign allows for the creation of a simple keyword index or a somewhat more detailed
indexof the information in the text usingembedded indexingcodes which are instantiated
as an index using a command in the Indexing palette. Unlike more
sophisticatedprograms,InDesignisincapableofinsertingcharacterstyleinformationaspartofani
ndex entry (e.g., when indexing book, journal or movie titles). Indices are limited to four
levels (top level and three sub-levels). InDesign Middle Eastern versions allow the user to
set various Sort Options for the indices according to the language dealtwith.

TherearenoprovisionsforimportingindexentriesaspartofanXMLfile.

Importing and exporting
InDesign Middle Eastern versions bring thecapabilityofopeningdirectlyand
convertingQuarkXPressfiles,evenusingArabicXT,ArabicPhonyxorHebrew XPressWay fonts,
retaining the layout and content. InDesign Middle Eastern versionscome with more than
50 import/export filters enabling to place many kinds of images and Roman texts:
MicrosoftWord 97-98-2000 Import filter and Text Import filter. QuarkXPress data can be
converted to InDesign with Markzware'sQ2ID. InDesign can also be used asa front end on
top of database applications, such as CCI Europe's NewsGate software.

Reverselayout
InDesign Middle Eastern versions include a reverse layout feature to reverse the layout of
a document, when converting a Left to Right document (Roman) to a Right to Left one
(Arabic or Hebrew) or vice versa. It is alsohelpful when creating a multilingual document.

ComplexScriptrendering

InDesign supports Unicode character encoding and there is a special Middle East version
supporting complex text layout for Arabic and Hebrew types of complex script. The
underlying Arabic and Hebrew support is present in the Western-language editions of
InDesign CS4, CS5, CS5.5 and CS6, but the user interface is not exposed, so it is difficult
to access.

Illustrator

AdobeIllustratorisa vectorgraphicseditordevelopedandmarketedby AdobeSystems. The
latest version, Illustrator CS6, is the sixteenth generation in theproduct line.
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Compatibility
CompatibilitywithInkscape:Inkscape'snativeformatisSVG,whichissupportedbyAI,but the two
implementations are not 100% compatible. Inkscape also exports to PS, EPS and PDF,
formats which Illustrator can recognize.
Branding
Startingwith version 1.0,Adobe chose to license an image of Sandro Botticelli's"The Birthof
Venus" from the Bettmann Archive and use the portion containing Venus' face as
Illustrator's branding image. Warnock desired a Renaissance image to evoke his vision of
Postscript as a new Renaissance in publishing, and Adobe employee Luanne Seymour
Cohen,who wasresponsiblefortheearlymarketingmaterial,foundVenus'flowingtresses a
perfect vehicle for demonstrating Illustrator's strength in tracing smooth curves over
bitmap source images. Over the years the rendition of this image on Illustrator's splash
screen and packaging became more stylized to reflect features added in each version.

The image of Venus was replaced (albeit still accessible via easter egg) in Illustrator CS
(11.0) and CS2 (12.0) by a stylized flower to conform to the Creative Suite's nature
imagery. In CS3, Adobe changed the suite branding once again, to simple colored blocks
with two-letter abbreviations, resembling a periodic table of elements. Illustrator was
represented by the letters Ai in white against an orange background (oranges and yellows
were prominent color schemes in Illustrator branding going back as far as version 4.0).
The CS4 icon is almost identical, except for a slight alteration to the font and the color
whichisdarkgray.TheCS5iconisalsovirtuallythesame,exceptthatthistimethelogois like a box,
along with all the other CS5 product logos, with the "Ai" bright yellow. CS6 changed itabit
toabrown square with a yellowborder and yellowlettering.

Toolbox
Selectiontool
Themostcommonlyusedtool,whichselectstextandgraphicframesandallowsyouto workwith
an object using its bounding box.
DirectSelection tool
Selects the contents of a frame, such as a placed graphic; allows you to work directly
witheditableobjects,suchaspaths,rectangles,ortypethathasbeenconvertedtoatext
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outline.Group Selection tool Selects a group of points all at once, such as the four pointsof
rectangle.

Magic Wand tool
Selects all objects in a document with the same or similar fill color, stroke weight, stroke
color,opacity, or blending mode. By specifying the Color Range, or Tolerance, you can
control whatthe Magic Wand tool selects.
Lassotool
Selects objects, anchor points, or path segments by being dragged around all or part of
the object.
Pentool
Createsalinebetweentwoanchorpointsyoumake.Createsstraightlinesif yousimply click and
release to make anchor points.
Add AnchorPointtool
Addsapointtoapath,whichisasimplewaytochangeanypath.Thishelpstoturnone shape into
another
DeleteAnchorPointtool
Deletespointsfromapathwithoutcausingabreakinthepath.
ConvertDirectionPointtool
Changes the controlhandlesaroundananchor pointreshapingthesegmentscontrolled by
thatanchor point.
Typetool
Createsresizableandmoveabletextframesinwhichyoucantype text.
Typeona Pathtool
←sedtotypeonanobject’spath.
Line tool
Createsstraightlines.
Ellipsetool
Createsellipseshapes that hold text.
Rectangle tool
Createsrectangleshapesthatholdcolorortext.
Polygontool
Createspolygonshapesthatholdcolorortext.
Paintbrushtool
Drawsapathandappliesabrushstrokesimultaneously.
Penciltool
Drawsopenandclosedpathsasifyouweredrawingwithapencilonpaper.Itismost useful forfast
sketching or creating a hand-drawn look.
Smoothtool
Removesexcessanglesfromanexistingpathora sectionof apath.
Layers let you organize your work into distinct levels that can be edited and viewed as
individual units. Every Illustrator CS6 document contains at least one layer. Creating
multiple layers lets you easily control how your artwork is printed, displayed, and edited.
You will use the Layers palette often while creating a document, so it is crucial to
understand what it does and how to use it.



Flash Animation
A Flash animation or Flash cartoon is an animatedfilm which is created by Adobe Flash or
similar animation software and often distributed in the .swf file format. The term Flash
animation not only refers to the file format but to a certain kind of movement and visual
style. With dozens of Flash animated television series, countless more Flash animated
television commercials, and award-winning online shorts in circulation, Flash animation is
enjoying a renaissance.

In the late 1990s, when for most Internet users, bandwidth was still at 56 kbit/s, many
Flash animation artists employed limited animation or cutout animation when creating
projectsintendedforwebdistribution.Thisallowedartiststoreleaseshortsand interactive
experiences well under 1 MB, which could stream both audio and high-endanimation.

Flash is able to integrate bitmaps and other raster-based art, as well as video, though
most Flash films are created using only vector-based drawings which often result in a
somewhat clean graphic appearance. Some hallmarks of poorly produced Flash animation
are jerky natural movements (seen in walk-cycles and gestures), auto-tweened character
movements,lip-syncwithoutinterpolation,andabruptchangesfromfronttoprofileview.

Flash animations are typically distributed by way of the World Wide Web, in which case
they are often referred to as Internet cartoons, online cartoons, or web toons. Web Flash
animations may be interactive and are often created in a series. A Flash animation is
distinguishedfrom aWebcomic,which is a comic strip distributedvia theWeb,rather than an
animated cartoon.Flash animation isnow taught inschools throughoutthe UK and can be
taken as a GCSE and A-level.

FlashAnimationdistribution
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While the creation of animation using Flash can be easier and less expensive than
traditionalanimationtechniques,theamountof time,money, andskillrequired toproduce
aprojectusingthesoftwaredependsonthechosencontentandstyle. Internetdistribution is
considerably easier and less expensive than television broadcasting, and websites such as
New grounds provide free hosting. Many Flash animations are created by individual or
amateur artists. Many Flash animations first distributed on the web became popular
enough to be broadcast on television, particularly on such networks as MTV andG4.
Flash AnimationinProfessionalstudios
Flash animation production is enjoying considerable popularity in major animation studios
aroundtheworld,asanimatorstakeadvantageofthesoftware'sabilityto organizealarge number
of assets (such as characters, scenes, movements, and props) for later re-use.
BecauseFlashfilesareinvectorfileformat,theycanbeusedtotransferanimationto 35 mm film
without any compromise in image quality. This feature is used by several
independentanimatorsworldwide, including Phil Nibbelink,who sawhis 77-minutefeature
film Romeo & Juliet: Sealed with a Kiss released in theaters in 2006, and Nina Paley, who
released Sita Sings the Blues in 2008. For Disneyland's 50 Magical Years film featuringLive
action Steve Martin interacting with Donald Duck, the hand drawn animation of Donald
Duck was cleaned up and colored in Flash. The Drawn Together Movie: The Movie!, a
straight-to-DVD feature of the animated series Drawn Together, produced by Comedy
Central and released in April 2010, discarded the series' traditional animation and used
Flash animation instead.
CreatingFlashanimationfromother software
Thereareanumberofothersoftwarepackagesavailablethatcancreateoutputinthe.swf
format.Amongtheseare GoAnimate, ToonBoom, XaraPhoto&GraphicDesigner, Vectorian
Giotto, CelAction2D, Toufee, KoolMoves, Express Animator, AlligatorFlash Designer, Amara
Web Animation software andAnime Studio. These front-ends often provide additional
support for creating cartoons, especially with tools more tailored to traditionally trained
animators, as well as additional rigging for characters, which can speed up character
animation considerably. Additionally, there are programs available which translate
3Dinformation into 2D vectors.
Aboutthe Timeline
The Timeline organizes and controls a document’s content over time in layers and frames.
Like films, Flash Professional documents divide lengths of time into frames. Layers are like
multiple film strips stacked on top of one another, each containing a different image that
appears on the Stage. The major components of the Timeline are layers, frames, and the
play head.
Layers in a document are listed in a column on the left side of the Timeline. Frames
contained in each layer appear in a row to the right of the layer name. The Timeline
header at the top of the Timeline indicates frame numbers. The playhead indicates the
current frame displayed on the Stage. As a document plays, the playhead moves from left
to right through the Timeline. The Timeline status displayed at the bottom of the Timeline
indicates the selected frame number, the current frame rate, and the elapsed time to the
current frame.
Note:Whenananimationisplayed,theactualframerateisdisplayed;thismaydifferfrom
thedocument’sframeratesettingifthecomputercan’tcalculateanddisplaytheanimation quickly
enough.
UserExperience
AdobeFlashPlayerexistsforavarietyofdesktopoperatingsystems, including Windows, Mac OS
9/X, Linux, Solaris, HP-UX, OS/2, QNX, BeOS,and IRIX.
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One estimate is that 95% of PCs have it, while Adobe claims that 98 percent of U.S. web
users and 99.3 percent of all Internet desktop users have installed their Flash Player, with
92 to 95% (depending on region) having the latest version Numbers vary depending on
the detection scheme and research demographics.

As of May 2011, users of computers with the PowerPC G5 processor are not able to view
Flash content from some sites (e.g. Facebook) that requires the latest upgrade of Adobe
Flash player, which is not compatible with this processor architecture.

In February 2012, Adobe announced to discontinue its NPAPI Flash plugin for Linux from
version 11.2. Newer versions will not be available from Adobe, but integrated with
GoogleChrome, using its PPAPI instead. Security updates for the NPAPI version will still be
provided for 5 years.

64-bit
Since version 11 of Adobe Flash Player, released October 4, 2011,64-bit and 32-bit builds
for Windows, Mac and Linux have been released in sync. Previously, Adobe offered
experimental 64-bit builds of Flash Player for Linux, from November 11, 2008 to June 15,
2010.

Availabilityonmobileoperatingsystems
AdobeFlashPlayerexistsforavarietyofmobileoperatingsystems, including Android (since
version 2.2), Pocket PC/Windows CE, QNX (e.g. on BlackBerryPlayBook), Symbian, Palm
OS, and webOS (since version 2.0).

In November 2011, however, Adobe announced the withdrawal of support for Flash on
mobile devices. Adobe is reaffirming its commitment to "aggressively contribute" to
HTML5, a platform with broader support and capabilities than Flash was ever able to
deliver.

ThereisnoAdobeFlashPlayerforiOSdevices(iPhone,iPadandiPodTouch).The iPhone accounts
for more than 60% of US and Canadian smartphone web traffic. This hurts Adobe's ability
to market Flash as a ubiquitous mobile platform. However, Flash content can be made to
run on iOS devices in a variety of ways:

 Flash content can be bundled inside an Adobe AIR app, which will then run on iOS
devices. (Apple didn't allow this for a while, but they relaxed those restrictions in
September 2010.)

 On March 8, 2011, Techradar reported that Adobe provides an experimental server
side tool (Wallaby) to convert Flash programs(asfar aspossible) toHTML5 code, thus
allowing iOS devices to display the content.

 If the content is Flash video being served by Adobe Flash Media Server 4.5, the
server will translate and send the video as HTTP Dynamic Streaming or HTTP Live
Streaming, both of which can be played by iOS devices.
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The mobile version of Internet Explorer 8 for Windows Phone cannot play Flash content.
The IE9 web browser on Microsoft Windows Phone 7.5 ('Mango') cannot play Flashcontent
either.

On November 9, 2011, Adobe announced that it will no longer develop Flash for Mobile
Platforms and is planning on developing new products with more open technologies and
standards like HTML5.

Availabilityonother computingdevices
Adobe Flash Liteis a lightweightversion ofAdobe Flash Player intended for mobile phones
and other portable electronic devices like Chumby and iRiver.

Ontheemerging single-board enthusiastmarket,assubstantiallypopularizedbythe Raspberry
Pi, support from Adobe is lacking. However, Gnash have been ported and found useful.

AvailabilityincountriesunderU.S.economicsanctions
Downloading Flash is blocked in countries that are under U.S.economic sanctions (suchas
Syria & Sudan). Users in these countries are blocked (by Adobe) from downloading Flash
plug-ins for both Internet Explorer and Firefox browsers.

Accessibility
Using Flash tends to break conventions associated with normal HTML pages. Selecting text,
scrolling,form control and right-clicking act differently than with a regular HTML
webpage.Many such interfaceunexpectanciesare fixableby thedesigner. Usability expert
Jakob Nielsen published an Alertbox in 2000 entitled,Flash: 99% Bad, which listed issues
like these.Some problems have been at least partially fixed since Nielsen's complaints:

 Textsizecanbecontrolledusingfullpagezoom,foundinmanymodernbrowsers.
 It has been possible for authors to include alternative text in Flash since Flash

Player 6. This accessibility feature is compatible only with certain screen readers and
only under Windows.

Performance
Complicationstovideoacceleration
Any Flash player must be able to animate on top of video renderings, necessitating an
intermediate color space conversion between video decoding and presentation, that a
traditional multimedia player would leave for hardware to do at a later stage. This
intermediate step splits the hardware acceleration pipeline in two. Depending on the
hardware acceleration APIs exposed by the operating system, doing either part separately
in hardware may be unsupported or complicated. For example, on Linux, native Xv video
scaling can not be used because it is made to take video in the form that comes from the
decoder – in YUVcolor space. However, Adobe Flash Player is able to make use
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of VDPAUfor decoding(provided that the computer has an NvidiaGPU), makingthe Linux
client partially hardware accelerated. The same challenge arises with native video
capability in the browser, however the implementor may choose a different compromise
between features and performance. For example, the KHTML layout engine does use Xv,
andsocannotdrawontopofthevideo.Ratherthandisplayingitsvideocontrolsontopof the video,
the video scaling is reduced to fit them below.

FlashPlayerbuild11.2.202.228forLinuxhasintroducedavideorenderingbugwithNvidia
hardwareacceleration,resultingindiscolouredFlashvideos.This bugiscausedbythe red palette
being rendered as blue. The problem has been confined to Flash Player and remains
unfixed as of April 2012. A workaround has been implemented in VDPAU.

Empiricaltests
IntestsdonebyArsTechnicain2008and2009,AdobeFlashPlayerperformedbetter on Windows
than Mac OS X and Linux with the same hardware. Performance has later improved for the
latter two, on Mac OS X with Flash Player 10.1, and on Linux with Flash Player 11.

Flashblockinginweb browsers

SomewebsitesrelyheavilyonFlashandbecomeunusablewithoutFlashPlayer,orwith Flash
blocked
Flash content is usually embedded using theobjector embedHTML element. A web browser
that does not fully implement one of these elements displays the replacement text, if
supplied by the web page. Often, a plugin is required for the browser to fully implement
these elements, though some users cannot or will not installit.

Since Flash can be used to produce content (such as advertisements) that some usersfind
obnoxious or take a large amount of bandwidth to download, some web browsers default
to not play Flash content before the user clicks on it, e.g. Konqueror,K-Meleon.

Most current browsers have a feature to block plugins, playing one only when the user
clicksit.Operaversionssince10.5 feature nativeFlashblocking.OperaTurborequires the user
to click to play Flash content, and the browser also allows the user to enable this option
permanently. Both Chrome and Firefoxhave an option to enable "click to play plugins".
Equivalent "Flash blocker" extensions also exist for many popularbrowsers:
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Firefox has Flashblock andNoScript, Internet Explorer has Foxie, which contains a number
of features, one of them named Flashblock. WebKit-based browsers under Mac OS X,such
as Apple's Safari, have ClickToFlash.

LayersandFrames

 Puteachobject tobeanimatedinaseparate layer!Yes,donotanimatetwoor more
different objectsin one layer (except in frame-by-frameanimation)

 Tocreateanewlayerclickontheinsertlayericon(leftunderneaththelayers)

 Immediatelygivethislayerameaningful name.
 simplydouble-clickonthelayername

 Ifobjectsofonelayershouldbeinfront/inthebackofanotherlayeryoucangraba layer with
the mouse and move it up or down.

 Whenyoueditobjectsinonelayer,it'sgoodpolicytolockalltheotherlayers!

Simple Drawing
Therearetwomodes:mergemodeandobjectmode:

 Inmergemode(default)youdrawshapesandoverorunder-paintothershapes.
 Inobjectmodeyoudrawgraphicobjectsthatyoulatercaneditagain.

Mostofyourdrawingsshouldbeinobjectmode.Somakesurethatthisiconisonwhen you select a
drawing tool:

 Onlyusemergemodewhenyoupaintlikeyouwouldwithrealpaint.
 YouthencanassembletheseshapeswithmenuModify->CombineObjects-

>Union.Theresultisagraphicobject.

Other commands:

 To select several objects: either hold down the SHIFT key, use a selection box or
the Lasso tool.

 Tobreakapartadrawing(wellanythingactually):right-click;BreakApart.However, to edit
the shape inside a graphic objects you don't need tobreak it apart. Youalso can
double-click on the graphic shape. You should see something like "Drawing Object"
in the Edit bar". Make sure to return to main timeline editing once you are done.

IntermediateDrawing
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Object transformation
Totransformanobjectorshapethereareseveraltools,mostimportantly:

 The Select tool: Make sure all objects are de-selected, then move the cursor close
to astroke ofanobjector a shape.Whenthecursor changes shapeyou candistort it.

 The Free Transform Tool has three different modes you can select with the
options controls in the tools bar:

o Changesize,rotate,skew(bydefaultyougetthis).Movethecursorcloseto lines or
corners and watch the cursor change form.

o Distorttool
o Envelopetool

 TheSubselectiontoolletsyoufinetunethingsyoudidwiththeabovetools
 SubselectionTool,DistortToolandEnvelopetoolletyoueitherdragdistortion points

(squares), turn or drag curve control handles(circles).

AdditionalstuffisintheModifymenu.AlsoseetheFlashCS3keyboard shortcuts.

 Make sure you only selected one single object (unless it's on purpose) before you
start transforming.

 Flash changes the cursor when it switches to a given "transform mode" and it may
display additional handles. There are lots and you should become familiar with
these.

Ifyoufeellost,gobacktotheFlashobjecttransformtutorial.

Arrangingobjects

 Toalignobjects,workwiththealignpanel(menuWindow->AlignorCtrl-k).There are
also shortcuts.

 Toassembleshapesintoagraphicobject,usetheModify->CombineObjects-
>Unionorturntheselectedshapesintoasymbol

 Tobreakapartanobject,useright-click->BreakApart.Ifyouwanttoproduce
shapes, you may have to repeat this step.

FramebyFrameAnimation
Itisusefulforseveralthings,e.g.

 Todoprecisionwork,e.g.drawing15framesforjustanarmmovement;
 Tomakepulsatingobjectsthatyoucanmovearound;
 Toinsert/removeobjectsintotheanimation

Procedure
Framebyframeanimationsworkwithanything.Justdrawanykindofshapesorgraphic objects or
whatever else in various frames. A frame with content is called a key frame.
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Animation is based on the principle that keyframe contents shown to the user in rapid
succession, by default 24 frames/second in Flash CS5/CS6 and 16 frames/second in Flash
CS3.

Toaddnewkeyframesandcopyovercontentsfromthelastkeyframe:

 Inthetimeline(intherightlayer!)clickintothenewframe
 HitF6(orright-click->InsertKeyframe).Thiswillcopycontentsfromprevious

keyframe to the new one.

Toaddnewkeyframesthatareempty:

 Inthetimeline(intherightlayer!)clickintothenewframe(ormovethereadplayhead)
 ThenhitF7(orright-click->InsertNewKeyframe)
 Thendrawsomethingneworcopy/pastefromanotherframe.
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WhyweuseLanguage?

Weuselanguageduetofollowingreasons:
 Itstoresdata
 Howtointeractbetweeninputandoutput
 Theoperatorusestotransformandcombinedata.

What isC?
By1960languagescomeintoexistence.COBOLwasbeingusedforcommercial purposes,
FORTRAN for Engineering and Scientific applications. An Internationalcommittee was setup
to develop languages. This committee came out with a language called ALGOL60. ALGOL-
60 never really became popular because it seemed too abstract, too general. To reduce
the abstractness and generality a new language called Combined Programming Language
(CPL) was developed at Cambridge University. CPL was an attempt to bring ALGOL 60 new
version, but CPL turned out to be so big, having so many features, that it was hard to
learn and difficult to implement. BCPL (Basic Combined Programming Language)
developed by Martin Richards at Cambridge University aimed to solve this problem by
bringing CPL down to its basic good features. But unfortunately it turned to be less
powerful and too specific. Dennis Ritchie inherit the features of CPL and BCPL and made a
language named C. C forms the basis for many advanced, highly
powerful and effective programming languages. C is a programming language developed
atAT&T’s Bell Laboratories of USA in 1972. It was designed and written by a man named
DennisRitchie.InthelateseventiesCbegantoreplacethemorefamiliarlanguagesof
thattimelikePL/I,ALGOLetc.NoonepushesC.Cseemssopopular,becauseitis reliable, simple
and easy to use. The concept of C derives its origin from a primitive form of C which was
called Basic Combined Programming Language (BCPL) developed by
KenThompson ofBellLaboratorieswhich hereferredtoas‘B’.Bynow itmightnotbe
difficulttoguessthatanameascrypticasC wasconferredtoitbecauseitwasconsidered to be
amodified more adaptive successor of “B”. C’s compactness and coherence is mainly
due to the fact that it’s a one man language.
CBasics
Beforeweembarkonabrief tourof C'sbasicsyntaxandstructureweofferabrief history of C and
consider the characteristics of the C language.

In the remainder of the Chapter we will look at the basic aspects ofC programs such as C
program structure, the declaration of variables, data types and operators.We will assume
knowledge of a high level language, such as PASCAL.



ItisourintentiontoprovideaquickguidethroughsimilarCprinciplestomosthighlevel
languages.Herethesyntaxmaybeslightlydifferentbuttheconceptsexactlythesame.

Cdoes haveafewsurprises:

 Many High level languages, like PASCAL, are highly disciplined and
structured.
 However beware -- C is much more flexible and free-wheeling. This freedom
gives C much more power that experienced users can employ. The above example
below (mystery.c) illustrates how bad things could really get.

CharacteristicsofC

WebrieflylistsomeofC'scharacteristicsthatdefinethelanguageand alsohaveleadtoits popularity
as a programming language. Naturally we will be studying many of these aspects
throughout the course.

 Smallsize
 Extensiveuseoffunctioncalls
 Loosetyping--unlikePASCAL
 Structuredlanguage
 Lowlevel(BitWise)programmingreadilyavailable
 Pointerimplementation-extensiveuseofpointersformemory,array,
structures and functions.

C has nowbecomeawidelyusedprofessional languagefor various reasons.

 Ithashigh-levelconstructs.
 Itcanhandlelow-levelactivities.
 Itproducesefficientprograms.
 Itcanbecompiledonavarietyofcomputers.

Featuresof C

LowLevelLanguageSupport ProgramPortability

PowerfulandFeatureRich BitManipulation

HighLevelFeatures ModularProgramming

EfficientUseof Pointers



FeaturesofCProgrammingLanguage:

C Programming is widely used in Computer Technology, We can say that C Programmingis
inspirationfordevelopmentof other languages.WecanuseC Programmingfor different
purposes. Below are some of the Features of C Programming language -

1 .LowLevelFeatures:
1. C Programming provideslow level featuresthat are generally provided by the Lower

level languages. C is Closely Related to Lower level Language such as “Assembly
Language“.

2. ItiseasiertowriteassemblylanguagecodesinCprogramming.

2 .Portability:

1. CProgramsareportablei.etheycanberunonanyCompilerwithLittleorno
Modification

2. CompilerandPreprocessormakeitPossibleforCProgramtorunitonDifferentPC

3. Powerful
1. ProvidesWideverityof‘Data Types‘
2. ProvidesWideverityof‘Functions’

3. ProvidesusefulControl&LoopControlStatements

4. Bit Manipulation

1. CProgramscanbemanipulatedusingbits.Wecanperformdifferentoperationsatbit level.
We can manage memry representation at bit level.

2. ItprovideswideverityofbitmanipulationOperators.Wehavebitwiseoperatorsto
manage Data at bit level.

5 .HighLevelFeatures:

1. It is more User friendly as compare to Previous languages. Previous languagessuchas
BCPL,Pascal and other programming languages never provide such great featuresto
manage data.

2. Previous languages have there pros and cons but C Programmingcollected all useful
features of previous languages thus C become more effective language.
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6 .Modular Programming

1. Modular programming isasoftwaredesigntechniquethatincreasestheextentto
which software is composed of separate parts, called modules

2. CProgramConsistofDifferentModulesthatareintegratedtogethertoformcomplete
program

7 .EfficientUseofPointers
1. Pointershasdirectaccesstomemory.

2. CSupportsefficientuseofpointer.

C Program Structure

ACprogrambasicallyhasthefollowingform:

 PreprocessorCommands
 Typedefinitions
 Functionprototypes--declarefunctiontypesandvariablespassedto
function.
 Variables
 Functions

Wemusthaveamain()function.

C Keywords

Keywords are the set of predefined words whose functionality has been expressed to the
compiler and whenever called upon they furnish their task with utmost comfort. The
keywords cannot be used for any function other than what it is defined for, not even as
variable names.

Variables
A program is made of data and instructions to manipulate those data. Note that data have
to be stored somewhere, and thus will need some memory space in the RAM.

A variable is an entity that is used to store data. Without variables, there is no way (or
actually NO PLACE) to store data. A variable has

 aname(morespecificallyasymbolicname)
 anassociatedphysicalmemoryspace(portionina RAM)
 adatatype
 avalue(dependsondata type)
 ascope



 a lifetime



r of integer with decimal points. Whenever an integer or a character is used in a program
thecomputershouldbeabletoidentifywheretostoreitinthememory.
The basic data types are depicted in a tabular format to get a better understanding of the
basics of C programming.

DataType Description Memory Range Format
Requirement Specifier

Int wholenumbers 2bytes -32768to %d,%i
long -- 4bytes +32767 %ld
Char Characters 1 Byte 0to255 %c,%s

Float Numberswith 4 Bytes 1.0E-37to %f
Decimals 1.0E+37

Double Numberswith 8 Bytes 1.7E-308to %lf

Constants

ANSICallowsyoutodeclare constants.Whenyoudeclareaconstantitisabitlikea variable
declaration except the value cannot be changed.

Theconstkeywordistodeclareaconstant,asshownbelow:

intconsta=1;
constinta=2;

Note:

 Youcandeclaretheconstbeforeorafterthetype.Chooseoneanstickto it.
 Itisusualtoinitialiseaconstwithavalueasitcannotgetavalueanyother way.

The preprocessor #define is another more flexible (see Preprocessor Chapters) method to
define constants in a program.You frequently see const declaration in function
parameters. This says simply that the function is not going to change the value of the
parameter.The following function definition used concepts we have not met (see chapters
onfunctions, strings, pointers,andstandardlibraries)butforcompletenesof thissection it is is
included here:

voidstrcpy(char*buffer,charconst*string)

The second argiment string is a C string that will not be altered by the string copying
standard library function.

ADVANCEDIPLOMAINOMPUTERAPPLICATIONS2NDYEAR



Operators inC :

Operators can briefly be defined as the tools used for solving various mathematical,
conditional,relationalandlogicalproblems.Theoperatorsthatyouwillbedealingwithare
arithmetic operators , unary operators, relational and logical operators . The item in
between which the operators are placed are called operands.

Arithmeticoperators:
Arithmetic Operators can be considered the main point of all the operators. Arithmetic
operators are tools that help us in computing various mathematical operations.

Operators Function Performed
+ Addition
- Subtraction
* Multiplication
/ Division
% (Modulus)Findsthe remainder

UnaryOperators:
Therearetwotypesofunaryoperators:-

 Theincrementoperator(denotesas‘++’)
 Thedecrementoperator(denotesas‘--’ )

When the increment operator is prefixed to a variable which holds an integer it increases
the value of the number by one. Similarly the decrement operator decreases the value by
one.

RelationalandLogicalOperators:

Operators Significance

< Lessthan

<= Lessthanorequalto

> Greaterthan

>= Greaterthanorequalto

EqualityOperators Significance

== Equalto

!= Notequalto

LogicalOperators Significance

&& And

|| Or

! Not

Assignmentis=I.E.i=4;ch=`y';



Increment++,Decrement--whicharemoreefficientthantheirlonghandequivalents,for
example:--x++ isfasterthan x=x+1.

The ++ and -- operatorscan be eitherin post-fixed orpre-fixed.With pre-fixed the value is
computed before the expression is evaluated whereas with post-fixed the value is
computed after the expression is evaluated.

Comparison Operators

Totestforequalityis==

Awarning:Bewareofusing``=''insteadof``=='',suchaswritingaccidentally

if(i=j).....

This is a perfectly LEGAL C statement (syntactically speaking) which copies the value in
"j" into "i", and delivers this value, which will then be interpreted as TRUE if j is non-zero.
This is called assignment by value -- a key feature of C.

Notequalsis:!=

Otheroperators<(lessthan),>(graterthan),<=(lessthanorequals),>=(greaterthanor equals)
are as usual.

StatementsinCLanguage

C needs some kind of managerial system which instructs the computer what function has
to be performed at which time. The control statement act as a manager. You will amazed
at the functions the different control statements handle. For example in a program you
may have a statement in which a multiplication operation is to be performed and in the
next an addition operation and after the next line there may be a statement which may
want itself to be repeated 8 timesandanotherstatement maylike itself to be skipped and
attended to at a later stage. All these conditions are managed by the control statements.

The sequence control structure is one of the basic uncomplicated control statements. The
ideaisverysimple.Inthesequencecontrolinstructionsthestatementstobeexecutedare done so
in a serial manner one after the other. The C compiler first executes the opening
lineandthenmovesontothenextandsoon.Inaserialfashionandtheentireprogramis executed in
this manner.

ConditionalStatement
C program executes program sequentially. Sometimes, a program requires checking of
certain conditions in program execution. C provides various key condition statements to



check condition and execute statements according conditional criteria.These statements
are called as 'Decision Making Statements' or 'Conditional Statements'.Followings are
the different conditional statements used in C :

1. If Statement
2. If-ElseStatement
3. NestedIf-ElseStatement
4. Switch Case

IfStatement:Theifstatementcanbeusedtotestconditionssothatwecanaltertheflow of a
program. Code:
#include<stdio.h>
int main()

{
int mark;
charpass;
scanf("%d",&mark);
if (mark > 40)

pass="y";
return 0;

}

If-ElseStatement:Theifstatementfirsttestsifaconditionistrueandthenexecutesan instruction
and the else is for when the result of the condition is false. Code:

#include<stdio.h>
int main()
{

int mark;
charpass;
scanf("%d",&mark);
if (mark > 40)
{

}
else
{

}

pass = "y";
printf("Youpassed");

pass = "n";
printf("Youfailed");

return0;
}

The Switch Statement:The switch statement is just like an if statement but it has many
conditions and the commands for those conditions in only 1 statement. It is runs faster
thananif statement.Inaswitchstatementyoufirstchoosethevariabletobetestedand



thenyougiveeachoftheconditionsandthecommandsfortheconditions.Youcanalso



putinadefaultifnoneoftheconditionsareequaltothevalueofthevariable.
For Loop, While Loop, Breakand Continue
Controlstructuresarebasicallyofthreetypes–

 Sequence statements
 Iterativestatements
 Selectionstatements

SequenceStatements: AlltheStateinaprogramexcepttheiterative&statements.They are
generally the individual statements which performs the task of input, output, assignment
declaration etc.

Iterative Statement are those repeated execution of a particular set of instructions
desired number of times. These statements are generally called loops for their execution
nature.

TypesofLoopingStatements:

Basically, the types of looping statements depends on the condition checking mode.
Conditioncheckingcanbemadeintwo waysas:Beforeloopandafterloop.So,thereare 2(two)
types of looping statements.

 Entrycontrolledloop
 Exitcontrolledloop

1. Entrycontrolledloop:

Insuchtypeofloop,thetestconditionischeckedfirstbeforetheloopisexecuted.

Somecommonexamplesofthisloopingstatementsare:

 while loop
 forloop

2. Exitcontrolledloop:

Insuchtypeofloop,theloopisexecutedfirst.Thenconditionischeckedafterblockof statements are
executed. The loop executed atleat one time compulsarily.

Somecommonexampleofthisloopingstatementis:

 do-whileloop



In C language the iterative statements (loops) can be implemented in the three loops and
they are

TheForLoop

Syntax-

for(initialization;condition; incrementation)
{

bodyofloop
}

ForLoopwillperformitsexecutionuntiltheconditionremainssatisfied.Ifthebodyoftheloop consists
of more than one statement then these statements are made compound by placing the open and
closed curly brackets around the body of the loop. For loop is a count loop. The initialization
condition and increamentation may be done in the same statement. For loop will not execute at
least once also if the condition is false at the first time itself.

TheWhileLoop

Syntax–
Initialization;
While(condition)

{
Body of loop;
Incrementation;

}

In this loop, initialisation, condition and incrementation is done in the three different
statements. This loops is count as well as event loop. In case of while loops the body of
theloopwillconsistofmorethanonestatementsbecauseeachtimeonestatementwillbe of
incrementation. Hence the open and closed curly brackets are required.

Do-While LoopStatement:

ThethirdloopstatementavailableinCisdo-whilestatementsyntax:- Initialization;
Do
{
Body of loop;
Increamentation;
}while(condition)

AnintroductiontoArrays



The concept of arrays depends on other data types, which was meant to facilitate the
storage of abundant amount of number and wasting an entire delivery of space in the
memory.Itwouldbelikebuyingatwodozenbooksandultimately usingoneanddumping the
restinthe garbage.Arrayscan be defined asa collection of similarelements. An array of
elementscanbeformedonlyifalltheelementsareofoneparticulardatatypei.e.allof them are
either integer or character or a floating point number, but there cannot exist an array
which hosts an combination of these data types.

TypesofArrays
Thearrayaredividedintotwoparts:

 SingleDimensionalArrays
 MultidimensionalArrays

SingleDimensionalArrays:

The single dimensional arrays as the name suggested, handles only a single advance of
similar elements. That is to say you can only have one row of elements and the size of a
single dimensional array depends on the programmer. Basically the single dimensional
arrays facilitate the accommodation of many similar elements in a single variable. The
succeeding sections after which you will have a cloud less view of the single dimensional
arrays.

MultiDimensionalArrays:
Multi dimensional array requires separate brackets for each subscript. One dimensional
array has a pair of square brackets, a two dimensional array will have two pairs of square
brackets, three dimensional array three pairs of square brackets and so on.

TwoDimensionalArray:
A two dimensional array can be visualized as an array below an array. Two dimensional
array will have two pairs of square brackets.
Syntax:-datatypearrayname[statement1][statement2]
Thetwodimensionalarrayisoftenreferredtoasamatrix.Thestatementoneandtwoare the
subscripts that the two dimensional array will hold. One will specify the row and
expression, two will specify the column and they indicate the number of array elements
associated with each subscript.

intA[ 4] [2 ];
Column0 Column1

RowNo0 4200 10
RowNo1 6500 20
RowNo2 7850 30
RowNo3 3450 40

ThustheelementinA[0][0]willbe1000andtheelementA[3][3]willbe40.Therestofthe numbers
can be figured by having a look at the above table. In the memory the element
areplacedinasequentialpatternsuchthattheelement[0][0]will befirstfollowedbythe
elementin[0][1]followedby[1][0]andsoon.
Strings
A group of integers can be stores in an integer array. Similarly a group of characters can
be stored in a character array. Character array are many a time also called strings. Most
languages internallytreat strings as character arrays, but somehowconceal thisfactfrom



theprogrammer.Characterarraysorstringsareusedbyprogramminglanguagesto manipulate
text such as words and sentences. A string constant is a one dimensional array of
characters terminated by a null ( ‘ \ 0 ’ ) for example ,

charname[ ] = {‘ I’,‘T’, ’T’,’C’,‘O’,‘M’,’P’,’U’, ‘T’,‘E ’,‘R’,‘\0
’}
Eachcharacterinthearrayoccupiesonebyteofmemoryandthelastcharacterisalways‘
\ 0 ’. What character is this ? It looks like two characters, but it is actually only
onecharacter,eitherthe\ indicating that what follows it is something special. ‘ \0 ‘ is called null
character.Notethat‘\0’and‘0’arenotsame.ASCIIvalueof‘\0‘is0whereasASCIIvalueof ‘ 0 ‘ is 48 It
shows a way a character array is stored in memory. The elements of character array are
stored in contiguous memory locations. The terminating null ( ‘ \ 0 ‘ ) is
important,becauseitistheonlywaythefunctionsthatworkwithastringcanknowwhere the
stringcan knowwherethe stringends. Astring not terminated by a ‘ \0 ‘ is really a string,
but merely a collection of characters.
WithCcompileralargesetofusefulstringhandlinglibraryfunctionsareprovided.

Function Use
strlen Findslengthofastring
strlwr Convertsastringtolowercase
strupr ConvertsaStringtoUpper Case
strcat Appendsonestringattheendofanother
strcpy CopiesaString into Another
strcmp Comparestwostrings
strdup DuplicatingaString
strrev ReversingaString

Function
A function is a self contained block of a statements that perform a coherent task of some
kind.EveryCprogramcanbethoughtof asacollectionof thesefunctions.Sometimesthe
interaction with this person is very simple sometimes it’s complex.
You have a task which is always performed exactly in the same way... say a servicing of your
motorbike.Whenyouwantittobedone,yougototheservicestationandsay“I’s time, do it
nowYou don’t need to give instructions, because the mechanic knowshisjob. You don’t
need to betold whenthejobisdone. Uassumethebike wouldbeservicedin the usual way, the
mechanic does.
AsimpleCfunctionwhichoperatedinmuchthesamewayasthe,mechanics.Wewillbe
lookingattwothingsaprogramthatcallsoractivatesthefunctionandthefunctionitself. void main
( )

{message();
printf(“\nThanksafterreturnoffirstfunction “ ) ;
getch ( ) ;

}
message()
{
printf(“\nWelcometothefirstfunctionprogram“);
}



Note:



AnyCprogram containsatleastonefunctions.
Ifaprogramcontainsonlyonefunction,itmustbemain().
In a C program if there are more than onefunctions present, then one ( and only one )of
thesefunctionsmustbemain(),becauseprogramexecutionalwaysbeginswithmain ( ) . Thereis
no limitonthenumberof functionsthatmight bepresented in a Cprogram.
Eachfunctioninaprogramiscalledinthesequencespecifiedbythefunctioncallsin
main( ).
Aftereachfunctionhasdoneitsthings,controlreturnstomain ( ).Whenmain ( ) runsout of
function calls, the program ends.

PROGRAMMING
Language C++

Introduction

object-orientation is introduced as a new programming concept which should help you in
developinghighqualitysoftware.Somepeoplewillsaythatobject-orientationis``modern''.
Whenreadingannouncementsofnewproductseverythingseemstobe``object-oriented''.
``Objects'' are everywhere. In this section we will try to outline characteristics of object-
orientation to allowyou to judge those object-oriented products.

Roughly speaking, we can distinguish the learning curve of someone who learns to
program:

 Unstructuredprogramming,
 proceduralprogramming,
 modularprogrammingand
 object-orientedprogramming.

Unstructured Programming

Usually, people start learning programming by writing small and simple programs
consisting only of one main program. Here ``main program'' stands for a sequence of
commands or statements which modify data which is global throughout the whole
program.

Figure:Unstructuredprogramming.Themainprogramdirectlyoperatesonglobaldata.



Procedural Programming

With procedural programming you are able to combine returning sequences of statements
into one single place. A procedure call is used to invoke the procedure. After the sequence
is processed, flow of control proceeds right after the position where the call was made

ModularProgramming

Withmodularprogrammingproceduresofacommonfunctionalityaregroupedtogetherinto
separate modules.Aprogram thereforenolongerconsistsof onlyone single part. It is now
devided into several smaller parts which interact through procedure calls and which form
the whole program.
Object-oriented programming solves some of the problems just mentioned. In contrast to
the other techniques, we now have a web of interacting objects, each house-keeping its
own state.

Figure:Object-orientedprogramming.Objectsoftheprograminteractbysending
messages to each other.



AbstractDataTypes

Some authors describe object-oriented programming as programming abstract data types
and their relationships. ADTs are used to define a new type from which instances can be
created.ADTsprovidean abstractviewto describe propertiesof setsof entities,theiruse is
independent from a particular programming language.

Class
A class is an actual representation of an ADT. It therefore provides implementation details
for the data structure used and operations. We play with the ADT Integer and design our
own class for it:
classInteger{
attributes:
inti

methods:
setValue(intn)
IntegeraddValue(Integerj)

}

Aclass istheimplementationofanabstractdatatype(ADT).It
defines attributes and methods which implement the data structure and operations of the
ADT, respectively.Instances of classes are called objects. Consequently, classes define
properties and behaviour of sets of objects.

Object

Objects are uniquely identifiable by a name. Therefore you could have two distinguishable
objectswiththesamesetof values.Thisissimilarto``traditional''programminglanguages
whereyoucouldhave,saytwointegersiandjbothofwhichequalto``2''.Pleasenoticethe use of
``i'' and ``j'' in the last sentence to name the two integers. We refer to the set of values at
a particular time as the state of the object.

Definition (Object) An object is an instance of a class. It can be uniquely identified by its
name and it defines a state which is represented by the values of its attributes at aparticular
time. The BEHAVIOURof an object is defined by the set of methods which can be applied on it.



Message

Arunningprogramisapoolofobjectswhereobjectsarecreated,destroyedand interacting.
Thisinteractingisbasedon messages whicharesentfromoneobject toanotheraskingthe
recipient to apply a method on itself. A message is a request to an object to invoke one of
its methods. A message therefore contains

 thenameofthemethodand
 theargumentsofthemethod.

Inheritance

With inheritance we are able to make use of the a-kind-of and is-a relationship. As
described there, classes which are a-kind-of another class share properties of the latter. In
our point and circle example, we can define a circle which inherits from point:

classCircleinheritsfromPoint{ attributes:
intradius

methods:
setRadius(int newRadius)
getRadius()}

Class Circle inherits all data elements and methods from point. There is no need to define
them twice:We just use already existing and well-known data and method definitions.

Definition (Inheritance) Inheritance is the mechanism which allows a class A to inherit
properties of a class B. We say ``A inherits from B''. Objects of class A thus have access to
attributesandmethodsofclassBwithouttheneedtoredefinethem. Thefollowingdefinition defines
two terms with which we are able to refer to participating classes when they use inheritance.

Definition (Superclass/Subclass) If class A inherits from class B, then B is called superclass
of A. A is called subclass of B. Objects of a subclass can be used where objects of the
corresponding superclass are expected. This is due to the fact that objects of the subclass
share the same behaviour as objects of the superclass.



Figure: Asimpleinheritancegraph.

Multiple Inheritance

One important object-oriented mechanism is multiple inheritance. Multiple inheritance does
not mean that multiple subclasses share the same superclass. It also does not mean that a
subclass can inherit from a class which itself is a subclass of another class.Multiple
inheritance means that one subclass can have more than one superclass. This enables the
subclasstoinheritpropertiesofmorethanonesuperclassandto``merge''theirproperties.

Figure:DeriveadrawablestringwhichinheritspropertiesofPointandString.

Whatisinheritedfrom the base class?

Inprinciple,aderivedclassinheritseverymemberofabaseclassexcept:

 itsconstructoranditsdestructor
 its operator=() members
 itsfriends



Although the constructors and destructors of the base class are not inherited
themselves,itsdefaultconstructor(i.e.,itsconstructorwithnoparameters)anditsdestructorare
always called when a new object of a derived class is created or destroyed.

AbstractClasses

With inheritance we are able to force a subclass to offer the same properties like their
superclasses.Consequently,objectsofasubclassbehavelikeobjectsoftheir superclasses.
Sometimes it make sense to only describe the properties of a set of objects without
knowing the actual behaviour beforehand.

StaticandDynamic Binding

In strongly typed programming languages you typically have to declare variables prior to
their use. This also implies the variable's definitionwhere the compiler reserves space for
thevariable.Definition (Static Binding) If the type T of a variable is explicitly associated with
itsnameNbydeclaration,wesay,thatNisstaticallyboundtoT.Theassociationprocessis called
static binding.

Polymorphism
Polymorphismallowsanentity(forexample,variable,functionorobject)totakeavarietyof
representations.Thereforewehavetodistinguishdifferenttypesofpolymorphismwhichwill be
outlined here.

Data Types
Table:Built-intypes.



Type Description Size Domain

Char

Signed Character
byte.Charactersare
enclosed in single
quotes.

1 -128..127

Double Doubleprecision
numbers 8 Ca.10-308..10308

Int Signedinteger 4 -231..231-1

Float Floatingpoint
number 4 Ca.10-38..1038

Long(int) Signedlonginteger 4 -231..231-1

Longlong(int) Signedverylong
integer 8 0..263..263-1

Short(int) Shortinteger 2 -215..215-1

Unsignedchar Unsigned character
byte 1 0..255

Unsigned(int) Unsignedinteger 4 0..232 -1

Unsignedlong (int) Unsignedlong
integer 4 0..232-1

Unsignedlonglong
(int)

Unsignedverylong
integer 8 0..264-1

Unsignedshort(int) Unsignedshort
integer 2 0..216-1

ExpressionsandOperators

Expressions are combined of both terms and operators. The first could be constansts,
variables or expressions. From the latter, C offers all operators known from otherlanguages.
However, it offers some operators which could be viewed as abbreviations to combinations
of other operators. In C almost everything is an expression. For example, the
assignmentstatement``=''returnsthevalueofitsrighthandoperand.Asa``sideeffect''it also sets
the value of the lefthand operand.

Statements

C defines all usual flow control statements. Statements are terminated by a semicolon ``;''.



We can group multiple statements into blocks by enclosing them in curly brackets. Within
each block, we can define new variables



Statement Description

break; Leave current block. Also used to leave case
statement in switch.

continue; Onlyusedinloopstocontinuewithnextloop
immediately.

do
Stmt
while(expr);

ExecutestmtaslongasexprisTRUE.

for ([expr]; [expr]; [expr
stmt

Thisisanabbreviationforawhileloopwhere
thefirstexpristheinitialization,thefirstexpr
istheconditionandthethirdexpristhestep.

gotolabel; Jumpstopositionindicatedbylabel.The
destinationislabelfollowedbycolon“:”.

if(expr) IF-THEN-ELSEINC notation

return[expr];

Returnfromfunction.Iffunctionreturnsvoid
return should be used without additional
argument. Otherwise the value of expr is
returned.

switch(expr){caseconst-erpr:stmts case
const-expr: stms
…
[default:stmts]
}

After evalution of expr its value is compared
with the caseclauses.Execution continuesat
the one that matches. BEWARE: You must
use break to leave the switch if you don’t
want execution of following case clauses! If
no case clause matches and a default clause
areexecuted.

While(expr)stmt RepeatstmtaslongasexprisTRUE.

Functions

AsCisaprocedurallanguageitallowsthedefinitionoffunctions.Proceduresare
``simulated''byfunctionsreturning``novalue''.Thisvalueisaspecialtypecalledvoid.

Functionsaredeclaredsimilartovariables,buttheyenclosetheirargumentsinparenthesis (even if

there are no arguments, the parenthesis must be specified):

intsum(intto);/*Declarationofsumwithoneargument*/
intbar();/*Declarationofbarwithnoarguments*/ void
foo(int ix, int jx);

/*Declarationoffoowithtwoarguments*/

Pointersand Arrays



OneofthemostcommonproblemsinprogramminginC++istheunderstandingofpointers and
arrays. In C (C++) both are highly related with some small but essential differences. You
declare a pointer by putting an asterisk between the data type and the name of the
variable or function:

char*strp; /*strpis`pointertochar'*/

Youaccessthecontentofapointerbydereferencingitusingagaintheasterisk:

*strp='a'; /*Asinglecharacter*/

As in other languages, you must provide some space for the value to which the pointer
points.A pointer to characters canbe used to pointto a sequenceof characters: the string.
Strings in C are terminated by a special character NUL (0 or as char ',\0).

Constructor

With constructors we are able to initialize our objects at definition time as we have
requested it for our singly linked list. We are now able to define a class List where the
constructors take care of correctly initializing its objects.If we want to create a point from
another point, hence, copying the properties of one object to a newly created one, we
sometimes have to take care of the copy process. For example, consider the class Listwhich
allocates dynamically memory for its elements. If we want to create a second list which is a
copy of the first, we must allocate memoryand copy the individual elements.

Destructors
Consider a class List. Elements of the list are dynamically appended and removed. The
constructor helps us in creating an initial empty list. However, when we leave the scope of
the definition of a list object, we must ensure that the allocated memory is released. We
therefore define a special method called destructor which is called once for each object at
its destruction time:

voidfoo(){
Listalist; //List::List()initializesto

//emptylist.
... //add/removeelements
} //Destructorcall!

Destruction of objects take place when the object leaves its scope of definition or is
explicitly destroyed. The latter happens, when we dynamically allocate an object and
release it when it is no longer needed. Destructors are declared similar to constructors.
Thus, theyalso use the nameprefixed bya tilde (~) of thedefiningclass.



Operators inC++

Operators can briefly be defined as the tools used for solving various mathematical,
conditional,relationalandlogicalproblems.Theoperatorsthatyouwillbedealingwithare
arithmetic operators , unary operators, relational and logical operators . The item in
between which the operators are placed are called operands.



Arithmeticoperators:
Arithmetic Operators can be considered the main point of all the operators. Arithmetic
operators are tools that help us in computing various mathematical operations.

Operators Function Performed

+ Addition

- Subtraction

* Multiplication

/ Division

% (Modulus)Findsthe remainder

UnaryOperators:
Therearetwotypesofunaryoperators:-

 Theincrementoperator(denotesas‘++’)
 Thedecrementoperator(denotesas‘--’ )

When the increment operator is prefixed to a variable which holds an integer it increases
the value of the number by one. Similarly the decrement operator decreases the value by
one.
RelationalandLogicalOperators:

Operators Significance
< Lessthan

<= Lessthanorequal to
> Greaterthan

>= Greaterthanorequalto

Equality Operators Significance

== Equalto

!= Notequalto

LogicalOperaors Significance
&& And
|| Or
! Not



Assignmentis=I.E.i=4;ch=`y';

Increment++,Decrement--whicharemoreefficientthantheirlonghandequivalents,for
example:--x++ isfasterthan x=x+1.

The ++ and -- operatorscanbeeitherinpost-fixedorpre-fixed.Withpre-fixedthevalueis
computed before the expression is evaluated whereas with post-fixed the value is
computed after the expression is evaluated.

Comparison

OperatorsTotestfor

equality is ==

Awarning:Bewareofusing``=''insteadof``=='',suchaswritingaccidentally

if(i=j).....

This is a perfectly LEGAL C statement (syntactically speaking) which copies the value in
"j" into "i", and delivers this value, which will then be interpreted as TRUE if j is non-zero.
This is called assignment by value -- a key feature of C.

Notequalsis:!=

Otheroperators<(lessthan),>(graterthan),<=(lessthanorequals),>=(greaterthanor equals)
are as usual.

Statements in C Language

C needs some kind of managerial system which instructs the computer what function has
to be performed at which time. The control statement act as a manager. You will amazed
at the functions the different control statements handle. For example in a program you
may have a statement in which a multiplication operation is to be performed and in the
next an addition operation and after the next line there may be a statement which may
want itself to be repeated 8 timesandanotherstatement maylike itself to be skipped and
attended to at a later stage. All these conditions are managed by the control statements.

.ConditionalStatement
C program executes program sequentially. Sometimes, a program requires checking of
certain conditions in program execution. C provides various key condition statements to



check condition and execute statements according conditional criteria.These statements
are called as 'Decision Making Statements' or 'Conditional Statements'.Followings are
the different conditional statements used in C :

5. If Statement
6. If-ElseStatement
7. NestedIf-ElseStatement
8. Switch Case

IfStatement:Theifstatementcanbeusedtotestconditionssothatwecanaltertheflow of a
program. Code:
#include<stdio.h>i
nt main()

{
int mark;
charpass;
scanf("%d",&mark);
if (mark > 40)

pass="y";
return 0;

}
If-ElseStatement:Theifstatementfirsttestsifaconditionistrueandthenexecutesan instruction and
the else is for when the result of the condition is false. Code:

#include<stdio.h>in

t main() {

intmark;
char pass;
scanf("%d",&mark);
if (mark > 40)
{

}
else
{

}

pass = "y";
printf("Youpassed");

pass = "n";
printf("Youfailed");

return0;
}

The Switch Statement:The switch statement is just like an if statement but it has many
conditions and the commands for those conditions in only 1 statement. It is runs faster
thananif statement.Inaswitchstatementyoufirstchoosethevariabletobetestedand



thenyougiveeachoftheconditionsandthecommandsfortheconditions.Youcanalso
putinadefaultifnoneof theconditionsareequaltothevalueof thevariable.
For Loop, While Loop, Breakand Continue
Controlstructuresarebasicallyofthreetypes–

 Sequence statements
 Iterativestatements
 Selectionstatements

Sequence Statements : All the State in a program except the iterative & statements.
They are generally the individual statements which performs the task of input, output,
assignment declaration etc.

Iterative Statement arethoserepeatedexecutionofaparticularsetofinstructionsdesired
number of times. These statements are generally called loops for their execution nature.

TypesofLoopingStatements:

Basically, the types of looping statements depends on the condition checking mode.
Conditioncheckingcanbemadeintwo waysas:Beforeloopandafterloop.So,thereare 2(two)
types of looping statements.

 Entrycontrolledloop
 Exitcontrolledloop

2. Entrycontrolledloop:

Insuchtypeofloop,thetestconditionischeckedfirstbeforetheloopisexecuted. Some

common examples of this looping statements are :

 while loop
 forloop

2. Exitcontrolledloop:

Insuchtypeofloop,theloopisexecutedfirst.Thenconditionischeckedafterblockof statements are
executed. The loop executed atleat one time compulsarily.

Somecommonexampleofthisloopingstatementis:

 do-whileloop



In C language the iterative statements (loops) can be implemented in the three loops and
they are

The For Loop

Syntax-

for(initialization;condition; incrementation)
{

bodyofloop
}

ForLoopwillperformitsexecutionuntiltheconditionremainssatisfied.Ifthebodyof the loop
consists of more than one statement then these statements are made compound by
placing the open and closed curly brackets around the body of the loop. For loop is a
count loop. The initialization condition and incrementation may be done in the same
statement. For loop will not execute at least once also if the condition is false at the first
time itself.

TheWhile Loop

Syntax–
Initialization;
While(condition)

{
Body of loop;
Incrementation;

}

In this loop, initialisation, condition and incrementation is done in the three different
statements. This loops is count as well as event loop. In case of while loops the body of
theloopwillconsistofmorethanonestatementsbecauseeachtimeonestatementwillbe of
incrementation. Hence the open and closed curly brackets are required.

Do-While LoopStatement:

ThethirdloopstatementavailableinCisdo-whilestatementsyntax:- Initialization;
Do
{
Body of loop;
Increamentation;
}while(condition)



PHP &MySQL
PHPstandsforHypertextPreprocessor.PHPisapowerfulserver-sidescriptinglanguage for
creating
dynamicandinteractivewebsites.PHPisthewidelyused,free,andefficientalternativeto competitors
such as Microsoft’s ASP. PHP is perfectlysuited for Web development and
canbeembeddeddirectlyintotheHTMLcode.ThePHPsyntaxisverysimilartoPerland
C. PHP is often used together with Apache (web server) on various operating systems. A
PHP filemay containtext,HTMLtagsandscripts.ScriptsinaPHPfileare executedon the server.
PHP +MySQL

PHPstandsforPHP:HypertextPreprocessor
PHPisaserver-sidescriptinglanguage,likeASP
PHPsupportsmanydatabases(MySQL,Oracle,Sybase,SQL,GenericODBC,

etc.)
PHPisanopensourcesoftware (OSS)&freetodownloadand use.
PHPfileshaveafileextensionof“*.php”.
MySQLisasmalldatabaseserver&idealforsmall and mediumapplications.

BasicPHPSyntax
Writing PHP on your computer is actually very simple. You don’t need any special
software, except for a text editor (like Notepad inWindows). A PHP scripting block always
starts with <?php and ends with ?>. A PHP scripting block can be placed anywhere in the
document.

<?phpecho “HelloWorld”;?>
Each code line in PHP must end with a semicolon. The semicolon is a separator andis
usedtodifferentiateonesetofinstructionsfromanother.Therearetwobasicstatementsto
outputtextwithPHP:echoandprint.Intheexampleabovewehaveusedtheecho
statementtooutputthetext“HelloWorld”.
Comments in PHP

In PHP, we use // to make a single-line comment or /* and */ to make a large comment
block.

<?php//Thisisacomment

/*Thisisacommentblock*/?>

PHP Variables : (Variable: A quantity which may vary during program execution is called a
variable.)Variables areused for storing values, like text strings, numbersor arrays.Whena
variable is declared, it can be used over and over again in your script.All variables in PHP
start with a $ sign symbol.

<?php
$age=12;



echo $age;
?>

PHPStringVariables:Astringvariableisusedtostoreandmanipulatetext.String
variablesareusedforvaluesthatcontainscharacters.Afterwecreateastringwecan manipulate it.
A stringcan be used directlyin a function or it can be stored in a variable.Below, the PHP
script assigns the text “Hello World” to a string variable called $txt:

<?php
$var=”HelloWorld”;
echo $var;
?>

Toconcatenate(forspace)twoormorevariablestogether,usethedot(.)operator:
<?php
$var1=”HelloWorld”;
$var2=”1234";
echo$var1.““.$var2;
?>

Thestrlen()function: Thestrlen()functionis usedtoreturnthelengthofa
string.Let’s find the length of a string:

<?php
echostrlen(“Helloworld!”);

Theoutputofthe codeabovewillbe:12
?>

The strpos() function :The strpos()function is used to search for character within a
string.Ifamatchisfound,thisfunctionwillreturnthepositionofthefirstmatch.Ifnomatch

isfound,itwillreturnFALSE.Let’s seeifwe canfind thestring“world”inour string:
<?php echo strpos(“Hello world!”,”world”); ?> Theoutputofthecode

above will be: 6
Thepositionofthestring“world”inourstringisposition6.Thereasonthatitis6(and
not7),isthatthefirstpositioninthestringis0,andnot1.
Conditional Statements : Theif,elseifandelsestatementsinPHPareusedtoperform different
actionsbasedondifferentconditions.When,youwanttoperformdifferentactionsfor different
decisions,youcanuseconditionalstatementsinyourcode.

ifstatement-usethisstatementifyouwanttoexecuteasetofcodewhenaconditionis true and
another if thecondition is not true.
Syntax:if(condition)codetobeexecutedifconditionistrue;

<?php
$d=date(“D”);
if ($d==”Fri”)
echo“Haveaniceweekend!”;
?>

ifelsestatement-isusedwiththeifelsestatementtoexecuteasetofcodeifone of several
condition are true



TheIf...else...if...elseStatement-Ifyouwanttoexecutesomecodeifaconditionistrue and
another code if a condition is false, use the if...........else statement.

if...else:Usetheif....elsestatementtoexecutesomecodeifaconditionistrueand
anothercodeifaconditionisfalse.
Syntax : if (condition) code to be executed if condition is true;else code to be
executed if condition is false;
The following example will output “Have a nice weekend!” if the current day is
Friday, otherwise it will output “Have a nice day!”:

<?php
$d=date(“D”);
if ($d==”Fri”)
echo“Haveaniceweekend!”;
else
echo“Haveaniceday!”;
?>

TheElseIfStatement:If youwanttoexecutesomecodeifoneofseveral
conditions are true use the elseif statement
Syntax:if(condition)codetobeexecutedifconditionistrue;elseif(condition)codetobe executed
if condition is true;else code to be executed if condition is false.The following example will
output “Have a nice weekend!” if the current day is Friday, and “Have a nice Sunday!” if
the current day is Sunday. Otherwise it will output “Have a nice day!”:

<?php
$d=date(“D”);
if ($d==”Fri”)
echo“Haveaniceweekend!”; elseif
($d==”Sun”)
echo“HaveaniceSunday!”;
else
echo“Haveaniceday!”;
?>

The Switch Statement : TheSwitchstatementinPHPisusedtoperformone ofseveral different
actionsbasedononeofseveraldifferentconditions.Ifyouwanttoselectoneofmany blocks of
codetobeexecuted,usetheSwitchstatement.Theswitchstatementisusedtoavoidlong blocks of
if..elseif..else code.
Syntax:switch(expression)

{
caselabel1:
codetobeexecutedifexpression=label1; break;
caselabel2:
codetobeexecutedifexpression=label2; break;
default:
codetobeexecutedifexpressionisdifferentfrombothlabel1and label2; }

What isan array?
Anarraystoresmultiplevaluesinonesinglevariable.



Avariableisastorageareaholdinganumberortext.Theproblemis,avariablewillhold only one
value.
An arrayisa specialvariable, which canstore multiple valuesinone single variable.
Ifyouhavealistofitems(alistofcarnames,forexample),storingthecarsinsingle variables
could look like this:

$cars1=”Maruti”;
$cars2=”Zen”;
$cars3=”BMW”;

However, what if you want to loop through the cars and find a specific one? And what if
you had not 3 cars, but 300?Each element in the array has its own index so that it can be
easily accessed.In PHP, there are three kind of arrays:

 Numericarray-Anarraywithanumericindex
 Associativearray-AnarraywhereeachIDkeyisassociatedwitha value
 Multidimensionalarray-Anarraycontainingoneormorearrays

Numeric Arrays : A numeric array stores each array element with a numeric index.There
are two methods to create a numeric array.In the following example the index are
automatically assigned (the index starts at 0):

$cars=array(“Maruti”,”Zen”,”BMW”,”Toyota”);
Looping : Looping statements in PHP are used to execute the same block of code a
specifiednumberoftimes.Veryoftenwhenyouwritecode,youwantthesameblockof
codetorunanumberoftimes.Youcanuseloopingstatementsinyourcodetoperform this.InPHP
we have thefollowingloopingstatements: while - loopsthrough ablockof code if and as
long as a specified condition is true
do...while- loops through a block of code once, and then repeats the loop as long as
aspecial condition is true
for -loopsthroughablockofcodeaspecifiednumberoftimes
foreach-loopsthroughablockofcodeforeachelementinanarray
ThewhileStatement:Thewhilestatementwillexecuteablockofcodeif andas long as
a
conditionis true.

Thedo...whilestatementwillexecuteablockofcodeatleastonce-itthenwillrepeat the loop
as long as a condition is true.

Syntax:do

{
code tobeexecuted;
}
while (condition);

Thefollowingexamplewillincrementthevalueofiatleastonce,anditwillcontinue incrementing
the variable i as long as it has a value of less than 5:

<?php
$i=0;
do



{
$i++;
echo“Thenumberis“.$i.“<br/>”;
}
while ($i<5);
?>

The for statement isusedwhenyouknowhowmanytimesyouwanttoexecutea statement or
a list of statements.

Syntax:for(initialization;condition;increment)
{
code tobeexecuted;
}
Increment1 to 10
<?php
$var=1;
do
{
echo$var."";
$var++;}
while($var<=10);
?>

Note: The for statement has three parameters. The first parameter initializes variables,
the second parameter holds the condition, and the third parameter contains the
increments required to implement the loop. If more than one variable is included in the
initialization or the increment parameter, they should be separated by commas.

MySQL
The MySQL development project has made its source codeavailable under the terms of the
GNU General Public License,as well as under a variety of proprietaryagreements.
MySQL was owned and sponsored by a singlefor-profitfirm, the SwedishcompanyMySQL
AB,now owned by Oracle Corporation.

MySQL is a popular choice of database for use in web applications, and is a central
component of the widely usedLAMPopen source web application software stack (and
other 'AMP'stacks). LAMP is an acronym for "Linux,Apache, MySQL,
Perl/PHP/Python."Free-software-open source projects that require a full-featured database
management system often use MySQL.

Interfaces
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MySQL is a relational database management system(RDBMS), and ships with no GUI tools
to administer MySQL databases or manage data contained within the databases. Users
may use the included command linetools, or use MySQL "front-ends", desktop software
and web applications that create and manage MySQL databases, build database structures,
back up data, inspect status, and work with data records. The official set of MySQL front-
end tools, MySQL Workbenchis actively developed by Oracle, and is freely available for use.

Graphical

The official MySQL Workbenchis a free integrated environment developed by MySQL AB,
that enables users to graphically administer MySQL databases and visually designdatabase
structures. MySQL Workbench replaces the previous package of software,MySQL GUI
Tools.Similar to other third-party packages, but still considered the authoritative MySQL
front end, MySQL Workbench lets users manage database design & modeling, SQL
development (replacing MySQL Query Browser) and Database administration (replacing
MySQL Administrator).

MySQL Workbench is available in two editions, the regular free and opensource
Community Edition which may be downloaded from the MySQL website, and the
proprietary Standard Edition which extends and improves the feature set of the
Community Edition.

Command line

MySQL ships with many command linetools, from which the main interface is 'mysql'
client.Third-partieshavealsodevelopedtoolstomanage, optimize,monitorandbackupa MySQL
server, some listed below. All these tools work on *NIX type operating systems, and some
of them also on Windows.

Maatkit - a cross-platform toolkit for MySQL, PostgreSQLand Memcached,
developed in Perl.Maatkit can be used to prove replication is working correctly, fix
corrupteddata,automaterepetitivetasks,andspeedupservers.Maatkitisincluded
withseveralGNU/LinuxdistributionssuchasCentOSandDebianandpackages are
available for Fedoraand Ubuntuas well. As of late 2011, Maatkit is no longer
developed, but Perconahas continued development under the Percona Toolkit brand.

 XtraBackup - Open Source MySQL hot backup software. Some notable features
include hot, non-locking backups for InnoDB storage, incremental backups,
streaming, parallel-compressed backups, throttling based on the number of IO
operations per second, etc.
MySQL::Replication - a replacement for MySQL's built-in replication, developed in
Perl.MySQL::Replicationcan be used to createa peer-to-peer, multi-master MySQL
replication network.
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Programming

MySQL works on manysystem platforms, includingAIX,BSDi,FreeBSD,HP-
UX,eComStation,i5/OS,IRIX,Linux,Mac OS X,Microsoft
Windows,NetBSD,NovellNetWare,OpenBSD,OpenSolaris,OS/2Warp,
QNX,Solaris,Symbian, SunOS, SCO
OpenServer, SCO UnixWare,Sanosand Tru64.A port of MySQL toOpenVMSalso
exists.MySQL is written in C and C++.Its SQL parser is written in yacc,but it uses a home-
brewedlexical analyzer.Manyprogramming languageswith language-
specificAPIsincludelibrariesforaccessingMySQLdatabases.TheseincludeMySQL
Connector/NetforintegrationwithMicrosoft'sVisualStudio(languagessuchasC#andVBaremost
commonlyused)andtheJDBCdriverforJava.Inaddition,

an ODBCinterface called MyODBCallows additional programming languages that support
the ODBC interface to communicate with a MySQL database, such as ASPor ColdFusion.
The HTSQL- URL-based query method also ships with a MySQL adapter, allowing direct
interaction between a MySQL database and any web client via structured URLs.

Features

Theyhaveacommoncodebaseandincludethefollowingfeatures:

AbroadsubsetofANSISQL99,aswellasextensions
 Cross-platformsupport
 Stored procedures, a procedural language that closely adheres to

SQL/PSM
TriggersCurs
ors
Updatable
ViewsInformationschema

 Strict mode (ensures MySQL does not truncate or otherwise modify data to
conform to an underlyingdata type, when an incompatible value is inserted into
that type)
X/OpenXAdistributedtransactionprocessing(DTP)support;twophasecommit as

part of this, using Oracle's InnoDBengine
Independent storage engines(MyISAMfor read speed, InnoDBfor transactions
andreferentialintegrity,MySQLArchiveforstoringhistoricaldatainlittlespace)

 Transactionswith the InnoDBand NDB Cluster storage engines; savepoints
with InnoDB

SSL support
Querycaching
Sub-SELECTs(i.e.nestedSELECTs)
Replication support (i.e. Master-Master Replication & Master-Slave Replication)
with one master per slave, many slaves per master. Multi-master replicationis
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providedin MySQLCluster,andmulti-mastersupportcanbeaddedto
unclustered configurations using Galera Cluster.
Full-textindexingandsearchingusingMyISAM engine

 Embeddeddatabaselibrary
Unicode support (however prior to 5.5.3 UTF-8and UCS-2encoded strings are
limited to the BMP,in 5.5.3 and later use utf8mb4forfull unicode support)
ACID compliance when using transaction capable storage engines (InnoDB and
Cluster)

 Partitionedtableswithpruningofpartitionsinoptimizer
Shared-nothing clustering through MySQL Cluster

 Hotbackup(viamysqlhotcopy)undercertainconditions
Multiple storage engines, allowing one to choose the one that is most effective
for each table in the application (in MySQL 5.0, storage engines must be
compiled in; in MySQL 5.1, storage engines can be dynamically loaded at
runtime):
Native storage engines (MyISAM, Falcon,Merge, Memory (heap), Federated,
Archive,CSV,Blackhole,Cluster,EXAMPLE,Aria,andInnoDB,whichwas made the
default as of 5.5)
Partner-developed storage engines (solidDB,NitroEDB, ScaleDB, TokuDB,
Infobright(formerly Brighthouse), Kickfire, XtraDB, IBM DB2). InnoDB used to
be a partner-developed storage engine, but with recent
acquisitions,Oraclenow ownsbothMySQLcoreandInnoDB.

 Community-developedstorage engines (memcache engine,httpd, PBXT,
Revision Engine)

 Customstorageengines
 Commit grouping, gathering multiple transactions from multiple connections

together to increase the number of commits per second. (PostgreSQL has an
advanced form of this functionality)

The developers release monthly versions of the MySQL Server. The sources can be
obtained from MySQL's website or from MySQL's Bazaarrepository, both under the GPL
license.

Limitations

LikeotherSQLdatabases,MySQLdoes notcurrently comply withthe full SQLstandard for some
of the implemented functionality, including foreign key references when using some
storage engines other than the 'standard' InnoDB.

Triggersarecurrentlylimitedtooneperaction/timing,i.e.maximumoneafterinsertand one
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before insert on the same table. There are no triggers on views.



MySQL, like most other transactionalrelational databases, is strongly limited by hard disk
performance.Thisisespeciallytrue intermsof write latency.Giventhe recentappearance of
very affordable consumer grade SATA interface Solid-state drivesthat offer zero
mechanicallatency,afivefoldspeedupoverevenaneightdriveRAIDarraycanbehadfor a smaller
investment.

Deployment

MySQL can be built and installed manually from source code, but this can be tedious so it
is more commonly installed from a binary package unless special customizations are
required. OnmostLinuxdistributions the package management systemcandownloadand
install MySQL with minimal effort, though further configuration is often required to adjust
security and optimization settings.

Though MySQL began as a low-end alternative to more powerful proprietary databases, it
hasgraduallyevolved tosupporthigher-scaleneedsaswell.Itisstillmostcommonlyused in small
to medium scale single-server deployments, either as a component in a LAMP- based web
application or as a standalone database server. Much of MySQL's appeal originates in its
relative simplicity and ease of use, which is enabled by an ecosystem of open source tools
such asphpMyAdmin.In the medium range, MySQL can be scaled by deploying it on more
powerful hardware, such as a multi-processor server with gigabytes of memory.

Therearehoweverlimitstohowfarperformancecanscaleonasingleserver,soonlarger scales,
multi-server MySQL deployments are required to provide improved performance and
reliability. A typical high-end configuration can include a powerful master database
whichhandlesdatawriteoperationsandisreplicatedtomultipleslavesthathandleallread
operations. The master server synchronizes continually with its slaves so in the event of
failure a slave can bepromoted to become the newmaster,minimizing downtime. Further
improvements in performance can be achieved by caching the results from database
queries in memory using memcached,or breaking down a database into smaller chunks
called shardswhich can be spread across a number of distributed server clusters.
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Java Script
JavaScript is the most popular scripting language on the internet, and works in all major
browsers,
suchasInternetExplorer,Firefox,Chrome,Opera,and Safari.

WhatisJavaScript?
JavaScriptisascriptinglanguageorisalightweightprogramminglanguage JavaScript
was designed to add interactivity to HTML pages
JavaScriptisusuallyembeddeddirectlyintoHTMLpages
JavaScriptisaninterpretedlanguage(meansthatscriptsexecutewithoutpreliminary

compilation)
Everyonecan use JavaScriptwithout purchasing alicense

AreJavaandJavaScriptthesame?

NO! Java and JavaScript are two completely different languages in both concept and
design! Java (developed by Sun Microsystems) is a powerful and much more complex
programming language - in the same category as C and C++.

How doesitWork?

JavaScript gives HTML designers a programming tool : HTML authors are normally
notprogrammers,butsinceJavaScriptisaverylightprogramminglanguagewithavery simple
syntax, almost anyone can start putting small “pieces” of code into their HTML
documents.

JavaScript can putdynamic text intoan HTML page : AJavaScriptstatementlikethis:
document. write(“<h1>” + name + “</h1>”) can write a variable text into the display of an
HTMLpage,justlikethestaticHTMLtext:<h1>Hello</h1>does.

JavaScript can react to events : A JavaScript can be set to execute when something
happens, like when a page has finished loading or when a user clicks on an HTML element.

JavaScript can read and write HTML elements : A JavaScript can readanHTML
element and change the content of an HTML element.



JavaScript can be used to validate data : JavaScript can be used to validate data in a
form before it is submitted to a server. This function is particularly well suited to save the
server from extra processing.
JavaScriptEvents:EventsareactionsthatcanbedetectedbyJavaScript.

Examplesofevents:

Amouseclick
A web page or an image
loadingMousingoverahotspotonthewebpa
ge
SelectinganinputfieldinanHTMLform &SubmittinganHTML form A
keystroke
Note: Eventsarenormallyusedincombinationwithfunctions,andthefunctionwillnotbe executed
before the event occurs!
JavaScriptisCaseSensitive:A functionnamed“myfunction”isnotthesameas “myFunction”.
Therefore watch your capitalization when you create or call variables, objects and functions.
Symbols:Opensymbols,like({[“‘,musthave amatchingclosing symbol,like‘“]}).

ToinsertascriptinanHTMLdocument,usethe<script>tag.Usethetypeattributeto define the
scripting language.
<scripttype=”text/javascript”>
InJavaScriptthecommandforwritingsometextonapageisdocument.write:
document.write(“HelloWorld!”)
Thescriptends:</script>

HowtoPutaJavaScriptIntoanHTMLDocument

<html><body>

<script type=”text/javascript”>

document.write(“HelloWorld!”)

</script>

</body></html>

Write textwithformatting

Howtoformatthetexton yourpagewithHTMLtags

<html><body>

<scripttype=”text/javascript”>



document.write(“<h1>HelloWorld!</h1>”)

</script>

</body></html>

Ending StatementswithaSemicolon?
With the traditional programming languages C++ and Java, each code statement has to
end with a semicolon.
Scripts in the head section: Scripts to be executed when they are called, or when an
eventistriggered,gointheheadsection.Whenyouplaceascriptintheheadsection,you
willensurethat the script isloadedbeforeanyoneusesit. <html>

<head>

<scripttype=”text/javascript”>

functionmessage()

{

alert(“Thisalertboxwascalledwiththeonload event”)

}

</script>

</head>

<bodyonload=”message()”>

</body>

</html>

Scripts in the body section: Scripts to be executed when the page loads go in the body
section.When you place a script in the body section it generates the content of the page.

<html>

<head>

</head>

<body>



<scripttype=”text/javascript”>
document.write(“Thismessageiswrittenwhenthepageloads”)
</script>
</body>
</html>
Scripts inboth the bodyand the head section: Youcanplaceanunlimitednumberof
scriptsinyourdocument,soyoucanhavescriptsinboththebodyandtheheadsection.
<html>
<head>
<scripttype=”text/javascript”>

/*somestatements*/document.write(“ThismessageiswritteninHead Section”)
</script>
</head>
<body><br>
<scripttype=”text/javascript”>
/*somestatements*/document.write(“ThismessageiswritteninBody

Section”) </script>
</body>
How toRunanExternalJavaScript: Sometimesyoumightwanttorunthesamescript on
several pages, without writing the script on each and everypage.To simplify this you
canwriteascriptinanexternalfile,andsaveitwithaname.jsfileextension,likethis:

document.write(“Thisscriptisexternal”)Savetheexternalfileasabc.js
The filename can not contain more than 8 letters
Theexternalscriptcannotcontainthe<script>tag
Nowyoucancallthisscript,usingthe“src”attribute,fromanyofyour pages:
<html>
<head>
</head>
<body>
<scriptsrc=”abc.js”>
</script>
</body>
</html>
Variables:Avariableisa “container”forinformationyouwanttostore.Avariable’svalue

canchangeduringthescript.Youcanrefertoavariablebynametoseeitsvalueorto change its
value.Rules for Variable names:

Variablenamesarecasesensitive
Theymustbeginwithaletterortheunderscorecharacter.
DeclareaVariable
Youcancreateavariablewiththevarstatement:varname=“SoftBrain”
<html>
<body>
<scripttype=”text/javascript”>
var name = “SoftBrain”
document.write(name)
document.write(“<h1>”+name+”</h1>”)
</script>



<p>Thisexampledeclaresavariable,assignsavaluetoit,andthendisplaysthe variable.</p>
<p>Thenthevariableisdisplayedonemoretime,onlythistimeasaheading.</p>
</body>
</html>
Lifetime of Variables : When you declare a variable within a function, the variable can
only be accessed within that function. When you exit the function, the variable is
destroyed. Thesevariablesarecalledlocalvariables.Youcanhavelocalvariableswith the same
name in different functions, because each is recognized only by the function in which it is
declared.If you declare a variable outside a function, all the functions on your page can
access it. The lifetime of these variables starts when they are declared, andends when the
page is closed.

Function : Afunctionisareusablecode-blockthatwillbeexecutedbyanevent,orwhen the
function is called.
Howtocallafunction.
<html><head>
<scripttype=”text/javascript”>
functionmyfunction()
{
alert(“HELLO”)
}
</script></head><body><form>
<inputtype=”button”onclick=”myfunction()”value=”Callfunction”>
</form><p>Bypressingthebutton,afunctionwillbecalled.Thefunctionwillalerta
message.</p>
</body>
Functionwitharguments : Howtopassavariabletoafunction,andusethevariable value in
the function.

<html><head>

<scripttype=”text/javascript”>

functionmyfunction(txt)

{

alert(txt)

}

</script>

</head>



<body>

<form>
<input type=”button”
onclick=”myfunction(‘Hello’)”
value=”Call function”>
</form></html>
<p>Bypressingthebutton,afunctionwithanargumentwillbecalled.Thefunctionwill alert this
argument.</p>
</body>
Conditional Statements : Veryoftenwhenyouwritecode,youwanttoperformdifferent actions
fordifferentdecisions.Youcanuseconditionalstatementsinyourcodetodothis. In
JavaScript we have two conditional statements:
if...elsestatement- use this statement ifyou want toselect one oftwo sets oflines to
execute
switchstatement- use this statement if you want to select one of many sets of lines to execute
IF Condition : You should use the IF statement if you want to execute some code if a
condition is true, or if you want to select one of two blocks of code to be executed.If you
want to execute only one statement when a condition is true, use this syntax for the
if...else statement, like this:

If statement : HowtowriteanIfstatement.Usetheifstatementifyouwantasetofcode to be
executed if a specified condition is true

If...else statement : HowtowriteanIf...Elsestatement.UsetheIf...Elsestatementifyou want
one set of code to be executed if the condition is true and another set of code to be
executed if the condition is false



Visual Basic
Microsoft Visual Programming Language (VPL) is an application development environment
designed on a graphical dataflow-based programming model. Rather than series of
imperative commands sequentially executed, a dataflow program is more like a series of
workers on an assembly line, who do their assigned task as the materials arrive. As a
result VPL is well suited to programming a variety of concurrent or distributed processing
scenarios.

VPL is targeted for beginner programmers with a basic understanding of concepts like
variables and logic. However, VPL is not limited to novices. The programming language
may appeal to more advanced programmers for rapid prototyping or code development.As
a result, VPL may appeal to a wide audience of users including students,
enthusiasts/hobbyists, as well as possibly web developers and professional programmers.
In computing,a visual programming language (VPL) is any programming languagethat lets
users create programsby manipulating program elements graphically rather than by
specifying them textually. A VPL allows programming with visual expressions, spatial
arrangements of text and graphic symbols used either as elements of syntaxor
secondarynotation. For example, many VPLs (known as dataflow or diagrammatic
programming) are based on the idea of "boxes and arrows", where boxes or other screen
objects aretreated as entities, connected by arrows, lines or arcs which represent relations.

VPLsmaybe furtherclassified, accordingto the type and extent of visualexpression used,
into icon-based languages, form-based languages, and diagram languages. Visual
programming environments provide graphical or iconic elements which can bemanipulated
by users in an interactive way according to some specific spatial grammar for program
construction.

 Aprogramminglanguagethatusesavisualrepresentation
(suchasgraphics,drawings,animationoricons, partially or completely)

 Avisuallanguagemanipulatesvisualinformationorsupportsvisualinteraction,or allows
programming with visual expressions [Golin 90]

 Any system where the user writes a program using two or more dimensions [Myers
90] A visual language is a set of spatial arrangements of text-graphic symbols with
a semantic interpretation that is used in carrying out communication actions in the
world

 VPTaxonomyby BurnettandBaker(1994)

Software paradigm, language level, application domain, visual extent (icon, form,
diagram).VisualBasicandtheentireMicrosoftVisual(tm)familyarenot,despitetheir names,
visual programming languages. They are textual languages

http://en.wikipedia.org/wiki/Computing
http://en.wikipedia.org/wiki/Programming_language
http://en.wikipedia.org/wiki/Computer_program
http://en.wikipedia.org/wiki/Syntax
http://en.wikipedia.org/wiki/Secondary_notation
http://en.wikipedia.org/wiki/Secondary_notation


whichuseagraphicalguibuildertomakeprogrammingdecentinterfaceseasieronthe programmer.

ElementsofVisual Programming

 Languageparadigm
 BatchorInteractive
 Visualrepresentationvs. visual object
 Diagrams,iconsorforms
 Numberofdimensions
 Specificapplicationdomain

BasicActivities
The Microsoft Visual Programming Language (VPL) includes a set of basic activities that
are used to help create a dataflow program. These blocks are typically used to connect
between service blocks, but can also be connected together.

Activity
The activity block, sometimes referred to as a Custom Activity, allows you to create your
own activities that caneach have theirown set of internaldataflowdiagrams. You can use
these to create diagrams that can be represented as single blocks in other diagrams and
are used in the same way as the built-in activities. These custom activities can also be
compiled into services that can be used with other services or in other VPL diagrams.

Calculate
The Calculate activity performs simple arithmetic or logical operations on the expression
entered into the textbox. The expression can include numeric values, the value from the



incoming message, itsdata members, or predetermined values provided by other services
on your diagram.
Fornumericdatayoucanuse:

+ add

- subtract/minus

* multiply

/ divide

% mod(Themodulusoperationreturnstheremainderafteradivision)

The plus (+) operator can also be used to concatenate, combine, strings. This can also be
used to combine text, string, and numeric data byusing double quotes, e.g. theanswer is
+x/4.

Forlogicaloperatorsyoucanuse:

&& AND

|| OR

! NOT

You can also use parenthesis to support precedence (the order of evaluation) of the
expression entered.
Clicking in the textbox of the Calculate block displays a list including the value of the
incoming message, any data members in the message, the state variables, as well as
predefined values that may be provided by other services.

Variable
TheVariable activityenablesyoutosetorgetthevalueofavariable.
To choose a variable select it from the drop-down list displayed by clicking on the down-
arrowbuttonattheright-handendofthetextbox.
Ifyouhavenotdefinedanyvariablesorwishtocreateanewvariable,selectDefine
Variablesfromthedrop-downlist,orselectVariablesfromtheEditmenu.Thiswilldisplay



the DefineVariablesdialog box where you can add a variable and define its type.
Variabledatatypesincludeintegers(int),doubleprecisionfloating-pointnumbers(double),
strings of characters (string), types of Lists, etc. See Data Typesfor the full list.
Variable names are case-sensitive. So when referencing a variable always be careful touse
the same case. Names must also start with a letter and include only alphabetic or numeric
characters. No punctuation characters are allowed except for the underscore (_).
Variable activities are simple constructs that support a GetValue connection, to get its
value, as well as a SetValue connection, to set its value. When using the SetValue
connection, the output connection of the activity also passes a variable on its outgoing
connection.

Naming conventions

Uptillnow,wehaveoftenaccepteddefaultnames,Text1,Label1,etc.Inabigproject,this is not
good practice as it makes the code harder to read or maintain. Naming conventions use a
prefix of three lowerCase letters to identify the type of control, followed by a meaningful
name. eg. lblTitle

Strings

 VariableLength
 Compareusingstandardcomparators
 Maximumlengthisabout64Kb
 Minimumlengthiszero
 Allocated from VB “String Space”, so mayrun out of spaceevenonsystems

with much memory.

Data Types

TheMicrosoftVisualProgrammingLanguagesupports .NETC#styledatatypes.

VPL
DESCRIPTION

TYPE

bool Booleanvalues:true,false

byte 8bitunsignedinteger(0to255)

sbyte 8bitsignedinteger(-128to127)

char character

decimal fixedpointdecimalnumber(fixedprecisionnumber)

http://msdn.microsoft.com/en-us/library/bb483010.aspx


double doubleprecision(64-bit)floatingpointnumber(approx14significant
digits)

float singleprecision(32-bit)floatingpointnumber(approx7
significantdigits)

int 32bitsignedinteger

uint 32bitunsignedinteger

long 64bitsignedinteger

ulong 64bitunsignedinteger

string characterstring(text)

short 16bitsignedinteger(-32768to32767)

ushort 16bitunsignedinteger(0to65535)

VPL supports Lists but not Arrays. However, a List can often be used instead of anArray.
(An array is a set of variables that are all of the same data type and are accessed via a
single variable name and an index. They are usually of fixed length. Lists are more
general-purpose and allow you to insert and delete elements anywhere in the list.)
VPLhaslimited supportforarbitraryuser-defined data types.The simpledata structures
used in operationmessagescan generallybe used inexpressionsusing"dot notation"to
select the members of a class. VPL usually creates a variable called value to hold the
responsefromanactivity.Ifthisvalue isacompounddatatype(referredtoasaclassor a
structure) then you can access its elements(called membersor properties).In the the
following example a string property called FullName can be obtained from a message:
value.FullName To convert from one data type to another, you can use C# cast
operations. For example, to convert from an integer called myInt to a string, use
thisexpression:(string)myIntSometimescastsfailbecausethedatacannotbe represented using the
new data type.

StrategiesinVisual Programming

Because VPEs employ visual ways of communicating about programs, the visual
communicationdevicesemployedby aVPEcanbeviewedasa(limited)VPL.Hence, the
strategies used by VPEs are a subset of those possible for VPLs. Because of this subset
relationship, much of the remaining discussion of visual programming will focus primarily
on VPLs.

VPL Strategies

A common misunderstanding is that the goal of visual programming research in general
and VPLs in particular is toeliminate text. This is a fallacy--in fact, most VPLs includetext
to at least some extent, in a multidimensional context. Rather, the overall goal of VPLs is



to strive for improvements in programming language design. The opportunity to achieve
this comes from the simple fact that VPLs have fewer syntactic restrictions onthe way a
program can be expressed , and this affords a freedom to explore programming
mechanisms that have not previously been tried because they have not been possible in
the past.

Toachievethesegoals,therearefourcommonstrategiesusedinVPLs:



Concreteness: Concreteness is the opposite of abstractness, and means expressing
some aspect of a program using particular instances. One example is allowing a
programmer to specify some aspect of semantics on a specific object or value, and

another example is having the system automatically display the effects of some portion of
a program on a specific object or value.

Directness:Directnessinthecontextofdirectmanipulationisusuallydescribedas“the feeling that one
is directly manipulating the object” [19]. From a cognitive perspective,
directness in computing means a small distance between a goal and the actions required
of the user to achieve the goal. Given concreteness in a VPL, an example of directness
would be allowing the programmer to manipulate a specific object or value directly to
specify semantics rather than describing these semantics textually.

Explicitness: Someaspectofsemanticsisexplicitintheenvironmentifitisdirectlystated
(textuallyorvisually),withouttherequirementthattheprogrammerinferit.Anexampleof
explicitness in a VPL would be for the system to explicitly depict dataflow relationships
(programsliceinformation)bydrawingdirectededgesamongrelatedvariables.Immediate Visual
Feedback: In the context of visual programming, immediate visual feedback refers to
automatic display of effects of program edits. Tanimoto has coined the term liveness,
which categorizes the immediacy of semantic feedback that is automatically provided
during the process of editing a program

AdvancedIssues

VisualProgrammingandAbstraction
One of the challenges in visual programming research is scaling up to the support of ever-
larger programs. This is a greater issue for VPLs than for traditional textual languages
(although it certainly can be said to exist in both) for reasons relating to representation,
languagedesignandimplementation,andrelativeyouthofthearea.Forexample,someof the
visual mechanisms used to achieve characteristics such as explicitness can occupy a great
deal of space, making it harder to maintain context. Also, it is hard to apply in a
straightforward way techniques developed for traditional languages, because doing so
often results in a reintroduction of the very complexities VPLs have tried to remove or
simplify.
Recent developments in the area of abstraction have been particularly important to the
scalability of VPLs. The two most widely-supported types of abstraction, both in visual and
textual languages, are procedural abstraction and data abstraction. In particular,
procedural abstraction has shown itself to be supportable by a variety of VPLs. A key
attribute to supporting procedural abstraction in a VPL has been consistency with the rest
of programming in the same VPL.

VisualProgrammingLanguage Specification
Theone-dimensionalityoftraditionaltextuallanguagesmeansthatthereisonlyone relationship
possible between symbols of a sentence, “next to”. Thus, in describing a textual
language in BNF, it is necessary to specify only the symbols in the language, notthe
relationship “next to” (which is implied when onesymbolis written next toanotherina



grammar). However, the multidimensionality of VPLs means many relationships are possible,
such as “overlaps,”0 “touches,” and “to the left of,” and there is no universally-
agreed-upondefinitionofexactlywhensuchrelationshipshold,orevenhowmanyofthem



may hold simultaneously between the same symbols. Hence, relationships among
symbols cannot be left implicit, and traditional mechanisms such as BNF for specifying
textual languages cannot be used without modification for specifying VPLs. Much
different formalism for the specification of visual languages have been investigated.
Grammar-like formalisms range from early approaches like web and array grammarsand
shape grammars to recent formalisms like positional grammars, relation grammars,
unification grammars, attributed multiset grammars, and several types of graph
grammars.

VisualProgrammingandCognitiveTheory
Since the goals of VPLs have to do with improving humans’ ability to program, it
is importanttoconsiderwhatisknownaboutcognitiveissuesrelevanttoprogramming.
Muchofthisinformationhasbeengleanedinthefieldofcognitivepsychology,and psychologist
Thomas Green and his colleagues have made many of these findings availabletonon-
psychologiststhroughcognitivedimensions,asetoftermsdescribingthe structure of a
programming language’s components as they relate to cognitive issues in programming.

EmpiricalFindings
Worktowardusingvisualprogrammingtechniquestoimprove correctnessand/orspeed in
programming tasks has focused primarily on three areas: program comprehension,
programcreation,andprogramdebugging.Ofthesethreeareas,themostempirical
studies have been done on VPLs’ effects on program comprehension. The results of
these
studies have been mixed, reportingfindingsfor some kinds of programs or audiences in
whichVPLsand/orvisualnotationsarelinkedwithgreatercomprehension,andothersin which
strictly textual languages and/or notations have been linked with greater comprehension.
There have been fewer empirical studies on program creation thus far, but these
studies have produced far more consistent results than the studies on comprehension.
Most have reported visual approaches outperforming traditional textual approachesfor
this task. Finally, the effects of visual programming are the least studied of allin
debugging(and infactthisisalsotrue of classicaldebuggers,which feature the precursors
oftheideas ofliveness as now foundinVPLs). Thesestudies havenot found statistically
significant improvements for all the aspects studied, but for the aspects in which
statistical significance was found, visual approaches including immediate feedback were
found to be superior to the static, non-feedback-oriented approaches in most cases.
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